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Visual Execution Analysis
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The Visual Execution Analyzer (VEA) is made up of an advanced and powerful suite of tools that allow you to build,
debug, record, profile, simulate and otherwise construct and verify your software development while keeping the code
tightly integrated with your model. Enterprise Architect has rich support for a wide range of popular compilers and
platforms, in particular the Java, .Net and Microsoft Windows C++ environments. Software development becomes a
highly streamlined visual experience, quite unlike working in traditional environments.

Enterprise Architect is itself modeled, built, compiled, debugged, tested, managed, profiled and otherwise constructed
totally within the Visual Execution Analyzer built into Enterprise Architect. While the VEA can be used to complement
other tool suites, it also shines when used as the primary development IDE in close coupling with the model and project
management capabilities provided by Enterprise Architect.

Access
Ribbon Code > Analyzer > Analyzer Scripts
Execute > Analyze > Analyzer Scripts
Context Menu Right-click on Package | Execution Analyzer
Keyboard Shortcuts Shift+F12

Execution Analyzer Features

Feature Description

Build & Debug Using Analyzer Scripts linked to Model Packages, it is possible to tightly integrate
the code/build/debug cycle into Enterprise Architect. For Java, .Net and Microsoft
C++ in particular, it is simple to link to project code bases and take over the
building and debugging within Enterprise Architect's Model Driven Development
Environment. In addition to standard debugging features, the strong coupling with
the model and the use of advanced debugging features such as Action Points makes
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Simulation

Profiling

Recording Execution

Object Workbench

Visual Execution Analyzer
Samples

Enterprise Architect the ideal platform from which to both design and construct
your software application.

Bring your behavioral models to life with instant, real-time behavioral model
execution. Coupled with tools to manage triggers, events, guards, effects,
breakpoints and simulation variables, plus the ability to visually track execution at
run-time, the Simulator is a powerful means of 'watching the wheels turn' and
verifying the correctness of your behavioral models.

Lift the hood on software performance and see what is actually going on. Quickly
gain a clear picture of why certain tasks behave poorly or worse than expected.
Whether its Microsoft .NET, native C++ or Java, use profiles to effectively judge
changes in performance over your software lifecycle.

Record the execution of code without the need for instrumentation. Control the
amount of detail through filters and stack depth. Generate beautiful Sequence
diagrams and diagrams that illustrate Class collaboration. Use recording to create
Test domain diagrams which can be used with the VEA Testpoints feature.

Create and manage test scripts for model elements. Explore the Testing interface,
supporting unit, integration, scenario, system, inspection and acceptance tests.
Employ programming by contract methodology with the Testpoints facility.

Workbench class behavior on the fly, by instantiating them in the Object
Workbench and then invoking their operations. You can even pass objects on the
workbench as parameters to other workbench objects.

Try our sample patterns to set up and explore some of the powerful features of the
Visual Execution Analyzer.

Benefits of the Execution Analyzer

30 June, 2017

The Execution Analyzer provides an integrated development and testing environment for multiple platforms, including
Microsoft .NET, Java, Native code and Android. It includes a feature-rich debugger, execution recording and profiling,
and Testpoint management.

It helps you to generate Sequence, Test Domain Class and Collaborative Class diagrams from a single recording. This is
a great way to understand and document your application.

e Optimize existing system resources and understand resource allocation

e Verify that the system is following the rules as designed

e Produce high quality documentation that more accurately reflects system behavior
(c) Sparx Systems 2015 - 2017 Page 6o0f214
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e Understand how and why systems work

e Train new employees in the structure and function of a system

e Provide a comprehensive understanding of how existing code works

e  Identify costly or unnecessary function calls

o [llustrate interactions, data structures and important relationships within a system
e Trace problems to a specific line of code, system interaction or event

e Visualize why a sequence of events is important

e  Establish the sequence of events that occur immediately prior to system failure

e Simulate the execution of behavior models including StateMachines, Activities and Interactions

Operations

Operation

Simulate UML behavior models to verify their logical and design correctness, for:
e  Activities
e Interactions and Sequences

e  StateMachines

Record executing programs and represent the behavior as a UML Sequence diagram; recording is supported for:
e  Microsoft Windows Native C, C++, Visual Basic
e Microsoft .NET Family (C#, J#, VB)

e Java
e Android
e PHP

Quickly view / report on behaviors of running applications. Profiling is supported for these platforms:
e  Microsoft Native C, C++, Visual Basic
e Microsoft NET Family (C#, J#, VB) (including any unmanaged / managed code mix)

e Java

Testpoints Management provides a facility to define the constraints on a class model as contracts. The contracts
provide the assets on which to create Test domains. A single Testpoint domain can then be used to test and report
the behavior of multiple applications. You can also use the Execution Analyzer to record a Use Case and generate a
Test Domain diagram with very little effort. Any existing Testpoints are automatically linked to the generated
domain or the Test Domain diagram can be used as the context for new contract compositions. How an application
behaves for a given Test domain can be seen immediately in real time! Results are displayed in the Testpoint report
window every time a contract is passed or failed. The decoupling of test measurement from the code-base has a
number of benefits, one of which is aiding the reconciliation of multiple systems with a common Test domain,
rather than one another.

The Testpoint system supports these contracts:
e (Class invariants

e Method pre-conditions

e  Method post-conditions

e Line conditions
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Create and work with objects created within the Enterprise Architect modeling environment using a dynamic Object
Workbench.

e  Create objects from class model

e Invoke methods and view results

e Workbench class collaboration

e Pass objects as parameters to other objects

e Full debugging features including recording

Run nUnit and jUnit tests for Java and Microsoft .NET

Record and document results.

Execution Recording and Profiling both acquire a collection of relevant code files, which you can reverse-engineer
to the current model in a single operation.

(c) Sparx Systems 2015 - 2017 Page 8of214 Created with Enterprise Architect
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Build & Debug

Enterprise Architect builds on top of its already exceptional code generation, diagramming and design capabilities with a
complete suite of tools to build, debug, visualize, record, test, profile and otherwise construct and verify software
applications. The toolset is intimately connected to the modeling and design capabilities and provides a unique and
powerful means of constructing software from a model and keeping model and code in sync.

Enterprise Architect lets you define 'Analyzer Scripts' linked to Model Packages that describe how an application will be
compiled, which debugger to use and other related information such as simulation commands. The Analyzer Script is the
core configuration item that links your code to the build, debug, test, profile and deploy capabilities within Enterprise
Architect.

As a measure of how competent the toolset is, it should be noted that Enterprise Architect is in fact built, debugged,
profiled, tested and otherwise constructed fully within the Enterprise Architect development environment. Many of the
advanced debugging tools such as 'Action Points' have been developed to solve problems inherent in the construction of
large and complex software applications (such as Enterprise Architect) and are routinely used on a daily basis by the
Sparx Systems development team.

It is recommended that new users take the time to fully understand the use of the Analyzer Scripts and how they tie the
model to the code and to the compilers and other tools necessary for building software.

In addition to the standard built-in tools, it is also possible to use the Visual Studio and Eclipse link tools built in to
version 12 and above of Enterprise Architect to couple design and modeling capabilities with these IDEs.

Integrating Model and Code

Model Driven Engineering is a modern approach to software development and promises greater productivity and higher
quality code, resulting in systems getting to market faster and with fewer faults. What makes this approach compelling is
the ability for the architecture and the design of a system to be described and maintained in a model, and then generated
to programming code and schemas that can be synchronized with and visualized within the model.

Enterprise Architect's Model Driven Development Environment (MDDE) supports this approach and provides a set of
flexible tools to increase productivity and reduce errors. These include the ability to define the architecture and design in
models, generate code from these models, synchronize the code with the models and maintain the code in sophisticated
code editors. Source code or binaries can also be imported, and users can record and document pre-existing or recently
developed code. The Analyzer Script tool helps you to describe how to build, debug, test and deploy an application.

Facility Description
Model Driven Model Driven Development provides a more robust, accessible and faster
Development development cycle than traditional coding-driven cycles.

A well constructed model, intimately linked with source code build, run, debug, test
and deploy capabilities provides a rich, easily navigated and easily understood
target architecture. Traceability, linkage to Use Cases, Components and other
model artifacts, plus the ability to readily record and document pre-existing or
recently developed code, make Enterprise Architect's development environment
uniquely powerful.

Enterprise Architect incorporates industry standard intelligent editing, debuggers
and modeling languages.

The Model Driven The MDDE provides tools to design, visualize, build and debug an application:
Development Environment
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(MDDE)

(c) Sparx Systems 2015 - 2017

UML technologies and tools to model software

Code generation tools to generate/reverse engineer source code
Tools to import source code and binaries

Code editors that support different programming languages
Intelli-sense to aid coding

Analyzer scripts that enable a user to describe how to build, debug, test and
deploy the application

Integration with compilers such as Java, .Net, Microsoft C++
Debugging capabilities for Java, .NET, Microsoft C++ and others

Advanced visualization, recording, inspection, testing and profiling capabilities

phpp = new CBCGPAppointmentDemo

(

4 2 of 2 ™ CBCGPAppointmentDemon:CBCGPAppointmentDemo(COleDateTime8: dtStart,
COleDateTimed& dtFinish, CString &t strText, COLORREF clrBackground, COLORREF

clrfForeground, COLORREF clrDuration)
: RGE (165, 222, 89),
CLR DEFRULT,
: RGE (128, 0O, 128)
¥
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Analyzer Scripts

Analyzer Scripts are used by the Execution Analyzer. You do not need to worry about creating these. They are not the
same type of script as Javascript or PHP, but are managed using a familiar user interface - a tree view - and you can
quickly locate the feature to change. Analyzer Scripts can be shared by users of a community model and are easily

imported and exported as xml

files.

|§i Execution Analyzer: Tomcat

[=- Build

. Build

- Clean

=J- Test

... Test

- Testpoints
- Debug

. Platform

- Tracepoints
- Workbench
=J- Intelli-sense

L. Libraries
.. Run
. Deploy
- Recording

. Simulation

Build Execute Command as:  Batch File -

javac.exe -g -verbose -cp V. ¥CLASSPATHY; BAPACHE_HOMEX'\lib'servlet- &
cd ..

jar cvf servlet.war *

1 4

Default Directory: | %VEA%%\avaTomcat\HelloServietiweb-Inf

Parse Output: Java SDK =

A single project can have multiple configurations and these can be found grouped together in the Analyzer window.

(c) Sparx Systems 2015 - 2017
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Execution Analyzer O x
B Eaed Bag da
A [ Project Model.Execution Analysis..NET.Source
[#] § BookTest
] &1 CExample
A @ Project Model Execution Analysis. . METVSTO
[ & ExcelWorkbook
@ Project Model Execution Analysis..MET Werkbench
03 Project Model.Execution Analysis.C++/Native.Source
@ Project Model Execution Analysis.GDB.Source
1§ Project Models.Execution Analysis.GDE.Source
@ Project Model Execution Analysis.Java.Source
09 Project Model.Execution Analysis.Java.Tomcat
@ Project Model Execution Analysis.Java.Workbench
09 Project Model.Execution Analysis.PHP Source
@ Project Model.Model Simulation.Interaction Models
09 Project Model.Model Simulation.State Machine Medels

b~ —

T

Each Analyzer Script is defined for a Package, so projects can co-exist quite happily. In many organizations, the
procedures to manage systems are distributed, and vary from individual to individual and group to group. Analyzer
Scripts in an Enterprise Architect model can provide some peace of mind to these organizations, by trusting a single,
shared and accountable procedure for building and deploying any variety of configurations. All aspects of a script are
optional. You can, for instance, debug without one. They can however, in a few lines, enable these powerful features:

e Building

e  Testing

e Debugging
e Recording

e Execution

e  Deployment

e  Simulation
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Managing Analyzer Scripts

The Execution Analyzer window enables you to manage all Analyzer scripts in the model. You can use the window
toolbar buttons or script context menu options to control script tasks. Scripts are listed by Package; the list only shows
Packages that have Analyzer scripts defined against them. Each user can set their own active script, independent of other
users of the same model; one user activating a script does not impact the currently active scripts for other users or affect
the scripts available to them. The active script governs the behavior of the Execution Analyzer; when choosing the build
command from a menu, for example, or clicking the Debug button on a toolbar.

Access

Ribbon
Context Menu

Keyboard Shortcuts

Toolbar Options:

Toolbar Button

gl -

f

(c) Sparx Systems 2015 - 2017

Execute > Analyze > Analyzer Scripts
Project Browser | Right-click on Package | Execution Analyzer

Shift+F12

Action

Quick access to the Analyzer core windows such as Call Stack or Local Variables,
plus the power features:

e Profiling
e Recording
e  Testpoints

e  Simulation

Create and edit a new Analyzer Script for a Package.

Export Scripts.

Export one or more Analyzer Scripts to an XML file, which can be used to import
the scripts into another model.

The 'Execution Analyzer: Export' dialog displays from which you select the script
or scripts to export, followed by a prompt for the target file name and location.

Import Scripts.

Import one or more Analyzer Scripts into the current model from a previously
exported XML file.

The 'Browse Project' dialog displays, on which you select the Package into which to
import the scripts, followed by a prompt for the source filename and location.

Execute the 'Build' command of the active script.

Page 13 of 214 Created with Enterprise Architect
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Context Menu Options:

Cancel the 'Build' command currently in progress.

Execute the 'Run' command of the active script.

Execute the 'Test' command of the active script.

Execute the 'Deploy' command of the active script.

Display the Help topic for this window.

Right-click on the required script or Package to display the context menus.

Option

Add New Script

Paste Script

Export Scripts

Import Scripts

Select In Project Browser

Build
Clean
Rebuild
Debug
Run

Test

(c) Sparx Systems 2015 - 2017

Action

Add a new script to the selected Package.
The Execution Analyzer window displays, showing the 'Build' page.

Paste a copied script from the Enterprise Architect clipboard into the selected
Package.

You can paste the copied script several times; each copy has the suffix 'Copy'.

To rename the copied script, press F2 and overtype the script name.
Export scripts from the selected Package.
The 'Execution Analyzer: Export' dialog displays, from which you select the script

or scripts to export, followed by a prompt for the target filename and location.

Import scripts from a . XML file into the selected Package.

A prompt displays for the source filename and location.

Highlight the selected Package in the Project Browser.

Display the Project Browser, which is now expanded to show the highlighted
Package.

Execute the 'Build' command of the selected script.

Execute the 'Clean' command of the selected script.

Execute the 'Clean' and 'Build' commands of the selected script.

Execute the 'Debug' command of the selected script.

Execute the 'Run' command of the selected script.

Execute the 'Test' command of the selected script.

Page 14 of 214 Created with Enterprise Architect
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Deploy Execute the 'Deploy' command of the selected script.

Start Simulation Start the simulation referenced by the 'Analyzer Script Simulation' page.

Edit Open the selected script in the 'Analyzer Scripts Editor'.

Copy Copy the selected script to the Enterprise Architect clipboard.

Paste Paste the most-recently copied script to the same Package as the selected script.

You can paste the copied script several times; each copy has the suffix 'Copy'.

To rename the copied script, press F2 and overtype the script name.

Delete Delete the selected script; there is no prompt for confirmation.

To delete a Package from the Execution Analyzer window, delete the scripts from
the Package. When the last script is deleted, the Package is no longer listed.

Set as Model Default Set the selected script as the default script for the model.
The icon to the left of the script changes color; any previous model default reverts
to normal.

Help Display the Help topic for this window.

(c) Sparx Systems 2015 - 2017 Page 15 of 214 Created with Enterprise Architect
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Analyzer Script Editor

The Analyzer Script Editor is a straightforward user interface with a tree view on the left for easy navigation of features,
and a content view on the right.

|§i Execution Analyzer: Tomcat

(- Build Build Execute Command as:  Batch File “
- Build
- Clean javac.exe -g -verbose -cp V. ¥CLASSPATHY; BAPACHE_HOMEX'\lib'servlet- &
- Test 'Ed o - *
ar cvf servlet.war
. Test ]
- Testpoints
- Debug
. Platform
- Tracepoints
- Workbench
B- Intelli-sense
.. Libraries
. Bun
- Deploy
- Recording 1 '
L Default Directory: | 2=VEA%:\JavaiTomcat\HelloServiet\Web-Inf
Parse Output: Java SDK ©
Access

On the 'Execution Analyzer' dialog, either:
e Double-click on a script to edit it or

e Right-click on the script and select the 'Edit' option

Ribbon Execute > Analyze > Analyzer Scripts
Context Menu Project Browser | Right-click on Package | Execution Analyzer
Keyboard Shortcuts Shift+F12

Execution Analyzer Scripts

Task - Page Action

Build - Build Enter script or command to build the application. This can be an Apache Ant or
Visual Studio command, but can also be tailored depending on your development
environment. Note: Remember to select a parser to get directly to the source code
in the event of any errors. The parser field is on the same page and offers support
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for many languages.

Build - Clean Enter script or command to clean the previous build. This is the command line you
would normally issue to build your system. This can be an Apache Ant or Visual
Studio command depending on your development environment.

Test - Test Enter script or command to test the application. This is typically where an nUnit or
jUnit invocation might be configured, but it just as easily could be any procedure or
program.

Test - Testpoints Specify where the output from a Testpoint run is sent.

Debug - Platform Specify the debugging platform, the application to be debugged, and the mode of

debugging (attach to process or run).

Debug - Tracepoints Specify where the output from Tracepoints encountered during a debug session are
sent.

Debug - Workbench For .NET projects, the assembly to load. Not required for Java.

Run Enter a script or command to run the application.

Deploy Enter a script or command to deploy the project. Build your jar file. Deploy to your

device, an emulator or Tomcat server.

Publish a web site. Its up to you.

Recording Does your Sequence diagram look like the national grid? Reduce the clutter with
filters. Filters define exclusion zones in your code base that can cut down
dramatically on any 'noise' that is being recorded. Even accurate noise is not always
helpful.

Simulation Complete the configuration for Simulation Control.
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Build Scripts

The "Build' page enables you to enter commands to build your project. You can use Enterprise Architect Local Paths and
environment variables in composing your command line(s). You can choose to create your own build script, entering
various shell commands. You can also choose to simply run an external program or batch file such as an Ant script.

Access

On the Execution Analyzer window, either:

e Locate and double-click on the required script and select the 'Build > Build' page or

—Ah
e C(Clickon b in the window Toolbar and select the 'Build > Build' page

Ribbon Execute > Analyze > Analyzer Scripts
Context Menu Project Browser | Right-click on Package | Execution Analyzer
Keyboard Shortcuts Shift+F12

Execute Command As:

Batch File

Use this option to create a shell script. The script is executed in a system command window. Environment variables can
be accessed by commands in this script.

Process
Use this option to run a single program.

The command should specify the path to the program, plus any command line arguments. If the path or arguments
contain spaces surround them with quotes; for example: "c:\program files (x86)\java\bin\javac.exe"

Build Script

Write your script in the large text box, using the windows shell commands; the format and content of this section
depends on the actual compiler you use to build your project. Here are some examples:

Visual Studio:
"C:\Program Files (x86)\Microsoft Visual Studio 9.0\Common7\IDE\devenv.com" /Rebuild Debug RentalSystem.sln

Visual Studio using a Local Path:
"%VsCompPath%\devenv.exe" /build Debug Subway.sln

Java:

C:\Program Files (x86)\Java\jdk1.6.0 _22\bin\javac.exe" -g -cp "%classpath%;." %r* java

Java using a Local Path:
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"%JAVA%\bin\javac.exe" -g -cp "%classpath%;." %r*.java

Wildcard Java builds %r

Source files in sub folders can be built using the %r token. The token has the effect of causing a recursive execution of
the same command on any files in all sub folders. See the example above.

Default Directory

The default directory path in which the build script process will run.

Parse Output

This enables you to select a method for automatically parsing the compiler output.

If you select this option, output from the script is logged in the System Output window; Enterprise Architect parses the
output according to the syntax you specify.

Notes

To execute the Build Script, click on the Package in the Project Browser and either:
e Right-click on any Toolbar and select 'Analyzer Toolbars | Build', or
e  Press Ctrl+Shift+F12 or

e  Select the 'Execute > Run > Build > Build' ribbon option

(c) Sparx Systems 2015 - 2017 Page 19 of 214 Created with Enterprise Architect



User Guide - Visual Execution Analysis 30 June, 2017

Cleanup Script

Incremental builds are the practice of only building those assets that have changed in some way. There are times,
however, when there is cause to build everything again from scratch. This command is used for those occasions, to
remove the binaries and intermediary files associated with a particular build or configuration. The project can then be
rebuilt. When you execute the 'Rebuild' menu option on a script, the command(s) you specify in this field are executed,
followed immediately by the 'Build' command from the same Analyzer script. Some compilers have options do this for
you. Visual studio for example has the "/clean" command line switch.

Access

On the Execution Analyzer window, either:

e Locate and double-click on the required script and select the 'Build > Clean' page or

e
e C(Clickon b in the window Toolbar and select the 'Build > Clean' page

Ribbon Execute > Analyze > Analyzer Scripts
Context Menu Project Browser | Right-click on Package | Execution Analyzer
Keyboard Shortcuts Shift+F12
Aspects
Aspect Detail
Action Enter the command to be executed when you select 'Clean' from the script context
menu.
Example devenv.com /Clean Debug MyProject.sln
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Debug Script

The process of configuring the Debug section of an Analyzer Script is usually a one time affair that rarely has to be
revisited. So once you have your script working, you probably wont have to think about it again. The details you provide
are not complicated, yet doing so provides access to a great many benefits. Here are some:

e Debugging

e Sequence diagram recording,

e Executable StateMachine execution and simulation

e Test domain authoring and recording

e Behavioral profiling of processes on a variety of runtimes.

All you need to do is select the appropriate platform and enter some basic details. The debugger platforms you can use
include:

e Java

e Java Debug Wire Protocol (JDWP)

e Microsoft NET Debugger

e Microsoft Native Code Debugger (C++, C, VB)
e  The PHP Debugger

e  The GNU Debugger (GDB)

Access
Ribbon Code > Build and Run > Analyzer > Analyzer Scripts
Execute > Analyze > Analyzer Scripts
Context Menu Right-click on Package | Execution Analyzer
Keyboard Shortcuts Shift+F12
Notes

e An Analyzer script is not necessary for debugging Enterprise Architect model scripts (JavaScript, VBScript etc.)
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Operating System Specific Requirements

The Enterprise Architect debugger is able to operate on a number of different platforms. This table describes the
individual requirements for debugging on each platform.

Platforms
Platform Detail

Microsoft NET e  Microsoft™ NET Frameworks 4.0, 3.5 and 2.0
e Language support: C, C#, C++, J#, VB.NET

Java e Java SE Development Kit from Oracle™ (version 5.0 minimum) (either 32-bit

or 64-bit JDK)

The Java Platform Debugger Architecture (JPDA) was introduced in Java SE
version 5.0. The JPDA provides two protocols for debugging; the Java Virtual
Machine Tools Interface (JVMTI), and the Java Debug Wire Protocol (JDWP).
Enterprise Architect's debugger supports both protocols.

GNU Debugger (GDB) Enterprise Architect supports debugging using the GNU Debugger, which enables
you to debug your applications under Linux either locally or remotely.
Requires GDB version 7.0 or above.
Source code file path must not contain spaces.

Windows for Native Enterprise Architect supports debugging native code (C, C++ and Visual Basic)

Applications compiled with the Microsoft™ compiler where an associated PDB file is available.

PHP Enterprise Architect enables you to perform local and remote debugging of PHP
scripts in web servers.
Requires web server to be configured to support PHP.
Requires PHP to be configured to support XDebug PHP (3rd party PHP extension)

Notes

e The debugging facility is available in the Enterprise Architect Professional Edition and above

e Debugging under Windows Vista (x64) - if you encounter problems debugging with Enterprise Architect on a 64-bit
platform, you should build a platform specific configuration in Visual Studio; that is, do not specify the AnyCPU
configuration, specify either Win32 or x64 explicitly
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UAC-Enabled Operating Systems

The Microsoft operating systems Windows Vista and Windows 7 provide User Account Control (UAC) to manage
security for applications.

The Enterprise Architect Visual Execution Analyser is UAC-compliant, and users of UAC-enabled systems can perform
operations with the Visual Execution Analyser and related facilities under accounts that are members of only the Users

group.
However, when attaching to processes running as services on a UAC-enabled operating system, it might be necessary to
log in as an Administrator.

Log in as Administrator

Step Action

1 Before you run Enterprise Architect, right-click on the Enterprise Architect icon on the desktop and select
the Run as administrator option.

Alternatively

Edit or create a link to Enterprise Architect and configure the link to run as an Administrator.

Step Action

1 Right-click on the Enterprise Architect icon and select the 'Properties’ option.
The Enterprise Architect 'Properties' dialog displays.

2 Click on the Advanced button.
The 'Advanced Properties' dialog displays.

3 Select the 'Run as administrator' checkbox.

4 Click on the OK button, and again on the 'Enterprise Architect Properties' dialog.
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WINE Debugging
Configure Enterprise Architect to debug under WINE

Step Action

1 At the command line, run § winecfg.

2 Set the library overrides for dbghelp to (native, builtin), and accept the warning about overriding this
DLL.

3 Set dbghelp to native by using winecfg.

4 Copy the application source code plus executable(s) to your bottle.

The path must be the same as the compiled version; that is:

If Windows source = C:\Source\SampleApp, under Crossover it must be

C:\Source\SampleApp

5 Copy any Side-By-Side assemblies that are used by the application.

Access Violation Exceptions

Due to the manner in which WINE handles direct drawing and access to DIB data, an additional option is provided on
the drop-down menu on the Debug window toolbar to ignore or process access violation exceptions thrown when your
program directly accesses DIB data.

Select this option to catch genuine (unexpected) access violations; deselect it to ignore expected violations.

As the debugger cannot distinguish between expected and unexpected violations, you might have to use trial and error to
capture and inspect genuine program crashes.

Notes

o If WINE crashes, the back traces might not be correct
e Ifyou are using MFC remember to copy the debug side-by-side assemblies to the C:\window\winsxs directory

e To add a windows path to WINE, modify the Registry entry:
HKEY LOCAL MACHINE\System\CurrentControlSet\Control\Session Manager\Environment
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Java

This section describes how to set up Enterprise Architect for debugging Java applications and Web Servers.
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General Setup for Java

The general setup for debugging Java Applications supports two options:

e Debug an Application

e  Attach to an application that is running

Option 1 - Debug an Application

Field

Debugger

x64

Mode

Default Directory

Application Class

Command Line Arguments

Java Virtual Machine
Options
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Action

Select Java.

Select this checkbox if you are debugging a 64-bit application.
Deselect the checkbox if you are debugging a 32-bit application.

Select Run.

This path is added to the class path property when the Java Virtual Machine is
created.

Identify the fully qualified Class name to debug; the Class must have a method
declared with this signature:

public static void main(String());

Application Class samples, Collector
Command Line “param1” param2 “param3” param4
Arguments:

Specify any parameters to be passed to the main method of the Application Class
above.

Parameters containing spaces should be surrounded with double quotes.

Specify command line options for Virtual Machine creation.

You also must provide a parameter (JRE) as the path to be searched for the jvm.dll;
this is the DLL supplied as part of the Java runtime environment or Java JDK from
Sun Microsystems™.

The JRE parameter can be either:
e An Enterprise Architect-defined Local Path

e An absolute file path (with no double quotes) to the installation folder of the
Java JDK to be used for debugging

The JRE parameter must point to the installation folder for the Java JDK. A JDK
installation is necessary for debugging to succeed. The JRE should not point to the
installation of the public Java Runtime Environment, if that is installed.
Environment variables can be used when specifying the VM startup options, such
as classpath.

For example, using:

e An Enterprise Architect Local Path JAVA and an environment variable
classpath:
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Java Virtual Machine Options;
JRE=":JAVAY:, Djava.dass. path="%dasspath%;. ;

e  Or an absolute path to the JDK installation directory and an environment
variable classpath:

Java Virtual Machine Options:
JRE=C:'Program Files (x88)Java'jdk 1. 7.0, Djava. dass. path="%dasspath%a;.;

In these two examples, the debugger will create a virtual machine using the JDK
located at the value of the JRE parameter.

If no classpath is specified, the debugger always creates the virtual machine with a
class path property equal to any path contained in the environment variable plus the
path entered in the default working directory of this script.

If source files and .class files are located under different directory trees, the
classpath property MUST include both root path(s) to the source and root path(s) to
binary class files.

Option 2 - Attach to Virtual Machine

There is very little to specify when attaching to a VM; however, the VM must have the Sparx Systems debugging agent
loaded.

Field Action
Debugger Select Java
Mode Select Attach to Virtual Machine

(c) Sparx Systems 2015 - 2017 Page 27 of 214 Created with Enterprise Architect



User Guide - Visual Execution Analysis 30 June, 2017

Advanced Techniques

In addition to the standard Java debugging techniques, you can:

e Attach to Virtual Machine

e Internet Browser Java Applets
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Attach to Virtual Machine

You can debug a Java application by attaching to a process that is hosting a Java Virtual Machine; you might want to do
this for attaching to a webserver such as Tomcat or JBOSS.

The Java Virtual Machine Tools Interface from Sun Microsystems is the API used by Enterprise Architect; it allows a
debugging agent to be specified when the JVM is created.

To debug a running JVM from Enterprise Architect, the Sparx Systems' debugging agent must have been specified as a
startup option to the JVM when it was started; how this is accomplished for products such as Tomcat and JBOSS should
be researched from that product's own documentation.

For java.exe, the command line option to load the Enterprise Architect debugging agent could be (depending on your
environment):

e -agentpath:"c:\program files\sparx systems\ea\VEA\x86\SSJavaProfiler32"
e -agentpath:"c:\program files (x86)\sparx systems\ea\VEA\x86\SSJavaProfiler32"
e -agentpath:"c:\program files (x86)\sparx systems\ea\VEA\x64\SSJavaProfiler64"

The appropriate option will depend on your operating system and whether you are working on a 32-bit application or a
64-bit application.

Alternatively, if you add the appropriate VEA directory to your PATH environment variable you can choose to use:
e -agentlib:SSJavaProfiler32
e -agentlib:SSJavaProfiler64

It is not necessary to configure an Analyzer Script when you attach to a Virtual Machine; you can just use the Attach
button on one of the Analyzer toolbars.

If you configure an Analyzer Script, there are only two things that must be selected:
e Select 'Java' as the debugging platform
e  Choose the 'Attach to Virtual Machine' option
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Internet Browser Java Applets

This topic describes the configuration requirements and procedure for debugging Java Applets running in a browser from
Enterprise Architect.

Attach to the browser process hosting the Java Virtual Machine (JVM) from
Enterprise Architect

Step

1

Action

Ensure binaries for the applet code to be debugged have been built with debug information.

Configure the JVM using the Java Control Panel.

In the Java Applet Runtime Settings panel, click on the View button.

On the installed version to use, include one of these options in the 'Runtime Parameters' field, depending

on your environment and whether you are working on a 32-bit application or a 64-bit application:
-agentpath:"c:\program files\sparx systems\ea\VEA\x86\SSJavaProfiler32"

-agentpath:"c:\program files (x86)\sparx systems\ca\VEA\x86\SSJavaProfiler32"
-agentpath:"c:\program files (x86)\sparx systems\ea\VEA\x64\SSJavaProfiler64"

In this field add the required Class paths.

At least one of these paths should include the root path of the source files to use in debugging.
Set breakpoints.
Launch the browser.

Attach to the browser process from Enterprise Architect.
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Working with Java Web Servers

If you are debugging Java web servers such as JBOSS and Apache Tomcat (both Server configuration and Windows
Service configuration) in Enterprise Architect, apply these configuration requirements and procedures.

Note: The debug and record features of the Visual Execution Analyzer are not supported for the Java server platform
"Weblogic' from Oracle.

Attach to process hosting the Java Virtual Machine from Enterprise Architect

Step Action

1 Build binaries for the web server code to be debugged, with debug information.

2 Launch the server with the 'Virtual Machine startup' option, described in Server Configuration.
3 Import source code into the Enterprise Architect Model, or synchronize existing code.

4 Set breakpoints.

5 Launch the client.

6 Attach to the process from Enterprise Architect.

Server Configuration

The configuration necessary for the web servers to interact with Enterprise Architect must address these two essential
points:

e Any VM to be debugged, created or hosted by the server must have the Sparx Systems Agent command line option
specified or in the VM startup option (that is:
-agentlib:SSJavaProfiler32 or -agentlib:SSJavaProfiler64)

e The CLASSPATH, however it is passed to the VM, must specify the root path to the Package source files

The Enterprise Architect debugger uses the java.class.path property in the VM being debugged, to locate the source file
corresponding to a breakpoint occurring in a Class during execution; for example, a Class to be debugged is called:

ab.C
This is located in physical directory:
C:\source\a\b
So, for debugging to be successful, the CLASSPATH must contain the root path:

c:\source

Analyzer Script Configuration

Using the 'Debug' tab of the 'Build Script' dialog, create a script for the code you have imported and:
e  Select the 'Attach to process' radio button and, in the field below it, type 'attach’
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e In the 'Use Debugger field, click on the drop-down arrow and select 'Java'

All other fields are unimportant; the 'Directory’ field is normally used in the absence of any Class path property.

Run the Debugger

The breakpoints could show a question mark. In this case the Class might not have been loaded yet by the VM. If the
question mark remains even after you are sure the Class containing the breakpoint has been loaded, then either:

e The binaries being executed by the server are not based on the source code
e The debugger cannot reconcile the breakpoint to a source file (check Class paths), or

e The JVM has not loaded the Sparx Systems agent

Step Action

1 Run the server and check that the server process has loaded the Sparx Systems Agent:
DLL SSJavaProfiler32.DLL or SSJavaProfiler64

Use 'Process Explorer' or similar tools to prove that the server process has loaded the agent.
2 In Enterprise Architect, open the source code and set some breakpoints.

3 Click on the Run Debug button in Enterprise Architect.
The 'Attach To Process' dialog displays.

4 Select the server process hosting the application.

5 Click on the OK button.

A confirmation message displays in the Debug window, stating that the process has been attached.
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JBOSS Server

In this JBoss example, for a 32-bit application, the source code for a simple servlet is located in the directory location:
C:\Benchmark\Java\]BOSS\Inventory

The binaries executed by JBOSS are located in the JAW.EAR file in this location:
C:\JBOSS\03b-dao\build\distribution

The Enterprise Architect debugger has to be able to locate source files during debugging; to do this it also uses the
CLASSPATH, searching in any listed path for a matching JAVA source file, so the CLASSPATH must include a path to
the root of the Package for Enterprise Architect to find the source during debugging.

This is an excerpt from the command file that executes the JBOSS server; the Class to be debugged is at:

com/inventory/dto/carDTO
Therefore, the root of this path is included in the JBOSS CLASSPATH.

Example Code

set SOURCE=C:\Benchmark\Java\JBOSS\Inventory

set JAVAC JAR=%JAVA HOME%\lib\tools.jar

if "%JBOSS_CLASSPATH%" ==""

(

set JBOSS CLASSPATH=%SOURCE%;%JAVAC_ JAR%;%RUNJAR%;

)

else

(

set JBOSS CLASSPATH=%SOURCE%;%JBOSS CLASSPATH%;%JAVAC_ JAR%;%RUNJAR%;

)
set JAVA_OPTS=%JAVA_OPTS% -agentpath:"c:\program files\sparx systems\vea\x86\ssjavaprofiler32"
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Apache Tomcat Server

The Apache Tomcat Server can be configured for debugging using the Java debugger in Enterprise Architect. This
example shows the configuration dialog for Apache Tomcat 7.0 on a PC running Windows 7.

‘g. Apache Tomcat 7.0 Tomcat? Properties

23|

| General I Log On | Logging | Java |513rtu|:| | Shutdown

[] Use default
Java Virtual Machine:

C:\Program Files (x36)Javayjdk 1. 7.0_04rebinidientjvm.dl D
Java Classpath:
C:\Tomcatwebappsserviet\WEB-IMNF\src; C: \Tomcatbin'bootstrap.jar; C

Java Options:

-Djava util, Ingglng manager = Drg apache.juli, CIassLDaderLogManage -

Initial memory poal: ME
Maximum mermory poal: ME
Thread stack size: KB

[ Ok, ][ Cancel H Apply

These three points are important:

e The 'Java Virtual Machine' specifies the runtime from an installation of the Java JDK

e The source path to any servlet to be debugged is added to Java Classpath; in this case we add the path to the Tomcat
servlet:
c:\tomcat\webapps\servlet\ WEB-INF\src

e The 'Java Options' include the path to the Sparx Systems debugging agent:
-agentpath:c:\program files (x86)\sparx systems\vea\x86\ssjavaprofiler32
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Apache Tomcat Windows Service

Configuration

For users running Apache Tomcat as a Windows™ service, it is important to configure the service to enable interaction
with the Desktop; failure to do so causes debugging to fail within Enterprise Architect.

Log on as:

@ Local System account
Allow service to interact with desktop

Select the 'Allow service to interact with desktop' checkbox.
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NET

This section describes how to configure Enterprise Architect for debugging .NET applications. It includes:
e General Setup for NET

e  Debugging an Unmanaged Application
e Debug COM Interop
e Debug ASP .NET
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General Setup for .NET

This is the general setup for debugging Microsoft .NET applications. You have two options when debugging:
e Debug an application

e  Attach to an application that is running

Option 1 - Debug an application

Field Action
Debugger Select Microsoft .NET as the debugging platform.
x64 Select this checkbox if you are debugging a 64-bit application.

Deselect the checkbox if you are debugging a 32-bit application.

Mode Select the Run radio button.
Default Directory This is set as the default directory for the process being debugged.
Application Path Select and enter either the full or the relative path to the application executable.

e Ifthe path contains spaces, specify the full path; do not use a relative path

e Ifthe path contains spaces, the path must be enclosed by quotes

Command Line Arguments Parameters to pass to the application at startup.
Show Console Create a console window for the debugger; not applicable to attaching to a process.
Symbol Search Paths Specify any additional paths to locate debug symbols for the debugger; separate the

paths with a semi-colon.

Option 2 - Attach to an application that is running

Field Action
Debugger Select Microsoft .NET as the debugging platform.
x64 Select this checkbox if you are debugging a 64-bit application.

Deselect the checkbox if you are debugging a 32-bit application.

Mode Select the Attach to Process radio button.
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Debugging an Unmanaged Application

If you are debugging managed code using an unmanaged application, the debugger might fail to detect the correct
version of the Common Language Runtime (CLR) to load.

You should specify a config file if you don’t already have one for the debug application specified in the Debug command
of your script.

The config file should reside in the same directory as your application, and take the format:
name.exe.config
where 'name' is the name of your application.
The version of the CLR you specify should match the version loaded by the managed code invoked by the debuggee.
This is a sample config file:
<configuration>
<startup>
<requiredRuntime version="version "/>
</startup>
</configuration>

'Version' is the version of the CLR targeted by your plugin or COM code.
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Debug COM Interop

Enterprise Architect enables you to debug .NET managed code executed using COM in either a Local or an In-Process
server.

This feature is useful for debugging Plugins and ActiveX components.

Debug .NET Managed Code Executed Using COM

Step Action

1 Create a Package in Enterprise Architect and import the code to debug.

2 Ensure the COM component is built with debug information.

3 Create a Script for the Package.

4 In the 'Debug | Platform' page, you can select to either attach to an unmanaged process or specify the path

to an unmanaged application to call your managed code.

5 Add breakpoints in the source code to debug.

Attach to an Unmanaged Process

If you are using:
e An In-Process COM server, attach to the client process
e A Local COM Server, attach to the server process

Click on the Debug window Run button (or press F6) to display a list of processes from which you can choose.

Notes

e Detaching from a COM interop process you have been debugging terminates the process; this is a known issue for
Microsoft .NET Framework, and information on it can be found on many of the MSDN .NET blogs
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Debug ASP .NET

Debugging for web services such as ASP requires that the Enterprise Architect debugger is able to attach to a running
service.

Begin by ensuring that the directory containing the ASP NET service project has been imported into Enterprise
Architect and, if required, the web folder containing the client web pages.

If your web project directory resides under the website hosting directory, you can import from the root and include both
ASP code and web pages at the same time.

It is necessary to launch the client first, as the ASP .NET service process might not already be running; load the client
using your browser - this ensures that the web server is running.

In the debug setup you would then select the 'Attach' radio button. When this choice is selected, the debugger will
prompt you each time for the process to debug.

Click on the Debug window Run button to start the debugger; the 'Attach To Process' dialog displays.

The name of the process varies across Microsoft operating systems, as explained in the ASP .NET SDK; for example,
under Windows Vista the name of the IIS process is w3wp.exe.

On Windows XP, the name of the process resembles aspnet_wp.exe, although the name could reflect the version of the
NET framework that it is supporting.

There can be multiple ASP.NET processes running under XP; you must ensure that you attach to the correct version,
which would be the one hosting the .NET framework version that your application runs on; check the web.config file for
your web service to verify the version of NET framework it is tied to.

The Debug window Stop button should be enabled and any breakpoints should be red, indicating they have been bound.

You can set breakpoints at any time in the web server code. You can also set breakpoints in the ASP web page(s) if you
imported them.

Notes

Some breakpoints might not have bound successfully, but if none at all are bound (indicated by being dark red with
question marks) something has gone out of synchrony; try rebuilding and re-importing source code
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The Enterprise Architect PHP Debugger enables you to debug PHP.exe scripts. This section discusses basic setup and the
various debugging scenarios that are commonly encountered; the scenarios concern themselves with the mapping of file
paths, which is critical to the success of a remote debugging session.

Script Setup

Local Windows Machine (Apache Server)
Local Windows Machine (PHP.exe)

Remote Linux Machine (Apache Server)

Remote Linux Machine (PHP.exe)

Setup and Scenarios

Scenario

Details

Script Setup An Analyzer Script is a basic requirement for debugging in Enterprise Architect;
you create a script using the toolbar of the Execution Analyzer.

Select PHP.XDebug as the debugging platform; when you select this platform the
property page displays these connection settings:

host - localhost - The adaptor that Enterprise Architect listens on for incoming
connections from PHP

localpath - %LOCAL% - Specifies the local file path to be mapped to a remote
file path; this is a remote debugging setting - for local debugging, clear the
value, the value is a placeholder and you should edit it to fit your particular
scenario

remotepath - Y% REMOTE% - Specifies the remote file path that a local file path
is to be mapped to; this is a remote debugging setting - for local debugging,
clear the value, the value is a placeholder and you should edit it to fit your
particular scenario

logging - Enter true or false to enable logging of communication from XDebug
server

output - names the file path on the remote machine to be used with the logging
option; this file will always be overwritten

Local Machine Apache In this situation, consider this configuration:

Server o

O/S: Windows7
Network computer name: MyPC
Network share MyShare mapped to c:\myshare

Source files in Enterprise Architect have been imported from
c:\myshare\apache\myapp\scripts

Apache document root is set to /MyPC/MyShare/apache

In this scenario an Analyzer Script for the connection parameters might be
configured as:
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host: localhost

port: 9000

localpath: c:\myshare\apache\
remotepath: MyPC/MyShare/apache/
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Local Machine PHP.EXE In this scenario an Analyzer Script for the connection parameters might be
configured as shown, as file paths always map to same physical path:

e  host: localhost
e port: 9000
e localpath:

e remotepath:

Remote Linux Machine In this situation consider this configuration:
Apache Server e Local Machine
e O/S: Windows7

e Source files in Enterprise Architect have been imported from
c:\myshare\apache\myapp\scripts

e Remote Machine

e O/S: Linux

e Apache document root is set to home/apache/htdocs

e  Source files in Apache are located at home/apache/htdocs/myapp/scripts

In this scenario an Analyzer Script for the connection parameters might be
configured as:

e  host: localhost
e port: 9000
e localpath: c:\myshare\apache\

e remotepath: home/apache/htdocs/

Remote Linux Machine In this situation consider this configuration:
PHP.exe e Local Machine
e O/S: Windows7

e Source files in Enterprise Architect have been imported from
c:\myshare\apache\myapp\scripts

e Remote Machine
e O/S: Linux
e  Source files in Apache located at home/myapp/scripts

In this scenario an Analyzer Script for the connection parameters might be
configured as:

e host: localhost
e port: 9000
e Jocalpath: c:\myshare\apache\

e remotepath: home/

PHP Global variables When you are at a breakpoint, you can examine the values of PHP globals using the
Analyzer Watch window. To list every global, type either 'globals' or 'superglobals'
into the field. To show an individual item, enter its name. This image shows the
value of the PHP environment variable § SERVER being displayed.
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Watches v X
$_SERVER =
Variable Value Type Address
= & % _SERVER array[31] 00000001k | &

& $_SERVER[O] "127.0.0.1" string 00000001

& $_SERVER[1] "keep-alive" string 0x0000001d

& $_SERVER[Z] "max-age=0" string Ox0000001e

& $_SERVER[3] -1~ string 0x0000001F

& $_SERVER[¥] "Mozilla/5.0 (X11; Linux x86_64) AppleW string 000000020

& $_SERVER[3] “text/html,application/xhtml+xmlLapplic  string Ox00000021

& $_SERVER[g] "gzip, deflate, sdch" string 000000022

& $_SERVER[T] "en-Us,en; q=0.8" string 000000023

& $_SERVER[2] "fusrflocalfsbin: fusrflocal/bin:fusrisbin:/ string Ox00000024

@& $_SERVER[Z] "<address=Apache/2.4.7 (Ubuntu) Serv  string Ox00000025

& E f "A Ubuntu)” string 3

& $_SERVER[11] "127.0.0.1 string 000000027

& $_SERVER[1Z] "127.0.0.1" string (00000028  |w
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This topic identifies the system requirements and operating systems for the Enterprise Architect PHP debugger.

System Requirements:

e  Enterprise Architect version 9
e PHP version 5.3 or above
e PHP zend extension XDebug 2.1 or above

e For web servers such as Apache, a server version that supports the PHP version

Supported Operating Systems:

e  Client (Enterprise Architect)

e Microsoft Windows XP and above
e  Linux running Crossover Office

e Server (PHP)

e Microsoft Windows XP and above

e Linux
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PHP Debugger Checklist

This topic provides a troubleshooting guide for debugging PHP scripts in Enterprise Architect.

Check Points

Check Point Details

System Requirements e Apache HTTP Web Server version 2.2
e PHP version 5.3 or above

e  XDebug version 2.1.1

Enterprise Architect e The model has an Analyzer Script configured to use the PHP XDebug platform

e PHP source code has been imported into the model (for recording and
testpoints)

e When the PHP XDebug platform is selected from the 'Analyzer Script' dialog,
default runtime settings are listed in the 'Connection' field:

localpath:%LOCAL%
remotepath: % REMOTE%

Either define local paths for these default variables or edit the script to provide
actual paths.

For example: local source, remote source
localpath:c:\code samples\vea\php\sample
remotepath:webserver/sample

e 'webserver' is a network or local share

e 'sample' is a folder below share

PHP In order to debug PHP scripts in Enterprise Architect, it is a requirement that the
PHP is configured properly to load the XDebug extension.

Settings similar to these should be used:
e [xdebug]

e xdebug.extended info=1

e xdebug.idekey=eca

e xdebug.remote enable=1

e xdebug.remote_handler=dbgp

e xdebug.remote autostart=1

e xdebug.remote host=X.X.X.X

e xdebug.remote port=9000

e xdebug.show local vars=1

The IP address X.X.X.X refers to and should match the host specified in the model
Analyzer Script.

The IP address is the address XDebug connects with and the same address the
Enterprise Architect PHP agent listens on.

Apache For debugging using Apache, these lines should be present in the Apache
configuration file, httpd.conf:
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LoadModule php5 module "php_home/phpSapache2 2.d11"
AddHandler application/x-httpd-php .php
PHPIniDir "php _home"

The value "php_home" is the PHP installation path (the path where php.ini and
apache dll exist).

Troubleshooting To prevent both PHP and Apache timeouts during a debugging session, these
settings might require modification.

The settings were used while developing the PHP Debugging agent in Enterprise
Architect.

PHP File: php.ini
; Enterprise Architect prevents PHP timeouts when debugging PHP extensions

max_execution_time =0

; Enterprise Architect prevents web server timeouts when debugging PHP
extensions

max_input_time = -1

; Enterprise Architect logs errors

display_errors = On

; Enterprise Architect displays startup errors

display_startup errors = On

Apache File: httpd.conf
; Enterprise Architect prevents timeouts while debugging php extensions
Timeout 60000
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The GNU Debugger (GDB)

When debugging your applications you can use the GNU Debugger (GDB), which is portable and runs on Unix-like
systems such as Linux, as well as on Windows. The GDB works for many programming languages including Ada, Java,
C, C++ and Objective-C. Using the GDB, you can debug your applications either locally or remotely.

Access

On the Execution Analyzer window, either:

e Locate and double-click on the required script and select the 'Debug > Platform' page  or

—Ah
e Clickon & in the window Toolbar and select the 'Debug > Platform' page

Ribbon Execute > Analyze > Analyzer Scripts
Context Menu Project Browser | Right-click on Package | Execution Analyzer
Keyboard Shortcuts Shift+F12

Set up the GNU Debugger

Task Details

Set up Script An Analyzer Script is a basic requirement for debugging in Enterprise Architect;
you create a script using the Execution Analyzer toolbar.

On the 'Platform' page of the Execution Analyzer Script Editor, in the 'Debugger’
field click on the drop-down arrow and select 'GDB'.

Define Connection Settings The property panel displays a number of connection settings for which you provide
values.

e path - <path> - The complete file path of the GDB executable; you only
specify this if the GDB cannot be found in the system path

e source - <path>, <path> - The path in which the debugger will search for
source files, if they do not reside in the executable directory.

e remote - F - Set for remote debugging; otherwise leave blank.
e port - <nnnnn> - The port to connect to on the remote server.
e  host - localhost - The host name to connect to.

e fetch - T - Set to retrieve the binary from the remote system.
e dumpgdb - <path> - The filename to write the GDB output to.
e initpath - <path> - The complete file path to the gbinit file.

Notes
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e A requirement of the GDB is that your source code file path does not contain spaces; the debugger will not run
correctly with spaces in the file path
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If you are developing Java applications running on Android devices or emulators, you can also debug them. The Local

and Remote machines can be on either a 32-bit platform or a 64-bit platform.

s ~

Remote Machine l‘j]
ExecutionEnvironment

Port Forwarding
Software

-

~

Local Machine l‘j]
ExecutionEnvironment

Enterprise

Architect

Android Debug

Bridge (ADB) «device»

Android Emulator

s ~\

Android Device l‘j]
ExecutionEnvironment

«executionEnvironment»
Java

App

System Requirements

On the Remote machine, this software is required:

e Android SDK, which includes the android debug bridge, ADB (you need to be familiar with the SDK and its tools)

e Java JDK (32 and 64 bit support)
e  Port Forwarding software (3rd party)

On the Local machine, this software is required:

e  Enterprise Architect Version 10 or higher

Analyzer Script Settings
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Field/Button

Debugger

Run

Default Directory
Application path
Command Line Arguments
Build first

Show console

Show diagnostic messages
Connection

Port

Host

Source

Logging

Output

Platform
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Action

Click on the drop-down arrow and select Java (JDWP).
Click on this radio button.

Not applicable - leave blank.

Not applicable - leave blank.

Not applicable - leave blank.

Not applicable - leave blank.

Not applicable - leave blank.

Not applicable - leave blank.

Not applicable - leave blank.

This is the application port, forward-assigned using adb or other means, through
which Enterprise Architect and the Android Virtual Machine (VM) can
communicate.

Host computer (defaults to localhost)

If Android is running on an emulator on a device attached to a networked computer,
enter the network name here.

By default, debugging will attempt to connect to the port you specify on the local
machine.

This is the source equivalent of the classpath setting in Java.

The root to each source tree should be listed. If more than one is specified, they
should be separated by a semi-colon; that is:

c:\myapp\src;c:\myserver\src

You must specify at least one root source path.

When a breakpoint occurs the debugger searches for the java source in each of the
source trees listed here.

Enables logging additional information from debugger

possible values: true,false,1,0,yes,no

Specifies the full name of the local log file to be written.
The folder must exist or no log will be created.

The log file typically contains a dump of bytes sent between debugger and VM.

If you are debugging Java running under any android scenario, select Android.

For all other scenarios, select Java.
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Configure Ports for Debugging - Port Forwarding (Local)

The debugger can only debug one VM at a time; it uses a single port for communication with the VM. The port for the
application to be debugged can be assigned using ADB, which is supplied with the Android SDK.

Before debugging, start the application once in the device. When the app starts, discover its process identifier (pid):
adb jdwp

The last number listed is the pid of the last application launched; note the pid and use it to allow the debugger to connect
to the VM:

e adb forward tcp:port jdwp:pid
- port = port number listed in analyzer script
- pid = process id of the application on the device

Configure Ports for Debugging - Port Forwarding (Remote)

To debug remotely the same procedure should be followed as for the local machine, but the communication requires
additional forwarding as the socket created using the adb forward command above will only listen on the local adapter.
The socket is bound to the localhost and attempts to connect to this port will be met with connection refused messages.

In order to achieve remote debugging it is necessary to have a proxy running on the remote machine that listens to all
incoming connections and forwards all traffic to the adb port; there are numerous software products available to do this.

Remote debugging with Enterprise Architect will not work unless a proxy port forwarder has been configured by the
user.
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Java JDWP Debugger

Java provides two main debugging technologies: an in-process agent-based system called the Java Virtual Machine Tools
Interface (JVMTI) and a socket-based paradigm called the Java Debug Wire Protocol (JDWP). A Java Virtual Machine
can name either one of these but not both, and the feature must be configured when the JVM is started.

System Requirements

1. The Enterprise Architect JDWP debugger will only be able to communicate with a JVM started with the 'TDWP'
option. Here is an example of the command line option:
java -agentlib:jdwp=transport=dt_socket,address=localhost:9000,server=y,suspend=n -cp
"c:\java\myapp;%classpath%" demo.myApp "paraml" "param2"

The Virtual Machine should not be currently attached to a debugger.

It is not possible for a VM to be debugged by Enterprise Architect and Eclipse at the same time.

Analyzer Script Settings

Field/Button

Debugger

Run

Default Directory
Application path
Command Line Arguments
Build first

Show console

Show diagnostic messages
Connection

Port

Host

Source
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Action

Click on the drop-down arrow and select Java (JDWP).

Click on this radio button to run the debugger when the script is executed.
Not applicable - leave blank.

Not applicable - leave blank.

Not applicable - leave blank.

Not applicable - leave blank.

Not applicable - leave blank.

Not applicable - leave blank.

Not applicable - leave blank.

Set the application port forward-assigned to the VM process during start-up, in the
Java command-line options.

Set the host computer (defaults to localhost)
If VM is running on a networked computer, enter the network name or url here.

By default debugging will attempt to connect to the port you specify on the local
machine.

This is the source equivalent of the classpath setting in Java.

List the root to each source tree; specify at least one root source path. If you specify
more than one, separate them with a semi-colon; for example:
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c:\myapp\src;c:\myserver\src

When a breakpoint occurs the debugger searches for the Java source in each of the
source trees listed here.

Logging Enable or disable logging of additional information from the debugger.
Possible values include:
e true
o false
o
o (
® yes
e no
Output Specify the full name of the local log file to be written. If the folder does not

already exist, no log will be created.

The log file typically contains a dump of bytes sent between the debugger and VM.

Platform Select Java.

Configure Ports for Debugging

The debugger can only debug one VM at a time; it uses a single port for communication with the VM. The port for the
application to be debugged is assigned when the VM is created.

Local Debugging

Where both Enterprise Architect and the Java VM are running on the same machine, you can perform local debugging. It
is necessary to launch the VM with the JDWP transport enabled - see the documentation on Java Platform Debugger
Architecture (JPDA) at Oracle for the command line option specifications. For example:

java -agentlib:jdwp=transport=dt_socket,address=localhost:9000,server=y,suspend=n -cp
"c:\samples\java\myapp;%eclasspath%" samples.MyApp "param1" "param2"

In this example the values for the Analyzer script would be 'host = localhost' and 'port = 9000'.

Remote Debugging

Where Enterprise Architect is running on the local machine and the Java VM is running on a remote machine, you can
perform remote debugging. It is necessary to launch the VM with the JDWP transport enabled - see the documentation
on JPDA at Oracle for the command line option specifications. Here is an example, where the remote computer has the
network name test01:

java -agentlib:jdwp=transport=dt_socket,address=9000,server=y,suspend=n -cp
"c:\samples\java\myapp;%classpath%"

samples.MyApp "param1" "param2"

Note the absence of a host name in the address. This means the VM will listen for a connection from the network not just
the local machine. In this example the values for the Analyzer script would be host = test01 and port = 9000.
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Tracepoint Output

The Tracepoints page of the Analyzer Script enables you to direct where the output from any Trace statements goes
during a debug session.

Access

On the Execution Analyzer window, either:

e Locate and double-click on the required script and select the 'Debug > Tracepoints' page or

s
e C(Clickon b in the window Toolbar and select the 'Debug > Tracepoints' page

Ribbon Execute > Analyze > Analyzer Scripts
Context Menu Project Browser | Right-click on Package | Execution Analyzer
Keyboard Shortcuts Shift+F12

Tracepoint properties

Field Detail

Output You can select from two options:
e 'Screen' (the default) - The output is directed to the Debug window
e 'File' - The output is directed to file

Folder Enter the folder to use for Trace statement log files.

Filename Enter the name to use for the Trace statement log files.

Overwrite If selected, the specified file is overwritten each time a debug session is started.

Auto Number If selected, the Trace log file is composed of the filename you specify and a
number.

Each time you start a debug session, the number is incremented.

Prefix trace output with If selected, any Trace statements executed during the debug session run are
function prefixed with the current function call.
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Workbench Setup

This topic describes the requirements for setting up the Object Workbench on Java and Microsoft .NET.

Access

On the Execution Analyzer window, either:

e Locate and double-click on the required script and select the 'Debug > Workbench' page  or

s
e C(Clickon b in the window Toolbar and select the 'Debug > Workbench' page

Ribbon Execute > Analyze > Analyzer Scripts
Context Menu Project Browser | Right-click on Package | Execution Analyzer
Keyboard Shortcuts Shift+F12
Platforms
Platform Detail
Platforms Supported The Workbench supports these platforms:

e Microsoft .NET (version 2.0 or later)
e Java (JDK 1.4 or later)

Microsoft NET The .NET workbench requires an assembly, which is used to create the workbench
Workbench items.

You specify the path to the assembly on the '"Workbench' page of the Analyzer
Script.

There are two constraints in using the .NET workbench:
e  Members defined as struct in managed code are not supported

e (lasses defined as internal are not supported

Java Workbench The Java workbench uses the Virtual Machine settings configured in the Analyzer
Script 'Debug' page to create the JVM.
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Microsoft C++ and Native (C, VB)

You can debug native code only if there is a corresponding PDB file for the executable. A PDB file is created as a result
of building the application.

The build should include full debug information and there should be no optimizations set.
The script must specify two things to support debugging:

e  The path to the executable

e  Microsoft Native as the debugging platform
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General Setup

This is the general setup for debugging Microsoft Native Applications (C++, C, Visual Basic). You have two options

when debugging:

e Debug an application

e  Attach to an application that is running

Option 1 - Debug an application

Field

Debugger

x64

Mode
Default Directory

Application Path

Command Line Arguments
Show Console

Symbol Search Paths

Action

Select Microsoft Native as the debugging platform.

Select this checkbox if you are debugging a 64-bit application.
Deselect the checkbox if you are debugging a 32-bit application.

Select the Run radio button.
This is set as the default directory for the process being debugged.

Select and enter either the full or the relative path to the application executable.
e Ifthe path contains spaces, specify the full path; do not use a relative path

e [fthe path contains spaces, the path must be enclosed by quotes
Parameters to pass to the application at startup.
Create a console window for the debugger; not applicable for attaching to a process.

Specify any additional paths to locate debug symbols for the debugger; separate the
paths with a semi-colon.

Option 2 - Attach to an application that is running

Field

Debugger

x64

Mode

Symbol Search Paths
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Action

Select Microsoft Native as the debugging platform.

Select this checkbox if you are debugging a 64-bit application.
Deselect the checkbox if you are debugging a 32-bit application.

Select the Attach to Process radio button.
Specify any additional paths to locate debug symbols for the debugger.

You could specify a symbol server here if you prefer; separate the paths with a
semi-colon or comma.
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Debug Symbols

For applications built using Microsoft Platform SDK, Debug Symbols are written to an application PDB file when the
application is built.

The Debugging Tools for Windows, an API used by the Visual Execution Debugger, uses these symbols to present
meaningful information to Execution Analyzer controls.

These symbols can easily get out of date and cause aberrant behavior - the debugger might highlight the wrong line of
code in the editor whilst at a breakpoint; it is therefore best to ensure the application is built prior to any debugging or
recording session.

The debugger must inform the API how to reconcile addresses in the image being debugged,; it does this by specifying a
number of paths to the API that tell it where to look for PDB files.

For system DLLs (kernel32, mfc90ud) for which no debug symbols are found, the Call Stack shows some frames with
module names and addresses only.

You can supplement the symbols translated by passing additional paths to the API; you pass additional symbol paths in a
semi-colon separated list in the 'Debug' tab.
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Test Scripts

These sections explain how to configure the 'Test' page of an Analyzer Script for performing unit testing on your code.
Most users will apply this to NUnit and JUnit test scenarios. Enterprise Architect accepts the output from these systems
and can automatically add to and manage each unit test case history. To view the case history, you would press Alt+3
while selecting the test case Class element.

Access

On the Execution Analyzer window, either:

e Locate and double-click on the required script and select the "Test > Test' page or

—Ah
e Clickon b in the window Toolbar and select the 'Test > Test' page

Ribbon Execute > Analyze > Analyzer Scripts
Context Menu Project Browser | Right-click on Package | Execution Analyzer
Keyboard Shortcuts Shift+F12

Actions

Execute Command As: Process

Enter the path to a program or batch file to run, followed by any parameters.

Batch File

When using this option you can enter multiple commands which are then executed
as a single script in a command console; you have access to any environment
variables available in a standard command console.

Example NUnit
"C:\Program Files\NUnit\bin\nunit-console.exe" "bin\debug\Calculator.exe"
JUnit
java junit.textui. Testrunner %N

The command listed in this field is executed as if from the command prompt; as a
result, if the executable path or any arguments contain spaces, they must be
surrounded in quotes.

If you include the string %N in your test script it is replaced by the fully
namespace-qualified name of the currently selected Class when the script is
executed.

Default Directory Preset to the Build default directory.

Parse Output When a parser is selected, output of nUnit and jUnit tests can be parsed, saved and
managed from the model; (Alt+3). Be aware that output is only captured when a
parser is selected.
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Build First Select to ensure that the Package is compiled each time you run the test.

(c) Sparx Systems 2015 - 2017 Page 62 of 214 Created with Enterprise Architect



User Guide - Visual Execution Analysis 30 June, 2017

Run Script

This section describes how to create a command for running your executable code.

Access

On the Execution Analyzer window, either:

e Locate and double-click on the required script and select the 'Run’' page or

s
e C(Clickon b in the window Toolbar and select the 'Run' page

Ribbon Execute > Analyze > Analyzer Scripts
Context Menu Project Browser | Right-click on Package | Execution Analyzer
Keyboard Shortcuts Shift+F12

Script elements

Element Description

Command This is the command that is executed when you select the 'Execute > Run > Start'
ribbon option; at its simplest, the script would contain the location and name of the
file to be run.

Examples These two examples show scripts configured to run a .Net and a Java application in
Enterprise Architect.

Net:
C:\benchmark\cpp\example net 1\release\example.exe
Java:
customer

The command listed in this field is executed as if from the command prompt; as a
result, if the executable path or any arguments contain spaces, they must be
enclosed by quotes.

Notes

e  Enterprise Architect provides the ability to start your application normally OR with debugging from the same script;
the 'Analyzer' menu has separate options for starting a normal run and a debug run
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Deploy Script

These sections explain how to create a command script for deploying the current Package. The script can be executed by
selecting the 'Code > Build and Run > Deploy' ribbon option or by pressing Ctrl+Shift+Alt+F12.

Access

On the Execution Analyzer window, either:

e Locate and double-click on the required script and select the 'Deploy' page or

s
e C(Clickon k- in the window Toolbar and select the 'Deploy’ page

Ribbon Execute > Analyze > Analyzer Scripts
Context Menu Project Browser | Right-click on Package | Execution Analyzer
Keyboard Shortcuts Shift+F12
Actions
Action Detail
Execute Command as: Process

If the deployment is handled externally, enter the path to the program or batch file
to run, followed by any parameters; the program is launched in a separate process.

Example:

C:\apache-ant-1.7.1\bin\ant.cmd myproject deploy

Batch File

When using this option, you can enter multiple commands that are then executed as
a single script in a command console; you have access to any environment variables
available in a standard command console.

Example:
@echo on
IF NOT EXIST "%1%" GOTO DEPLOY_NOWAR
IF "%APACHE _HOME%" =="" GOTO DEPLOY_NOAPACHE

xcopy /L "%1%" "%APACHE HOME%\webapps"
GOTO DEPLOY_END

rem

rem NO WAR FILE

rem

:DEPLOY NOWAR

echo "%1% WAR file not found"

GOTO DEPLOY_END

(c) Sparx Systems 2015 - 2017 Page 64 of 214 Created with Enterprise Architect



User Guide - Visual Execution Analysis 30 June, 2017

rem

rem NO APACHE ENVIRONMENT VARIABLE

rem

:DEPLOY_NOAPACHE

echo "APACHE_HOME environment variable not found"
:DEPLOY_END

pause

Parse Output Selecting a Parser from the list causes output of the deploy script to be captured; the
output is parsed according to the syntax selected from the list.

To display the System Output window, select the Show > Window > System
Output ribbon option.
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Testpoints Output

The Testpoints page of the Analyzer Script helps you to configure the output of a Testpoint run.

Access

On the Execution Analyzer window, either:

e Locate and double-click on the required script and select the 'Test > Testpoints' page or

s
e C(Clickon b in the window Toolbar and select the 'Test > Testpoints' page

Ribbon
Context Menu

Keyboard Shortcuts

Options

Option

Output

Folder
Filename

Overwrite

Auto Number

Prefix trace output with
function
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Execute > Analyze > Analyzer Scripts
Project Browser | Right-click on Package | Execution Analyzer

Shift+F12

Description

You can select from two options:
e 'Screen' (the default) - The output is directed to the 'Testpoints' tab of the

System Output window
e 'File' - The output is directed to file
Enter the folder to use for Testpoint log files.

Enter the name to use for the Testpoint log files.

When this option is selected, the file specified is overwritten each time a Testpoint
run is performed.

When this option is selected, the Testpoint output is composed of the filename you
specify and the number of the Test run; each time you perform a Test run the
number is incremented.

When this option is selected, any trace statements executed during the Testpoint run
are prefixed with the current function call.
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Recording Scripts

The beauty of recording is not really that we always get to see the bigger picture, but a chance to see a smaller picture
that has some truth to tell. We have all seen Sequence diagrams that are less than helpful. (The same message appearing
100 times in succession on a diagram does tell us something, but not much.) Fortunately Enterprise Architect takes care
of this first point through the use of fragments. Repeating behaviors are identified as Patterns and represented once as a
fragment on the Sequence diagram. The fragment is labeled according to the number of iterations. The recording history,
of course, always shows the entire history. We also need tools to help us focus the recording on particular areas of
interest and reduce the noise from others. We can use filters to do this. With filters, you can exclude any Classes,
functions, or even modules from any recording. You can create multiple sets of filters and use them with marker sets to
target different Use Cases.

Access

On the Execution Analyzer window, either:

e Locate and double-click on the required script and select the 'Recording' page or

s
e Clickon h- in the window Toolbar and select the 'Recording' page

Ribbon Execute > Analyze > Analyzer Scripts
Context Menu Project Browser | Right-click on Package | Execution Analyzer
Keyboard Shortcuts Shift+F12
Filter Strings
Element Discussion
Filtering If the 'Enable Filter' checkbox is selected on the 'Recording' page of the Execution

Analyzer Script Editor, the debugger excludes calls to matching methods from the
recording. The comparison is case-sensitive.

To add a value, click on the 'New' ('Insert") icon in the right corner of the 'Exclusion
Filters' box, and type in the comparison string; each filter string takes the form:

class name token::method name token

The class_name_token excludes calls to all methods of a Class or Classes that have
a name matching the token; the string can contain the wildcard character *
(asterisk).

The method name_token excludes calls to methods having a name that matches the
token; again, the string can contain the wildcard character *.

Both tokens are optional; if no Class token is present, the filter is applied only to
global or public functions (that is, methods not belonging to any Class).

Example In this Java example, the debugger would exclude:
e (Calls to the OnDraw method for the Class Example.common.draw.DrawPane

e (Calls to any method of any Class having a name beginning with
Example.source.Collection
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Filters

Use Filter Entry

::Get*

*::Get*
CClass::Get*
CClass::*

ATL*
std*

CClass::GetName
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e  (alls to any constructor for any Class (such as <clint> and <init>)

Filters

Example.common. draw. DrawPane: :OnDraw
Example.source. Collection™
Fuinit®

In this Native Code example, the debugger would exclude:

e (Calls made to Standard Template Library namespace

e (Calls to any Class beginning with TOb

e (Calls to any method of Class CLock

e  (Calls to the method GetLocation for Class CTrain

e  (Calls to any Global or Public Function with a name beginning with Get

Filters

std*

TOb*

Clock
CTrain::Getlocation
iGet®

To Filter

All public functions having a name beginning with 'Get' from the recording session
(for example, GetClientRect in Windows API).

All methods beginning with 'Get' in any Class.
All methods beginning with Get for the CClass Class.
All methods for CClass Class.

All methods for Classes belonging to Standard Template and Active Template
Libraries.

The specific method(s) GetName for the CClass Class.
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Build Application

This topic explains how to execute a Build script on your application, within Enterprise Architect.

Access
Ribbon Code > Build and Run > Build > Build
Execute > Run > Build > Build
Keyboard Shortcuts Ctrl+Shift+F12
Other 'Build toolbar > £
Execution Analyzer window | i
Action

When you select the 'Build' option, it executes the 'Build' command in the script selected in the Execution Analyzer
window. The progress and outcome of the build operation are displayed in the 'Build' tab of the System Output window.

You can quickly visit the line of code for any compilation error appearing by double-clicking the error.
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Locate Compiler Errors in Code

When you build an application using an Analyzer Script, compiler output is logged in the System Output window. You
can double-click on any error message that appears here and be taken to the source code. When you do, the cursor is
positioned on the line containing the error.

61

62 if(PeopleOFF > @)

63 re turn PeopleOFF * 28;
a4

65 return 8;

B
¥
58| Running Analyzer Script - CityLoop

551 Microsoft (R) Visual Studic Version 10.0.30319.1.

Qutput

7 Copyright (C) Microsoft Corp. All rights reserved.
;? 12--mmm- Build started: Project: CityLoop, Configuration: Debug Win32 ------

72| 1= Train.cpp

rZ{ 1> cdata\wea\microsoft native\cityloophtrain.cpp(63): error C2065: 're' : undeclared identifier

72 1= chdata\weamicrosoft native\cityloophtrain.cpp(83): error C2146: syntax error: missing ;' before identifier "turn’
78 1> c\data\vea\microsoft native\cityloop\train.cpp(63): error C2065: 'turn' : undeclared identifier

Tip

If output is missing, check that a language parser is mentioned in the Analyzer Script (Shift+F12).

Parse Output: Java SDK -
Access
Ribbon Show > Window > System Output
Keyboard Shortcuts Ctrl+Shift+8
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Debugging

@ vea-demo - Enterprise Architect
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Enterprise Architect is more than a drawing tool. Every feature that you might expect in an IDE is also available.
Comprehensive debugging environments and tools for many major platforms are provided. By integrating debugging
capability within the modeling tool allows code to be developed, built and managed by its authors, working and
collaborating in an integrated model has made actions count and every action accountable in ways that are just not
possible using other tool chains.

Features

Speed

Debuggers in Enterprise Architect are quick! Stepping through programs won't take all day.
The Recording program execution can be done without manual stepping.

Support

e (C++, C and Visual Basic

e  Microsoft NET, ASP.NET WCF

e Java, using socket transport (JDWP) or in memory model (JVMIT)

e  Android on an emulator or device

e Javascript, VBScript and JScript

e  PHP scripts on Apache web servers

e Remote Linux GDB processes using Enterprise Architect on Windows (how's that for interoperability?)
e  Simulation - debug simulations in UML and BPMN

e Executable StateMachines - debug an executing StateMachine

Isolation
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The debuggers operate out of process from Enterprise Architect, isolating it from side effects. (Your artifact is safe!)
Efficiency

Starting and stopping the debugger is quick and painless. It does not hold you back. Designed to be a responsive UI, the
main Ul thread is isolated from duties that are not its responsibility.

Productivity

Switch from modeling to requirements, from raising a change request to tracking code changes in a model shared across
an organization, to profiling recent code changes. All in the one tool.

Notes

e The debug and record features of the Visual Execution Analyzer are not supported for the Java server platform
"Weblogic' from Oracle
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Run the Debugger

Enterprise Architect provides a number of ways to start and control a debug session. There is the main Debug window, as
well as a Debug toolbar and the 'Run' panel in the 'Execute’ ribbon. It is always best to display the Debug window
whenever you are running a debug session, as this is where all debug output is captured.

Access
Ribbon Execute > Analyze > Debugger > Open Debugger
Execute > Run
Keyboard Shortcuts Alt+8 (displays the Debug window)
F6 (begins execution of the application being debugged)
Other Right-click on Project Browser caption bar menu | Analyzer Toolbars | Debugging

Using the Debug window

Action Detail

Start the Debugger When an Analyzer script has been configured to support debugging, you can start
the debugger in these ways:

e  From the ribbon, select 'Execute > Run > Start'

e From the ribbon, select 'Execute > Analyze > Debugger > Start Debugging'

e  On the 'Debug' toolbar, click on the - button, or
e Press F6

You can also launch the debugger for any script through its context menu in the
'Analyzer Script Window', or press Shift+F12

If you have no Analyzer Script, it is still possible to debug a running application by
attaching to that process directly:

e  From the ribbon, select 'Execute > Analyze > Debugger > Attach to Process',
or

e  On the 'Debug' toolbar, click on the e (Attach) button and choose the
debugging platform manually

Pause/Resume Debugging You can pause a debugging session, or resume the session after pausing, in these

ways:

e  From the ribbon, select 'Execute > Run > Pause'

e On the 'Debug' toolbar, click on the i |but‘[on

Stop the Debugger To stop debugging, either:
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e  From the ribbon, select 'Execute > Run > Stop'

e On the 'Debug' toolbar, click on the (Stop) button
e  Press Ctrl+AIt+F6

The debugger normally ends when the current debug process terminates; however,
some applications and services (such as Java Virtual Machine) might require the
debugger to be manually stopped.

Step Over Lines of Code To step over the next line of code:

e  From the ribbon, select 'Execute > Run > Step Over', or

=

e  On the 'Debug' toolbar, click on the
e Press Alt+F6

(Step Over) button, or

Step Into Function Calls To step into a function call:

e  From the ribbon, select 'Execute > Run > Step In', or

4=
e  On the 'Debug' toolbar, click on the (Step In) button, or
e  Press Shift+Fo6

If no source is available for the target function then the debugger returns
immediately to the caller.

Step Out Of Functions To step out of a function:

e  From the ribbon, select 'Execute > Run > Step Out'

==
e  On the 'Debug' toolbar, click on the E (Step Out) button, or
e  Press Ctrl+F6

If the debugger steps out into a function with no source code, it will continue to
step out until a point is found that has source code.

Show Execution Point While the debugger is paused, to return to the source file and line of code that the
debugger is about to execute:

e  From the ribbon, select 'Execute > Run > Start > Show Execution Point'

e  On the 'Debug' toolbar, click on the i (Show Execution Point) button.

The appropriate line is highlighted, with a pink arrow in the left margin of the
screen.

Output During a debug session, messages display in the Debug window detailing:
e  Startup of session
e  Termination of session
e Exceptions
e FErrors

e Trace messages, such as those output using Java System.out or NET
System.Diagnostics.Debug

If you double-click on a debug message, either:
e A pop-up displays with more complete message text, or

e Ifthere has been a memory leak, the file is displayed at the point at which the
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error occurred

Save Output (and Clear You can save the entire contents of the Debug output to an external .txt file, or you
Output) can save selected lines from the output to the Enterprise Architect clipboard.

To save all of the output to file, click on the = (Save output to file) button.

To save selected lines to the clipboard, right-click on the selection and select the
'Copy Selected to Clipboard' option.

When you have saved the output or otherwise do not want to display it any more,
right-click on the current output and select the 'Clear Results' option.

Switch to Profiler If you are running a debug session on code, you can stop the debug session and
immediately switch to a Profiling session.

To switch from the Debugger to the Profiler:

e From the ribbon, select 'Execute > Analyze > Debugger > Switch to Profiler'

@ -

e  On the Debug window, click on the ' | Switch to Profiler' option, or

&+ -

e On the Debug toolbar, click on the ' | Switch to Profiler' option
The Profiler attaches to the currently-running process.

This facility is not available for the Java debuggers.
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Breakpoint and Marker Management

Breakpoints work in Enterprise Architect much like in any other debugger. Markers are like breakpoints, but in
Enterprise Architect they have special powers. You set any marker or breakpoint in the Source Code editor. They are
visible in the left margin, and clicking in this margin will add a breakpoint at that line. Breakpoints and markers are
interchangeable. You can change a breakpoint into a marker and vice versa using its 'Properties' dialog. Simply put,
markers perform actions such as recording execution and analysis, that breakpoints do not. The action of a breakpoint is
always to stop the program. You can quickly view and edit a breakpoint or marker's properties using Ctrl+click on its
icon in the editor margin or in the Breakpoints and Markers window.

Breakpoints are maintained in sets. There is a default set for each model and each breakpoint typically resides there, but
you can save the current breakpoint configuration as a named set, create a new set and switch between them. Breakpoint
sets are shared; that is, they are available to the model community. The exception is the Default set which is a personal
set allocated to each user of any model. It is private.

Access

Ribbon Execute > Windows > Breakpoints

Breakpoint and Marker Options

Option Detail
Delete a breakpoint or To delete a specific breakpoint:
marker e [fthe breakpoint is enabled, click on the red breakpoint circle in the left margin

of the Source Code Editor, or

e Right-click on the breakpoint or marker in the Source Code Editor, the
Breakpoints folder or the Breakpoints & Markers window and select the
'Delete’ option, or

e Select the breakpoint in the 'Debug Breakpoints' tab and press the Delete key

Delete all breakpoints J
Click on the Delete all breakpoints button ( ).

Breakpoint properties In the Breakpoints window or code editor, use the marker's context menu to bring
up the properties. Here you can change the marker type, add or modify constraints
and enter trace statements. (Useful shortcut: hold the Ctrl key while clicking the
marker, to quickly show its properties.)

Disable a breakpoint Deselect the checkbox against the breakpoint or marker.
Enable a breakpoint or Select the checkbox against the breakpoint or marker.
marker

Disable all breakpoints iy
Click on the button

Enable all breakpoints
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Break when memory
address is modified

Identify or change the
marker set

Change how breakpoints
and markers are grouped
on the Breakpoints &
Events window

Breakpoint States

State

(c) Sparx Systems 2015 - 2017

Click on the Enable all breakpoints button ( -t ).

Click on the Data breakpoint button ().

Check the Default " field in the Breakpoints & Events window
toolbar.

If necessary, click on the drop down arrow and select a different marker set.

The Default set is normally used for debugging and is personal to your user ID;
other marker sets are shared between all users within the model.

The breakpoints and markers can be grouped by Class or by code file. To group the

items, click on the down arrow on the = - icon in the toolbar, and click on the
appropriate option. If you do not want to group the items, click on the selected
option to deselect it; the breakpoints and markers are then listed by line number.

Remarks

Debug Running: Bound
Debug Not Running: Enabled

Debug Running: Disabled
Debug Not Running: Disabled

Debug Running: Not bound - this usually means that a module is yet to be loaded.
Also, dlls are unloaded from time to time.

Debug Not Running: N/a

Debug Running: Failed - this means the debugger was unable to a match this line of
code to an instruction in any of the loaded modules. Perhaps the source is from
another project or the project configuration is out of date. Note, that if the module
date is earlier than the breakpoint's source code date you will see a notification in
the debugger window. The text is red in color so they will stand out. This is clear
sign that the project requires building.

Debug Not Running: N/a
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Setting Code Breakpoints

Normal Breakpoints are typically set on a line of source code. When the Debugger hits the indicated line during normal
execution, the Debugger halts execution and displays the local variables, call stack, threads and other run-time
information.

Set a breakpoint on a line of code

Step Action

1 Open the source code to debug in the integrated source code editor.

2 Find the appropriate code line and click in the left margin column - a solid red circle in the margin
indicates that a breakpoint has been set at that position.

12 CTest::CTlest (LPCTSTE name, TTestIype tvpe)
13 H4{

1}5 14 m Name = name;
15 m Type = Type:

16 theTeat = this;

If the code is currently halted at a breakpoint, that point is indicated by a blue arrow next to the marker.

& int tmain(int arge, _TCHAR* argv[])
{

e

CTest Test( T ("Model™), CTest::Regression):
return Test.Run /() :;

[ T T ]

Alternatively, you can set the Breakpoint marker (or other marker) by right-clicking on the left margin on
the required line, to display the breakpoint/marker context menu; select the appropriate marker type.
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Trace Statements

A Trace Statement is a message that is output during execution of a debug session. Trace statements can be defined in
Enterprise Architect without requiring any changes to your application source code.

Tracepoint Markers are set in the code editor. Like breakpoints, they are placed on a line of code. When that line of code
executes, the debugger evaluates the statement, the result of which is logged to the Debug window. (or to file if
overridden by the Analyzer scripft)

Access

Any existing Trace statements can be viewed and managed in the Breakpoints & Markers window. The Breakpoints &
Markers window can be displayed using either of the methods outlined here.

Ribbon Execute > Windows > Breakpoints

Add a Tracepoint Marker

Step Action

1 Open the source code to debug in the source code editor.
2 Find the appropriate code line, right-click in the left margin and select the 'Add Tracepoint Marker'
option.

If a marker is already there, press Ctrl+click to show the Breakpoint Properties window.

3 Ensure the "Trace statement' checkbox is selected.
4 In the text field under the '"Trace statement' checkbox, type the required Trace statement.
5 Click on the OK button. A Tracepoint Marker is shown in the left margin of the code editor.

55 DWORD CTrain::Disembark({int PeopleOFF)

56 {

o 57 if(Passengers - PeopleOFF > -1)
: 58 Passengers -= PeopleOFF;

59 else

68 Passengers = @;

61

62 if(PecpleOFF > B)

63 return PeopleOFF * 28;

o4

65 return &;

66 }

Specifying a Trace Statement
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A trace statement can be any freeform text. The value of any variables currently in scope can also be included in a trace
statement by prefixing the variable name with a special token.

The available tokens are:

e  $ - when the variable is to be interpreted as a string

e (@ - when the variable is a primitive type (int, double, char)

Using the example in the image above, we could output the number of people getting off a train by using this statement:
There were @Passengers before @PeopleOFF got off the train at $Arriving.Name Station

In addition to tracing the values of variables from your code, you can use the $stack and $frame keywords in your Trace
statement to print the current stack trace; use:

e  S$stack - to print all frames, or

e  S$frame[start](count) - print a specific number of frames from the stack starting at a given frame; for example,
$frame[0](5) will print the current frame and 4 ancestors

Notes

e Trace statements can be included on any type of breakpoint or marker.

(c) Sparx Systems 2015 - 2017 Page 80 of 214 Created with Enterprise Architect



User Guide - Visual Execution Analysis

30 June, 2017

Break When a Variable Changes Value

Data breakpoints can be set on a pre-determined memory variable to cause the debugger to halt execution at the line of
code that has just caused the value of the variable to change. This can be useful when trying to track down the point at
which a variable is modified during program execution, especially if it is not clear how program execution is affecting a
particular object state.

Access
Ribbon Execute > Windows > Local Variables : Right-click on variable > Break When
Variable is Modified or
Execute > Windows > Watches : Right-click on variable > Break When Variable is
Modified
Other In a code editor window: Right-click on the variable of interest | Break when item
modified

Capture changes to a variable using data breakpoints

the 'Break When Variable is Modified' option.

Steps Detail
1 Set a normal breakpoint in the code so you can choose a variable. Then run the debugger (F6).
2 When the program has hit the breakpoint, select the variable of interest and from its context menu, select

Locals 1 X
Yariable Value
B4 this 0008 efd10
=g CTrain
-4 TObject
-§ h_thread 00000000
g m_tid 2864
W@ Metwork 0012F78 ¢
B Arriving 05008 ef9al
i Distance 0.000000
iy Capacity 500
g Mumbe Break When Variable is Modified L\)
"'5} Departi View Memory at Address
% Locatis o in Editer
iy Delay _ _
¢y PeopleON Dump Variable Members to File
o Save Snapshot of Variable -
Watehes | 5] Loca Compare Variable Snapshots
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3 There are no breakpoint indicators in the code, but data breakpoints are easily recognizable in the
Breakpoints & Events window, being a blue icon with a white diamond. Enterprise Architect displays the
name of the variable and its address instead of a line number.

ErEEkpUiﬂtS & Markers PP b e e b e P e P B P B

dy 4 3 % |Defautt 8-8-@
Enabled Line ource
Q D0ZEBEE4  int Passengers (D0ZEBEE4)
» [ 127 CHEANEATSDNCode Samples VEANR
4 With the data breakpoint set, you can disable any other breakpoints you might have. The program will

stop at any line of code that changes this variable's value. Now run your program.

5 When this variable is modified, the debugger halts and displays the current line of code in the editor. This
is not the line that caused the break, but the line of code following the event. The event is logged to the
Debugger window.

#- 8 p n(ESECzO o H @
[1650154916] Module loaded C:AWindows\SysWOWEdole32.dIl no symbols

[1650154916] Module loaded C:AWindowsh\SysWOWENSHCORE.dIl no symbaols

[1650205565] Data breakpoint hit at CTrain.Disernbark, chea\ea73 M code samples\vea\microsoft nativecityloop'
[1650270313]  Data breakpoint hit at CTrain.Embark, c\ea\ea750\code samples\vea\microsoft native\cityloop'trai
[1650271852] Data breakpoint hit at CTrain.Disembark, c\ea\ea?30hcode samplesivea\microsoft nativelcitylooply
[1650272025] Data breakpoint hit at CTrain.Embark, c\ea\ea730\code samples\vea\microsoft nativel\cityloophtrai
[1650273270] Data breakpoint hit at CTrain.Disembark, c\ea\ea/30\code samplesivea\microsoft native\citylooply
[16530273521] Data breakpoint hit at CTrain.Embark, c\ea\ea73 M code samplesivea\microsoft nativelcityloop'trai

[1650274759]  Data breakpoint hit at CTrain.Disernbark, c\ea\ea730 code samplesivea\microsoft nativelcityloop'
4

W Debug | g Execution Analyzer

Now we know how and where this value (its State) has changed. For example, the statement at line 58 has
just updated the number of Passengers.

55 DWORD CTrain::Disembark({int PeopleOFF)

56 {
57 if(Passengers - PeopleOFF » -1)
58 Passengers -= PeopleOFF;
59 else
68 Passengers = 8j
61
62 if(PeocpledFF » @)
63 return PeocpleOFF * 28;
a4
65 return @;
66 }
6 Having discovered this and other places where this value is being changed, be sure to get rid of the

notification before moving on. You can delete the data breakpoint quickly by selecting it in the
Breakpoints window and pressing the Delete key.

You can also use the right-click context menu to do this.
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Ereakpoints & Markers

Al @y dly 8 T Default B - H

Enabled Line Source

A — o

%)

Remove Break at Address

@ O de Sam
o D View Memory at Address de Sam
@O de Sam
0O H"_IF' _ de Sam
@0 220 CHAEANEATHINCode Sam

This feature is not presently supported by the Microsoft .NET platform
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Trace When Variable Changes Value

When your code executes, it might change the value of a variable. It is possible to capture such changes and the
variable's new value, on the Debug window. You can then double-click on the change record to display the line of code
that caused the change, in the Code Editor.

Access
Ribbon Execute > Windows > Local Variables : Right-click on variable > Trace When
Variable is Modified or
Execute > Windows > Watches : Right-click on variable > Trace When Variable is
Modified
Other In Code Editor | Right-click on variable | Trace When Variable Modified

Set up Trace

The variable you are tracing must be in scope, so to identify and select it, set a normal breakpoint on the line of code
where you know that the variable will exist. When the debugger reaches this breakpoint, locate the variable and use its
context menu to enable the trace.

To locate a variable:

e Ifyou see the variable in the source code, hover over it, right-click and select the 'Display variable' option;
Enterprise Architect will locate it

e Ifthe variable is in scope (a local, or 'this' or a member of 'this'), look for it in the Locals Window ('Execute >
Windows > Local Variables')

e If the variable is global (C, C++), display the Watches window ('Execute > Windows > Watches') and search for it
by name

e Ifthe variable is a Class static member, display the Watches window ('Execute > Windows > Watches') and enter its
fully qualified name

Once trace is enabled, you can disable all other breakpoints and let the program run. Each time the variable changes
value, it will be logged to the 'Output' tab of the debugger. Check the change in value and double-click on the line to
display the code in the Code Editor.

Notes

e  The debugger does not halt when the change event occurs, it only logs the change
e This facility is available on the Microsoft Native and Java platforms

e Microsoft .NET does not support breakpoints on values
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Detecting Memory Address Operations

Being able to detect where and when an area of memory is being read or written can be a great help for investigators,
even when the code base is well understood. Without this tool, a C++ developer could have a potentially daunting task of
tracking where and when a global variable is accessed, and debugging those functions. Data breakpoints allow a C++
programmer to track when a variable / memory location is read or when it is written. When the operation is detected, the
debugger will halt the execution and the line of code following the operation will be displayed in the code editor.

Access

Ribbon Execute > Windows > Breakpoints

Detect operation on memory address

Step Action

1 Click the data breakpoint button .
2 Enter the memory address to watch. You can copy an address from the locals variables window.
Data El'fakpoint x

Address: | 0x0033fdf4 |

Operation: Write Action: Break
Read [ Write Trace
Ok Cancel
3 Select the operation to detect. If you select Write, the debugger will break when the address is written to.

If you choose Read / Write, the debugger will notify you when the address is read or when it is written.

4 Select the action to perform. If you choose Break, the debugger will halt the program and the line of code
will be shown in the editor. If you choose Trace, the debugger will not halt execution, but log any
operation on the address as it occurs. This output is displayed in the Debugger Window.

5 The data breakpoint is added to the Breakpoints and Markers window.
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Lad9

Enabled

Breakpoints & Markers

MyBreakpoints - B-H-

Line Source

0033FDF4 [MN33FNF4

Remove Break at Address

Viﬁd Memory at Address

Help

(33fdf4

0x0033FDF4
0x0033FEDT
0x0033FELA
0x0033FEZD

6 You can use the context menu on the data breakpoint to check the value at the memory address.

Memory Viewer

a,
0100 00 Q0 00 0000 00 0000 Q0 00 00 00 00 00 CCCCCC
CCSBFE3300 18 104100010000 00 AB14 42 00 AB43
42 00 F9 97 04 AV B2 10 41 00 00 FO FD ¥F 00 FO 63 VB 28
204100 26 AE44 Y8 00 00 00 00 00 00 34 00 00 00 00 00

7 To delete a data breakpoint, select it in the Breakpoints and Markers window and press the Delete key.
Alternatively, deselect the checkbox next to it. Data breakpoints are deleted when they are disabled; they
do not persist as other breakpoints do.

System Requirements

Memory address breakpoints are supported in the C/C++ native debugger.
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Breakpoints have a number of additional properties that determine what occurs when executing the line of code that the

breakpoint applies to.
These properties define:
e  The action to be performed

e  The line of code that the breakpoint applies to

e  Constraints that determine whether or not the action is performed when the breakpoint is hit

e Trace information to be output when the breakpoint is hit

Ereakpoint Properties x
Action: Line number:
@ Break Execution - 62
+/| Constraints:

h_secClosingVolume < 0

.| Trace statemert

Clasing Volume @m_secClosingVolume is Megative 11

Cancel Help

Access

There are several ways to display the 'Breakpoint Properties' dialog:
In Code Editor:

e Right-click on a breakpoint marker | Properties or

e Ctrl+Click on breakpoint marker or

e Right-click on code that has a breakpoint marker | Breakpoint | Properties

In the Breakpoints & Markers window:

e  Right-click on breakpoint | Properties

Options
Field Details
Action The behavior when the breakpoint is hit.
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Line The line of source code that this breakpoint applies to.

Stack Height For Stack Capture markers, the number of caller frames to record. To record the
entire Stack, set the value to 0.

Constraints Defines the condition under which the breakpoint action will be taken. For normal
breakpoints this would be the condition that halts execution. In this example, for a
normal breakpoint, execution would stop at this line when the condition evaluates
to True. Constraints are evaluated each time the line of code is executed.

(this.m_FirstName="Joe") AND (this.m_LastName="Smith")

Trace statement A message output to the Debug window when the breakpoint is hit. Variables
currently in scope can be included in a trace statement output by prefixing the
variable name with a $ token for string variables, or an @ token for primitive types
such as int or long. For example:

Account $pAccount->m_sName has a balance of @pAccount->m_fBalance
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Failure to Bind Breakpoint

A breakpoint failure occurs if there is a problem in binding the breakpoint. Breakpoint failures are most often caused by
source files being changed without the application being rebuilt. Breakpoints can sometimes bind to a different line,
causing them to be moved. If a breakpoint cannot be bound to the binary at this line or the three lines following it, it is
displayed with a question mark.

A warning message displays in the 'Details' column of the Breakpoints & Events window, identifying the type of
problem:

e The source file for the breakpoint does not match the source file used to build the application image
e  The time date stamp on the file is greater than that of the image

A warning message is also output to the Debug window.
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Debug a Running Application

Rather than starting a process explicitly from within Enterprise Architect, you might want to debug an application
(process) that is already running on your system.

In this case you can use the debugging capability to attach to the process that is already running. Provided you have the
appropriate debug information written into the running process, and/or associated debug files (such as .PDB files), the
debugger binds to that process and initiates a debug session.

You can also 'detach’ from the process after you have completed your inspection and leave the process to run as normal.

Access

Ribbon

Other

Stages

Stage

Show Processes

Select Debugger

Process Selection

Detach From Process

(c) Sparx Systems 2015 - 2017

Execute > Run > Start > Attach to Process or

Execute > Analyze > Debugger > Attach to Process

Debug window toolbar :

Description

When you select to debug another process, the 'Attach To Process' dialog displays.

You can limit the processes displayed using the radio buttons at the top of the
dialog; to find a service such as Apache Tomcat or ASP.NET, select the System
radio button.

When you select a process, you might have to choose the debugger from the
Debugger dropdown list; however, if the selected Package has already been
configured in an Analyzer Script, then the debugger listed in the script is preset on
the dialog.

Once you double-click on a process containing debug information, and Enterprise
Architect is attached to the process:

e  Any breakpoints encountered are detected by the debugger
e  The process is halted when a breakpoint is encountered, and

e The information is available in the Debug window

To detach from a process, click on the (Debug Stop) button.
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View the Local Variables

The Locals window displays variables of the executing system. Whether you are recording C#, debugging Java, C++ or
VBScript, debugging an Executable StateMachine, or running a simulation, this window is where the system's variables
are located. Current values are only displayed when a program is halted. This occurs when a breakpoint is encountered
during debugging, when you step over a line of code or when you step between States in a simulation.

Access
Ribbon Execute > Windows > Local Variables
Simulate > Dynamic Simulation > Local Variables
Context Menu In Code Editor | Right-click on any variable identifier > Display Variable
Icons

The value and type of any in-scope variable is displayed in a tree; each variable has a colored box icon that identifies the
type of variable:

e Blue - Object with members
e Green - Arrays

e Pink - Elemental types

e  Yellow - Parameters

e Red - Workbench instance

Finding variables

The easiest way to find a variable is to first locate it in the code editor and use the right-click context menu on the
variable, selecting 'Display Variable'. Enterprise Architect will find and reveal any variable in scope, including deeply
nested members. If the variable is found in a different scope (global, file, module, static), it will be displayed in the
Watches window (see View Variables in Other Scopes).
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Go to Declaration

Go to Definition

synchronize Tree to Editor

+  Auto Synchronize Tree and Editor

Search for 'y

Search Intelli-sense

5et Debugger to Line

Run to Cursor

Display Variable

Show in 5tring Viewer
Break when item modified
Trace when item modified
Create Use Case for 'Run’

EBreakpoint

Persistent View

30 June, 2017

The examination of variables usually involves digging around in the tree to expose the values of interest. It can be
annoying then, having gone through that trouble, to step to the next line of code, only to have those variables buried from
sight again due to a change in context. The Locals window has a persistent view that lingers for a while after a run or
step command. When you step through a function in Enterprise Architect, the variables structure persists line after line.
This makes stepping through a function quick and easy.

What changed

As part of the persistent view, the Locals window tracks changes to values and highlights them.

Locals :
Variable
B & this
B @ ExchangenAccount
[ ¢ Exchange:lAccount
® § m_pExchange
[+ & m_acctMame
§ m_acctBalance
§ m_acctlD
5 =id
3 amount
3 debitPurchaseCost

Context Menu
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Yalue
Ox02BD0OAAD

(xD0CEFB44
"Its not broken Pty Ltd"

Oufffffec? (-318)
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Type
ExchangerAccount™
ExchangerAccount
Exchange:|Exchange

ATL:CString T<wchar

int

unsigned int

unsigned int

unsigned int

int

Address

OoeD0cBfed0
(e02bd0aal
he02bd0aal
he02bd0aad
02bd0aal
(re02bd0aac
he02bd0ab0
DuD0cBfoel
DuD0cBfbed
DuD0cBfoed
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Facility

Break When Variable is
Modified

View Memory at Address
Show in String Viewer

Dump Variable Members
to File

Save Snapshot of Variable

Compare Variable
Snapshots

Copy

Add Instance Run State to
Diagram

Set Conditional Breakpoint
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Detail

Set data breakpoints on the selected memory variable to halt debugger execution at
the line of code that has just caused the value of the variable to change.

Display the raw values in memory at the selected address, in hex and ASCII.
Display the variable string in the 'String Viewer' dialog.

Capture and store the selected variables to a separate location; a browser displays to
select the appropriate .txt file name and file path.

Capture the value of a variable at a specific point in the life of that variable.

Compare the values of a variable at different points in the life of that variable.

Copy the selected variable to the Enterprise Architect clipboard.

If you have opened a model diagram containing an Object of the Class for which
the source code is being debugged, this option updates that Object with the Run
State represented by the variable value.

Add a breakpoint at the current execution position with a constraint for this variable
matching its current value.
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View Content Of Long Strings

For efficiency, the Locals window only shows partial strings. However, you can display the entire contents of a string
variable using the 'String Viewer'.

Locals
Variable Value Type Address
§ this (2 5604E00 CContextHandler® 0837 efbl
i grammar “ff XML nBMF Grarmmar caseSensitive(); delir - ATL:CStringT<unsign (0887004
= & data "< el version="1.0" encoding="UTF-8"7> < ATL:CStringT<unsigi  Ox08370ed
B & ATL:CSimpleStringT < 00887 0ed
B § m_pszData "< Tl version="1.0" encoding="UTF-8"%> < wchar* (028 7f0ed
o owehar U<Txmiversion="10" encoding="UTF-8"7> < wechar  0296c3050
i macros Break When Variable is Modified ATL:CStringT<unsigr  Ow0387F0dc
G ret Trace When Variable is Modified bool 0x0887efbf

View Memory at Address

Show in S5tring Viewer

Dump Yariable Members to File
Save Snapshot of Variable
Compare Variable Snapshots

Copy
Add Instance Run State to Diagram

Set Conditional Breakpoint

Help

This example shows the value of a variable holding the contents of an xml schema file.
string Viewer

« fusd:enumeration = Y
«<¥sdienumeration value="204143">
<xsd:annotation =
<xsd:documentation xml:lang="en"=
<cts:Mame =Discharging chassis in overtime = focts: Name =
< fwsdidocumentation =
< fusdiannotation =
« fusd:enumeration =
«xsdienumeration value="204144">
«<xsd:annotation =
<xsd:documentation xml:lang="en">
<rctsiMame =Discharging breakbulk (1 ton to 7 ton) ro-o in overtime < focts:Mame =
< fusd:documentation =
< fwsd:annotation =
« fusd:enumeration =
«<wsd:enumeration value="204145">

Access
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From Code Editor or Locals window:

Right-click on string variable | Show in String Viewer
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View Debug Variables in Code Editors

When a breakpoint occurs, you will see all the local variables in that window. You can also inspect variables in the
Source Code Editor by hovering your mouse over the reference. Here are some examples.

public woid Print ()
{

int n = 0;
while (names[n] . Length = 0)

{ names = {[4] names[0]=book, names[0]=book, names[1]=novel, names[2]=Ffilm}, ]-l
Docum = [BFFTT -

d._Print ()

}

public woid Print i)

{
int n = 0;
whi 14 37-hit signed inkeger n=0} 0%
{

Document d = new Document (hames[n+t++]);
d.Print () ;

Note: The variable does not have to be one of the local variables. It can have a file or module scope.
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Variable Snapshots

It is possible to take a 'snapshot’ of a variable when your program hits a breakpoint and use this snapshot to see how the
value of the variable changes at different points in its life. The debugger does not copy the value of the selected variable
only; for complex variables it copies the values of the selected variable and of each of its hierarchy of members until it
can no longer find any more debug information for a member or no more members can be found.

Capture Variable Snapshot

Step Action

1 In the Code Editor, set two breakpoints: one at the start of a function and another at the end of the
function.
2 At the start breakpoint, right-click on a variable in the Locals window and select the 'Save Variable

Snapshot' menu option.
3 Run the application.

4 When the end breakpoint is reached, right-click on the variable in the Locals window and select the
'Compare Variable Snapshots' option.

A dialog displays that shows the original value from the first snapshot and the current value from the
second snapshot as illustrated in this diagram taken from the EA.Example model.

CTrain® this X
Mame Address Valuel Value?2

int::Passengers Ox0003BEE4  Owxbl (177) Oxd& (214)

int::Delay 0x0003BEF4  Ox3c (B0) 0x28 (40)

Save Variable Snapshot to File

You can save the state of a variable to file using its right-click context menu.
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Locals

Yariable Value
§ #stopped 3 (3)

@

Break When Variable is Modified
Trace When Variable is Modified
View Memory at Address

Show in S5tring Viewer

Dump Variable Members to File
Save Snapshot of Variable
Compare Variable Snapshots

Copy

Add Instance Run State to Diagram

Set Conditional Breakpoint

This is an excerpt of the file contents.

73 epeRBROE | BxBE731FER | name | TObjectType: :Type  |value|TypelsStation|
74 @ReRBEOS | BxB8731F08 | name [wchar: :Name |value|"Treasury™|

75 8RaRBEOS |BxBe731FEC |name |unsigned: :Location |value|&xdd (&54) |

76 8ReRBEO3 | BxB@a3EEDS | name | float: :Distance |value|@|

77 epaRBEB3 | BxB@E3EEER | name |int: :Capacity |value|@xlf4 (Se) |

78 epeRBREO3 | BxBEB3EEEL | name |int: :Passengers |value|@xds (214) |

79 BRERBEE3 | BxBEB3EEES |name |unsigned: :Number  |value|8x3 (3)|

80 BPERBEOS | BxBEE3EEFR | name |unsigned: :Location |value|&xd (@) |

81 epeReR3 | BxB@E3EEFL | name|int: :Delay |value|8x28 (48) |
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Actionpoints

Actionpoints are breakpoints that can perform actions. When a breakpoint is hit, the actionpoint script is invoked by the
debugger, and the process continues to run. Actionpoints are sophisticated debugging tools, and provide expert
developers with an additional command suite. With them, a developer can alter the behavior of a function, capture the
point at which a behavior changes, and modify/detect an object's state. To support these features, Actionpoints can alter
the value of primitive local and member variables, can define their own 'user-defined-variables' and alter program
execution.

User-Defined Variables in Actionpoints and Breakpoints

User Defined Variables (UDVs):

e Provide the means for setting a UDV primitive or string in Actionpoint statements
e Can be used in condition statements of multiple markers/breakpoints

e Can be seen easily in the same Local Variables window

e  The final values of all UDVs are logged when debugging ends.

In the UDV syntax, the UDV name:
e Must be preceded by a # (hash) character

e [s case-insensitive

Actionpoint Statements

Actionpoint statements can contain set commands and goto commands.

set command - sets variable values. An Actionpoint statement can contain multiple set commands. They should precede
any goto command.

The set command syntax is:
set LHS = RHS

Where:
LHS = the name of the variable as a:
- user defined variable (UDV) such as #myval

- local or member variable such as strName or this.m_strName

RHS = the value to assign:
- As a literal or local variable

- If a literal, as one of: integer, boolean, floating point, char or string

UDV Examples Local Variable Examples
set #mychar = 'a’' set this.m_nCount=0
set #mystr = "a string" set bSuccess=false

set #myint = 10
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set #myfloat = 0.5

set #mytrue = true

goto command

goto command - switches execution to a different line number in a function. An Actionpoint statement can contain only
one goto command, as the final command in the statement.

The goto command syntax is:
goto L

Where L is a line number in the current function.

Integer operators

Where a UDV exists and is of type int, it can be incremented and decremented using the ++ and -- operators. For
example:

1. Create a UDV and set its value and type to a local integer variable.
AP1: set #myint = nTotalSoFar

2. Increment the UDV.
AP2: #myint++

3. Decrement the UDV.
AP3: #myint--

Timer operations

Actionpoints can report elapsed time between two points. There is only one timer available, which is reset or started with
the startTimer command. The current elapsed time can then be printed with the printTimer command. Finally, the total
elapsed time is printed and the timer ended with the endTimer command.

Example Actionpoint Conditions

With Literals and constants:
(#mychar="a")

(#mystr <>"")

(#myint > 10)

(#myfloat > 0.0)

With Local Variables:
(#myval == this.m_strValue)
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(#myint <> this-=>m_nCount)

(#myint != this->m_nCount)

Instruction Recording

Instruction recording can be useful for detecting changes to a known behavior; the point in execution (B) that diverges
from a previous execution(s) (A). The commands are:

e  recStart - starts recording or starts comparing if a previous recording exists
e recStop - ends recording

e recPause - pause recording

e recResume - resumes recording

The recStart command begins recording instructions. Executed instructions are then stored. When a recStop command
is encountered, the recording is saved. There can only be one saved recording at any one time between two Actionpoints.
When a recStart is encountered and a previous recording exists, the debugger will begin comparing each subsequent
instruction with its recording. It could perform many comparisons. If and when a difference is detected, the debugger
will break and the line of code where the behavior changed will be displayed in the code editor. The iteration of the
comparison is also printed.

The recording is stored in memory by default, but it can also be stored to a file with the command syntax:
recStart filesspec

For example:
recStart c¢:\mylogs\onclickbutton.dat

When a recStart command is encountered that specifies a file, and that file exists, it is loaded into memory and the
debugger will immediately enter comparison mode.

Expressions

There is no implicit precedence in Breakpoint, Actionpoint and Testpoint conditional expressions. In complex
expressions, the use of parentheses is mandatory. See these examples:

Actionpoint UDV example

(#myint=1) AND (#mystr="Germany")

Local variables example

(this.m_nCount > 10) OR (nCount%1)
(this.m_nCount > 10) OR (bForce)

Equality operators in conditional expressions

<> Not Equal
= Not Equal
== Equal
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= Equal

Assignment operator in Actionpoint

= Assigns RHS to LHS

Arithmetic operators in conditional expressions

/ division

+ plus

- minus

* multiplication

% modulus

Logical operators in conditional expressions

AND - both must be true
OR - one must be true
&& - both must be true
I - one must be true

A - Exclusive OR (only one must be true)
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View Variables in Other Scopes

Access

Ribbon Execute > Windows > Watches

Other £
Execution Analyzer window toolbar : | Watches

Views
View Description

Watches The Watches window is most useful for native code (C, C++, VB) where it can be
used to evaluate data items that are not available as Local Variables - data items
with module or file scope and static Class member items.
You can also use the window to evaluate static Class member items in Java and
NET
To add a watch, type the name of the variable to watch in the toolbar, and press the
Enter key.
To examine a static Class member variable in C++, Java or Microsoft .NET, enter
its fully qualified name:

CMyClass::MyStaticVar
To examine a C++ data symbol with module or file scope, just enter its name.
Variables are evaluated by looking at the current scope; that is, the module of the
current stack frame (you can change the scope at a breakpoint by double-clicking
the frame in the Call Stack).
If the global variable exists in a different module, you can examine the variable by
prefixing the module name to the variable
modulename!variable name
History The history of items entered is maintained. Previously entered names or expressions

can be selected again using the Up and Down arrow keys inside the toolbar text
box. The history will also persist for the user across any instance of Enterprise
Architect or model on the same machine.
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View Elements of Array

You can use the Watches window to inspect one or more specific elements of an array.

In the field to the left of the Watches window toolbar, type the variable name of the array followed by the start element
and the number of elements to display. The start element is enclosed in square brackets and the count of elements is
enclosed in parentheses; that is:

variable[start_element](count_of elements)

For example, Points[3](2) displays the fourth and fifth elements of the Points array, as illustrated.

Watches q =
Points[3](2) HE
Varable Value Type
E-4 Points CPoint[100]
=-¢ Points[3] CPoint
. ¢ tagPOINT
e X 610 long
ey 35 leng
El--u Points[4] CPoint
=@ tagPOINT
e X 45 long
ey 35 leng
1 | 1] b

] Watches | x| Locals [ Memory Viewer

If you entered Points[3] the Watches window would show the third array element only.

Access

Ribbon Execute > Windows > Watches

Other ) El~
Execution Analyzer window toolbar : | Watches
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View the Call Stack

The Call Stack window is used to display all currently running threads in a process. It can be used to identify which
thread is operational, immediately before program failure occurs.

When a Simulation is active, the Call Stack will show the current execution context for the running simulation. This will
include a separate context stack for each concurrent simulation "thread".

A stack trace is displayed whenever a thread is suspended, through one of the step actions or through encountering a
breakpoint. The Call Stack window can record a history of stack changes, and enables you to generate Sequence

diagrams from this history.

Access

Ribbon

Other

Use to

Execute > Windows > Call Stack

Execution Analyzer window toolbar : L S | Call Stack

e  View stack history to understand the execution of a process

e  View threads

e  Save a call stack for later use

e Record call stack changes for Sequence diagram generation

e  Generate a Sequence diagram from the call stack

o  View the related code line in the Source Code Editor

Facilities

Facility

Indicators

Save a Call Stack to a
.TXT File

Record a Thread in a
Debug Session
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Description

e A pink arrow highlights the current stack frame
e A blue arrow indicates a thread that is running

e A red arrow indicates a thread for which a stack trace history is being recorded

Not currently available.

To record the execution of a thread and direct the recording to the Record &
Analyze window, right-click on the thread in the Call Stack and select the
appropriate context menu option:

e 'Record' - to manually record the current thread during the debug session
Used in conjunction with the 'step' buttons of the debugger; each function that
is called due to a step command is logged to the Record & Analyze window

Page 105 of 214 Created with Enterprise Architect



User Guide - Visual Execution Analysis 30 June, 2017

e 'Auto-Record' - to perform auto-recording during a debug session
When you select this icon, the Analyzer begins recording and does not stop
until either the program ends, you stop the debugger or you click on the 'Stop'
icon

Stop Recording If you have started a manual or automatic recording of a thread you can stop it
before completion; select the thread (indicated by a red arrow) and either:

e  Click on the (Stop Recording) button in the toolbar or
e Right-click and select the 'Stop' option

Generate a Sequence To generate Sequence diagram from the Call Stack trace, either:
Diagram from the Call 2
Stack e  C(Click on the (Generate Sequence Diagram of Stack) button, or

e Right-click and select the 'Generate Sequence Diagram' option

Copy Stack to Recording To add the stack details immediately to the Record & Analyze window (for later
History generation of Sequence diagrams) either:

e  C(Click on the E& button, or

e Right-click and select the 'Copy Stack to Record History' option

Toggle Stack Depth To toggle between showing the full stack and showing only frames with source,
click on the (Toggle Stack Depth) button.

Display Related Code in Double-click on a thread/frame to display the related line of code in the Source

Source Code Editor Code Editor; local variables are also refreshed for the selected frame.
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Create Sequence Diagram of Call Stack

The Call Stack window records a history of stack changes from which you can generate Sequence diagrams.

Access
Ribbon Execute > Windows > Call Stack
Other B~
Execution Analyzer window toolbar : | Call Stack
Use to

e Record Call Stack changes for Sequence Diagram generation

e  Generate a Sequence Diagram from the Call Stack

To generate a Sequence diagram from the current Stack, click on the
on the Call Stack window toolbar.

This immediately generates a Sequence diagram in the Diagram View.
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(Generate Sequence Diagram of Stack) button
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Inspect Process Memory

Using the Memory Viewer, you can display the raw values of memory in hex and ASCII. You can manually define the
memory address in the 'Address' field (top right), or right-click on a variable in the Locals window or Watches window
and select the 'View Memory at Address' option.

Access
Ribbon Execute > Windows > Memory Viewer
Other B~
Execution Analyzer window toolbar : | Memory Viewer
From Locals window or Watches window : Right-click on a variable | View
Memory at Address
Notes

e The Memory Viewer is available for debugging Microsoft Native Code Applications (C, C++, VB) running on
Windows or within WINE on Linux
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Show Loaded Modules

For .NET and native Windows applications, you can list the DLL's loaded by the debugged process, using the Modules
window. This list can also include associated symbolic files (PDB files) used by the debugger.

Access

Ribbon Execute > Windows > Modules

Modules Window display

Column Description
Path Shows the file path of the loaded module.
Load Address Shows the base memory address of the loaded module.
Modified Date Shows the local file date and the time the module was modified.
Debug Symbols Shows:

e The debug symbols type
e Whether debug information is present in the module, and

e Whether line information is present for the module (required for debugging)

Symbol File Match Indicates the validity of the symbol file; if the value is false, the symbol file is out
of date.

Symbol Path Shows the file path of the symbol file, which must be present for debugging to
work.

Modified Date Shows the local file date and time the symbol file was created.
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Process First Chance Exceptions

Access

Ribbon

Other

Processing Elements

Element

Debug Process

Second Chance Exceptions

First Chance Exceptions

Selection
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Execute > Analyze > Debugger > Process First Chance Exceptions

&

Debug window toolbar : : | Process First Chance Exceptions

Description

When an application is being debugged and the debugger is notified of an
exception, the application is paused and the debugger responds in the way it is
configured to do; it either:

e Resumes the application and leaves the exception to the application to manage,
or

e Keeps the application suspended and passes the exception to the appropriate
routines for automatic resolution or manual intervention

The Enterprise Architect debugger defaults to the first behavior, above.

If the application can handle the exception, it continues to process; if it cannot
handle the exception, the debugger is notified again and this time it must suspend
the application and resolve the exception condition.

In this behavior, because the debugger has encountered the exception twice, it is
known as a second-chance exception; in this case, if the exception does not halt
execution, it is ignored and you avoid spending time on conditions that do not
impact the overall outcome of processing.

You might work this way on large or complex systems that invariably involve
exception conditions somewhere in the processing paths.

However, if you want to examine every exception that occurs as soon as it occurs,
you can set the debugger to adopt the second behavior.

Because the debugger responds to the exception on first contact, it is known as a
first-chance exception.

You might work this way with individual functions or routines that must work
cleanly or not at all.

Select the 'Process First Chance Exceptions' option to debug exceptions on first
contact.

Deselect the option to process exceptions only if the application fails when they
occur.
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Just-in-time Debuger

You can register the Enterprise Architect debugger as the operating system Just-in-time debugger, to be invoked when an
application running outside Enterprise Architect on the system either encounters an exception or crashes. When you do
s0, an application crash will cause Enterprise Architect to be opened, and the source and reason for the crash displayed.

Access

Ribbon Execute > Analyze > Debugger > Set as JIT Debugger
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During the lifetime of software applications, it is not uncommon to investigate application tasks that are determined to be
performing slower than expected. You might also simply want to know what is going on when you 'press this button'!
You can work this out quite quickly in Enterprise Architect by using its Profiler. Results can usually be produced in a
few seconds and you will quickly be able to see the actions that are consuming the application and the functions
involved. In the Execution Analyzer, The feature employs two separate strategies; Process Sampling and Process
Hooking. In one, samples are taken at regular intervals to identify CPU-intensive patterns, while in the other, the process
is hooked to record demands made on memory. Data is analyzed to produce a weighted Call Graph. Behaviors are
usually identifiable as root nodes (entrypoints) in the graph, or branches near these points. All reports can be reviewed on
demand. They can be saved to file within the model, both as Artifact elements and as Team Review posts.

Access
Ribbon Code > Analyzer > Profile
Execute > Analyze > Profiler > Open Profiler
Other Execution Analyzer toolbar : Analyzer Windows | Profiler
Call Sampling
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Profiler O x
- & o 1 | B call Graph @

Process Id: 3540 Path: CM\Apachewences \DOMPrint exe

Sample time {ms): 0.0963 Court: 46257

Process time (ms): 1.1381 Fragments: 2

Entrypoints Sampled Processed Tirne

1 mainCRT5tartup Ap257 46228 00:00:38.63

The Profiler is controlled using its toolbar buttons. Here you can attach the Profiler to an existing process (or JVM), or
launch the application for the active Analyzer Script. The Profiler window displays the details of the target process as it
is profiled. These details provide feedback, letting you see the number of samples taken. You also have options for
pausing and resuming capture, clearing captured data and generating reports. You can gain access to the reporting feature
by pausing the capture - the reporting feature is disabled whilst data capture is in progress.

Weighted Call Graph
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d=|e~|a4|a7|3|@

Call Stack Inclusive Hits  Hits
= xercesc_3_1n5AKZKMLReaderlmpl:parse 16051
= xercesc_3_T1uxXMLScanner:scanDocument 16051
= xercesc_3_T:ulGEMLScanner:scanDocument 16051
= xercesc_3_1ulGEMLScanner:scanContent 16051
= xercesc_3_1ulGXMLScanner:scanStartTaghs 16051
= xercesc_3_1ulGXMLScannersresolveschemaGrammar 16051
= xercesc_3_1nSchemaValidator:preContentValidation 16049
= xercesc_3_luComplexTypelnfoicheckUniqueParticledttribution 16049
= xercesc_3_1uComplexTypelnfoimakeContentModel 16049
= xercesc_3_1uDFAContentModel:DFAContentModel 16047
= xercesc_3_TuDFAContentModel:buildDFA 15993 515
= xercesc_3_1:CMStateSet:operator|= 2174 2093
memcpy 32 32
wercesc_3_1aCMStateSet:allocateChunk 27 1
__security_check_cookie 21 21
TraillpVec 1 1
xercesc_3_TuCMStateSet:: ~ CMStateSet 3573 4
xercesc_3_1uXMemorny:operator delete 241 2
xerces-c_3_10 4416 2
xercesc_3_1nCMStateSet:getBit 1036 1036
xercesc_3_1nDFAContentModel:buildSyntaxTree 528 3
wercesc_3_1nCMStateSet: CMStateSet 373 3
xercesc_3_1nCMStateSet:getBitCountinRange 285 285
xercesc_3_1uXMemonyioperator new 21 2
xercesc_3_TuCMStateSetizeroBits 154
wercesc_3_1uCMStateSetEnumerator:nextElement 153 136
xercesc_3_1uRefHashTableOf<xercesc_3_1uXMLinteger: 59 2
xercesc_3_1uRefHashTableOf <xercesc_3_1uXMLinteger: 28 2
xercesc_3_1uRefHashTableOf<xercesc_3_1n¥MLintegery 25
wercesc_3_1uDFAContentModel:makeDefStatelist 25 2

This detailed report shows the unique set of Call Stacks/behaviors as a weighted Call Graph. The weight of each branch
is depicted by a hit count, which is the total hits of that branch plus all branches from this point. By following the hit
trail, a user can quickly identify the areas of code that occupied the program the most during the capture period.

Memory Profiles

(c) Sparx Systems 2015 - 2017 Page 115 of 214 Created with Enterprise Architect



User Guide - Visual Execution Analysis

30 June, 2017

Profiler
d-r & o

- E/ Memory Profile

Program:

C:Vapache \werces\DOMPrint, exe C:\test\materialsYarge, xml
Frames (4-64): 20
Alocations: JO00 Frees: 0
Stack holdings: 7000 Frees not found: 0
Heap Holdings (MB): 8 Blapsed: 1:24 mins

The Memory profile tracks allocations, ignoring when memory is freed. It uses this information to rate the executing
code's demands for memory, in terms not of the amount of memory but of the frequency of demands. The Allocations

figure is the total number of memory allocations requ

ested. The Stack Holdings is the number of stack traces taken at

those times, and the Heap Holding figure is the total amount of memory obtained by these calls. Note that profiling can
be turned on and off on demand. There is also no need to rebuild your program to get it to work as there is no linkage

involved.

Memory Graph

bed profile

@StartPage 3 *leaks |4 *profile ¢
Call Stack

4 [7] ntdll:RtlAllocateHeap
4 ntdll:RtlpNtSetValuekey
Fl ntdll:RtIDestroyMemoryBlocklLookaside
4 ntdll:RtlAllocateHeap
4 [7] ntdll
4 msverd0d:malloc_base
4 msvcrdldimalloc_dbg
4 msvecrdld:malloc_dbg
4 msverdld:malloc_dbg
4 msverdld:mallec
Pl msvcrld:operator new
4 @ xerces-c_3_Tdixercesc_3_1:M

4 EvApache\xalan- builds\xerces-src-31\Buil d\Win32\WVCHdebug \DOMPrint.exe C:\test\materials\portraitxml

» @ xerces-c_3_ldixercesc_3_1u:
» @ xerces-c_3_Tdixercesc_3 1u:
» @ xerces-c_3_ldixercesc_3_1:
» @ xerces-c_3_ldixercesc_3_1:
» @ werces-c_3_ldmercese_3_1:
» @ xerces-c_3_ldixercesc_3_1:
» @ xerces-c_3_ldixercesc_3_1u:
» @ xerces-c_3_ldixercesc_3_1u:
» @ xerces-c_3_ldixercesc_3_1u:
» @ xerces-c_3_Tdixercesc_3 1u:
» @ xerces-c_3_ldixercesc_3_1:

This example is of a report produced from Profiling a

q
Instances Bytes
0 0
7,068 4,830,947
7,068 4,830,947
7,068 4,830,947
7,068 4,830,947
7,068 4,830,947
4813 3,985,885
4813 3,985,885
4813 3,985,885
4813 3,985,885
4812 3,985,734
4812 3,985,734
M. Impl:allocate 4,807 3,985,526
RangeToken:expand 803 396,934
ValueHashTableOf < bool xercesc_3_1:5tringHashers:put 79 37,968
XMemory:operator new 753 239,048
XMemory::operator new 333 21,652
RangeToken:doCreateMap 201 19,788
RangeToken:addRange 287 28,700
XMLString:replicate 218 12,914
RefHashTableOf <xercesc_3_1:RangeTokenElemMap,xercesc_3_1 146 7,008
RefHashTableOf <xercesc_3_1:CPMapEntry,xercesc_3_1u5tringH: 144 6,912
Win32Trans5ervice::Win32TransService 112 6,612
Win32Trans5ervice:Win32TransService 106 6,258

demonstration program in the Xerces project from Apache. The

program iterates over the Document Object Model (DOM) for a provided xml file.

Function Summary Report
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Mame Inclusive Hits
Je Je

profiler/Example.Run 156
profiler/Example.main 156
java/lio/FileQutputStream.write 154
java/io/PrintStream.println 154
profiler/Example.Print 154
profiler/Example. MakeltalianCars 2
profiler/Example.MewCar 2

This summary report lists the functions and only those functions executed during the sample period. Functions are listed
by total invocations, with a function that presents twice in separate Call Stacks appearing before a function that appears
just the once.

Function Line Report

LineMo Hits Code

54 1 forfint n = 0; n < 10000; n++)

55 [

56 1408 m_Cars = new Collection<Car=[);
57 1408 if{[n % 3)=0)

53 i

59 938 forfinti =0 i< 1000 i=+)

60 i

&1 S33000 MakeltalianCars();:

R 1

This detailed report shows the source code for a function line by line displaying beside it the total times each was
executed. We uncovered code using this report, that exposed case statements in code that never appeared to be executed.
Support

The Profiler is supported for programs written in C, C++, Visual Basic, Java and the Microsoft .NET languages. Memory
profiling is currently available for native C and C++ programs.

Notes
e The Profiler is available in Enterprise Architect Professional editions and above

e  The Profiler can also be used under WINE (Linux and Mac) for Profiling standard Windows applications deployed
in a WINE environment
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System Requirements

Using the Profiler, you can analyze applications built for these platforms:
e Microsoft ™ Native (C++, C, Visual basic)
e Microsoft .NET (supporting a mix of managed and unmanaged code)

e Java

Microsoft Native applications

For C, C++ or Visual Basic applications, the Profiler requires that the applications are compiled with the Microsoft ™
Native compiler and that for each application or module of interest, a PDB file is available. The Profiler can sample both
debug and release configurations of an application, provided that the PDB file for each executable exists and is up to
date.

Microsoft .NET applications

For Microsoft .NET applications, the Profiler requires that the appropriate Microsoft .NET framework is installed, and
that for each application or module to be analyzed, a PDB file is available.

Java

For Java, the Profiler requires that the appropriate JDK from Oracle is installed.
The classes of interest should also have been compiled with debug information. For example: "java -g * java"
e New instance of application VM is launched from Enterprise Architect - no other action is required

e  Existing application VM is attached to from within Enterprise Architect - the target Java Virtual Machine has to
have been launched with the Enterprise Architect profiling agent

These are examples of command lines to create a Java VM with a specific JVMTI agent:

1. java.exe -cp "%classpath%;.\" -agentpath:"C:\Program Files (x86)\Sparx Systems\EA\vea\x86\ssamplerlib32"
myapp

2. java.exe -cp "%classpath%;.\" -agentpath:"C:\Program Files (x86)\Sparx Systems\EA\vea\x64\ssamplerlib64"
myapp

(Refer to the JDK documentation for details of the -agentpath VM startup option.)
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Getting Started

The Profiler can be used to investigate performance issues, providing three separate tools for you to choose from,
namely:

e  Call Graph
e  Memory Profile
e Memory Leaks

You select the tools from the Profiler toolbar.

Tools
Tool Description

Call Graph Analyzes performance by taking samples during an activity in a program. Each
sample represents a stack. The samples are taken at intervals controlled using the
toolbar. In this scenario, poor performance is rated by the patterns of behavior that
repeat the most during the sample time period. This figure is used to weight the Call
Graph produced.

Memory Profile Analyzes performance by hooking the memory allocations made by a program. In
this scenario, poor performance is rated by the activities making the most requests
for memory. This figure is used to weight the Call Graph produced.

Memory Leaks Analyzes memory leaks by hooking the memory operations performed by a
program. What is produced is a Call Graph presenting the Call Stacks that allocated
memory for which a free operation was not detected.

Access

Ribbon Code > Analyzer > Profile
Execute > Analyze > Profiler > Open Profiler

Other Execution Analyzer toolbar : Analyzer Windows | Profiler

Toolbar Buttons

Button Action
(s Profiler options
b Launches the configured application to be profiled. By default, this is the

application configured in the active Analyzer Script.
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1w Cu While the Profiler is running, pauses and resumes capture.

When capture is paused, the Report button and Discard Data button are active.

Stops the Profiler process; if any samples have been collected, the Report button is
enabled.
Generates a report from the current data collection.

5 - For the call sampler, sets the interval, in milliseconds, at which samples are taken
of the target process; the range of possible values is 1 - 250. (Sampler strategy
only.)

W Discards the collected data. You are prompted to confirm the discard.
Displays the Help topic for this window.

(c) Sparx Systems 2015 - 2017 Page 120 of 214 Created with Enterprise Architect



User Guide - Visual Execution Analysis 30 June, 2017

Call Graph

Profiler O x
-~ % a1 - | [&/ | call Graph
Process Id: 3540 Path: CApache'werces \DOMPrint exe
Sample time {ms): 0.0963 Court: 46257
Process time |ms): 1.1381 Fragments: 2
Entrypoints Sampled Processed Time
1 mainCRTStartup 46257 46228 00:00:33.63
Call Stack Inclusive Hits UFP
4 [7] mainCRTStartup 7408
4 [ sax2print:mainCRTStartup 7408 1
a4 [ sax2print:_trmainCRTStartup TA07 1
4 [ sax2printmain 7,350 1
4 @ xerces-c_3_1Dmercesc_3_1nSAX2KMLReaderlmpl:parse 7,350 1
rl @ xerces-c_3_1Duwercesc_3_TuXMLScanner:scanDocument 7,350 1
4 @ xerces-c_3_1Duwercesc_3_TuXMLScanner:scanDocument 7.349 1
4 @ xerces-c_3_1Dhxercesc_3 1ulGXMLScanner:scanDocument 7.348 1
4 @ xerces-c_3_1Dhxercesc_3 1ulGXMLScanner:scanContent 3,309 1
4 @ xerces-c_3_1Dkxercesc_3_1:lGXMLScanner:scanCharData 3,301 1
4 @ werces-c_3_1Dmercesc_3_1:lGXMLScanner:sendCharData 3,301 1,742
4 @ werces-c_3_1Dxercesc_3_1uSAX2XKMLReaderlmpl:docCharacters 3,301 1,742

e Quickly discover what a program is doing at any point in time
e Easily identify performance issues

e  Be surprised how quickly you can realize improvements

e See your improvements at work and have the evidence

e Support for C/C++, NET and Java platforms

Usage

The 'Call Graph' option is typically used in situations where an activity is performing slower than expected, but it can
also be used simply to better understand the patterns of behavior at play during an activity.

Operation

The Profiler operates by taking samples - or Call Stacks - at regular intervals over a period of time; the interval is set
using the Profiler toolbar. You use the Profiler to run a particular program, or you can attach to an existing process. The
Profiler capture is controlled, and you can pause and resume capture at any time. You can also elect to have capture
initiated immediately when the Profiler is started. If necessary, you can discard any captured samples and start again
during the same session. If you can't continue with the same session, restarting the Profiler is quick and easy.

Results
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Results can be produced at any time during the session; however, capture must be disabled in order for the Report button
to become active. It is up to you to decide how long you let the Profiler run. You might know when an activity is
finished, or it might be apparent for other reasons. The reason you are here might be that an activity is not completing at
all.

You enable the Report button by either pausing capture or stopping the Profiler altogether.

Results are displayed in a Report view. The report opens with two tabs initially visible: the Call Graph and the Function
Summary. The reports can be saved to file, stored in the model as Artifacts or posted in Team Review.
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Memory Profile

Profiler 0o
i~ & o\ - | [E/ Memory Profile

Program:
C:Vapache \werces\DOMPrint, exe Ci\test\materialsYarge, xmil
Frames (4-64): 20
Alacations: JO00 Frees: 0
Stack holdings: 7000 Frees not found: 0
Heap Holdings (MB): 8 Elapsed: 1:24 mins
Call Stack Instances Bytes
Pl c\Apache\xalan-builds\xerces-src-31\Build\Win32\VC9\debughDOMPrint.exe "c\sysinternals\LogFilexml" 4136 78,256,467
4 ntdll:RtlAllocateHeap 4136 78,256,467
Pl ntdll:RtlphtSetValuekey 4136 78,256,467
Pl ntdll:RtiDestroyMemoryBlocklLookaside 4136 78,256,467
4 ntdll:RtlAllocateHeap 4136 78,256,467
Pl ntdll 4136 78,256,467
4 msverdld:malloc_base 4132 78,253,895
4 msverdld:malloc_dbg 4132 78,253,895
4 msverdld:malloc_dbg 4132 78,253,895
4 msverdld:malloc_dbg 4132 78,253,895
4 msverdd:malloc 4131 78,253,747
4 msverdld:operator new 4131 78,253,747
4 @ xerces-c_3_ldwercesc_3_1:MemoryManagerlmpl:allocate 4126 78,253,539
» @ xerces-c_3_ldwercesc_3_1:ValueHashTableOf<boolxercesc_3_1:StringHasher=:put 791 37,968
» @ xerces-c_3_ldixercesc_3_l:uXMemory:operator new 746 75,364
» @ xerces-c_3_ldixercesc_3 OMDocumentlmpl::allocate 372 142,664
» @ xerces-c_3_ldixercesc_3_l:uXMemory:operator new 332 21,596
» @ xerces-c_3_ldwxercesc_3_1:RangeToken:doCreateMap 2491 16,788
» @ xerces-c_3_ldwxercesc_3_1:RangeToken:addRange 223 22,300
» @ xerces-c_3_ldwercesc_3_1:uXMLString:replicate 202 11,906
» @ xerces-c_3_ldwxercesc_3_1:DOMDocumentimpl:allocate 152 77,583,712
» @ xerces-c_3_ldwxercesc_3_1:RefHashTableOf <xercesc_3_1:RangeTokenElemMap,xercesc_3_ 146 7,008
» @ xerces-c_3_ldwxercesc_3_1:RefHashTableOf <xercesc_3_1:CPMapEntry,xercesc_3_1:Stringk 144 6,912
» @ xerces-c_3_ldixercesc_3_1:RangeToken:expand B4 74,052

e  Quickly rate performance of activities that interest you
e Nothing influences a discussion more than evidence
e Reward your efforts by working in those areas that will make a difference

e  Surprise yourself by delivering optimizations you might not have known existed

Usage

The Memory Profile can be used to reveal how activities perform in regard to memory consumption. Using this mode, a
user would be interested in questioning the frequency of demands made for memory during a task. They would be less
interested in the actual amount consumed. A well managed activity might make relatively few calls to allocate resources
but allocate enough memory to do its job efficiently. Other activities might make many thousands of requests, and that
typically makes them less efficient. This mode is useful for detecting those scenarios.

(c) Sparx Systems 2015 - 2017 Page 123 of 214 Created with Enterprise Architect



User Guide - Visual Execution Analysis 30 June, 2017

Operation

The Memory Profile works by hooking the process in question, so that program has to be launched using the tool in
Enterprise Architect. Unlike the Call Graph option, you cannot attach to an existing process. When the program is
started, hooking mechanisms track the allocation of memory; this information is collected and collated in Enterprise
Architect. You can easily monitor the number of allocations being made. Also, the process is controlled; that is, the
memory hooks can be turned on and off on demand. If you might have mistimed some action, you can pause capture,
discard the data and resume capture again easily.

Results

Results can be produced at any time during the session; however, capture must be disabled in order for the Report button
to become active. It is your decision how long you let the Profiler run. You enable the Report button by either pausing
capture or stopping the Profiler altogether.

Results are displayed in a Report view. The report initially opens with two tabs visible; a single weighted Call Graph and
a Function Summary. The Call Graph depicts all the Call Stacks that led to memory allocations, which are aggregated
and weighted according to the frequency of the pattern.

Requirements

For best results, the image and its modules should be built with debug information included, and without optimizations.
Any module with the Frame Pointer Omission (FPO) optimization is likely to produce misleading results.
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Memory Leaks

Profiler
-k % 05| - | [% | Memory Leaks -
Program; Ising Analyzer Script -
E:\apachewalan-buildsxerces-src-31\Build Wiin323WC9\debug \DOMPrint.exe C

Frames (4-64): 20 :

Mlocations: 7088 Frees: 7083

Stack holdings: 1 Frees not found: 86

Heap Holdings (MB): 0 Elapsed: 3.1 secs

The Profiler control, showing the count of memory allocations and the count of operations that are memory free.

B leaks

®5tart Page | i+, *leaks X
Call Stack Instances Bytes
4 EM\Apache\xalan-builds\xerces-src-31\Build\Win32\WVCH debughDOMPrint.exe C:\test\materials\portrait.xml
4 ntdll:RtlAllocateHeap
4 [7] ntdl:RtpMNtSetValueKey
Pl ntdll:RtiDestroyMemoryBlockLookaside
a ntdll:RtlAllocateHeap
4 [7] ntdll
4 msverdld:malloc_base 131
P msverdld:malloc_dbg 151

0
1 151
1
1
1
1
1
1
4 msverdld:malloc_dbg 1 151
1
1
1
1
1
1
1
1

131
13
131
131

4 msvcr0d:malloc_dbg 131
4 msverdld:malloc_dbg 151

a msver3d:unlock 151

4 mevcrd:_getmainargs 131

P msverdld 151

P msver®dinitterm 151

4 [7] msvers0d 151

mswerd0d 151

A well behaved program.

Memory leak detection is a road well traveled. Although many other good options are available, we believe our approach
has major benefits, such as:

e No changes at all to existing project build
e No header files required by the project code
e No runtime dependencies to worry about

e No system configuration to think about

Usage

A person would use this mode to track memory leaks in an application or in an activity within the application. A memory
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leak from the Profiler's point of view is a successful call made to a memory allocation function that returns a memory
address for which no matching call to free that address is made.

Operation

The Memory Leak detection works through hooking. The memory routines of the process are hooked to track when
memory is both allocated and freed. Call Stacks are captured at the point of the allocation and this information is collated
in Enterprise Architect to produce a report in the form of a Call Graph. Capture is controlled; that is, the hooking
mechanisms can be enabled or disabled on demand.

Depending on the type of program and its memory consumption, you could employ an appropriate strategy. For small
programs, you might track the program from start to finish. For larger windowed programs, you would probably do better
by toggling capturing before and after a specific task to avoid tracking too much data.

Results

Results can be produced at any time during the session; however, capture must be disabled in order for the Report button
to become active. It is your decision how long you let the Profiler run. You enable the Report button by either pausing
capture or stopping the Profiler altogether.

Results are displayed in a Report view. The report initially opens with two tabs visible; a single weighted Call Graph and
a Function Summary. The Call Graph depicts all the Call Stacks that led to memory allocations, and are aggregated and
weighted according to the frequency of the pattern.

Reports can contain a variable amount of 'noise'. To focus on an area you have specific concerns for, locate a function
known to you in the summary report and use that to navigate directly into the line in the graph where it is featured.

Requirements

For best results, the image and its modules should be built with debug information included, and without optimizations.
Any module with the Frame Pointer Omission (FPO) optimization is likely to produce misleading results.
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Setting Options

Profiler
-k 1 - | & Memory Profile

# Attach to Running Process

*

Load Report

Analyzer Scripts...

Shift+F12

CallGraph Aggregates Method

CallGraph Samples Include Wait State

v Start Sampling Immediately

Discard Fragments
Capture Debug Output

Stop Process on Exit

Call Graph Options

Option

Interval

Attach to Running Process

Switch to Debugger

CallGraph Aggregates
Method

CallGraph Samples Include
Wait State

Discard Fragments

(c) Sparx Systems 2015 - 2017

Description

5 .

Clicking on the up/down arrows, set the interval, in milliseconds, at which samples
are taken of the target process; the range of possible values is 1 - 250 ms.

Click on this option to select a running process.

Click on this option to switch from Profiling to Debugging. The Debugger has an
equivalent drop-down menu option that you can use to switch from Debugging to
Profiling.

When this option is selected, instances of the identical stack sequences are
aggregated by method. That is to say, line numbers / instructions within a method
are ignored, so two stacks will be counted as one where they differ only by line
number in their final frame.

When this option is selected, the Profiler will sample all threads, including those in
Wait states. When unselected, the Profiler only samples threads that have
accumulated CPU time since the last interval expired.

Sometimes, it just happens that the results of a stack walk operation can not be
reconciled; that is, they do not appear to lead back to the entry point for the thread
reporting the stack. We refer to these partial stack traces as ' fragments' and you can
decide to display them or select this option to ignore them.
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Capture Debug Output Applies to Process Sampling. When selected, output normally visible during
debugging is captured and displayed in the Debugger window. Note that only
debug builds will typically emit debug output.

General Options

Option Description
Load Report Select this option to load a previously saved report from the file system.
Analyzer Scripts Select this option to open the Analyzer Script window, which is the model

repository for configuring builds, debugging, and all other Visual Execution
Analyzer options.

Start Sampling Select this option to trigger Data Collection immediately on launch. You would
Immediately typically use this option to profile a process during startup.
Stop Process on Exit This option determines termination behavior for the Profiler. When the option is

selected, the target process will terminate when the Profiler is stopped.
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Start & Stop the Profiler

Profiling is a two stage process of data collection and reporting. In Enterprise Architect the data collection has the
advantage of being a background task - so you are free to do other things while it runs. The information sent back to
Enterprise Architect is stored until you generate a report. To view a report, the capture must be turned off. After the
report is produced you can resume capture with the click of a button. If, for some reason, you decide to scrap your data
and start again, you can do so easily and without having to stop and start the program again.

class Profiler

EA Profiler [Target Application
T eflows | ~ flows
Access
Ribbon Code > Analyzer > Profile
Execute > Analyze > Profiler > Open Profiler
Other Execution Analyzer toolbar : Analyzer Windows | Profiler
Actions
Action Detail
Toolbar .
Profiler
- 1 . Call Graph @
Memory Profile
Memory Leaks
Strategy Selection Select the Profiling strategy from the available options on the Toolbar.
Start the Profiler Click the Run button on the Profiler window
Stop the Profiler The process exits if:
e You click on the Stop button
e The target application terminates, or
e  You close the current model
If you stop the Profiler and the process is still running, you can quickly attach to it
again.
Pause and Resume Capture You can pause and resume capture at any time during a session.

When capture is turned on, samples are collected from the target. When paused, the
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Profiler enters and remains in a wait state until either capture is enabled, the
Profiler is stopped or the application finishes.

Generate Reports The Report button is disabled during capture but is available when capture is turned
off.
Clear Data Collection You can clear any data samples collected and resume at any time. First suspend

capture by clicking on the Pause button. The Discard button, as for the Report
button, is enabled whenever capture is turned off. In clicking on the Discard button
you will be asked to confirm the operation. This action cannot be undone.
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Function Line Reports

After you have run the Profiler on an executing application and generated a Sampler report, you can further analyze the
activity of a specific function listed in the report by generating a Function Line report from that item. A Function Line
report shows the number of times each line of the function was executed. You produce one Function Line report at a
time, on any method in the Sampler report that has a valid source file. The Function Line report is particularly useful for
functions that perform loops containing conditional branching; the coverage can provide a picture of the most frequently
and least frequently executed portions of code within a single method.

The line report you generate is saved when you save the Sampler report. The body of the function is also saved with the
Function Line report to preserve the function state at that time.

Platforms supported

Java, Microsoft NET and Microsoft native code

Create a Line Report

In the Sampler report, right-click on the name of the function to analyze, and select the 'Create Line report for function'
option.

Once the Profiler binds the method, the Function Line report is opened on the Sampler Report window. The report shows
the body of the function, including line numbers and text. As each line is executed a hit value will accumulate against
that line. A timer will update the report approximately once every second.

(c) Sparx Systems 2015 - 2017 Page 131 of 214 Created with Enterprise Architect



User Guide - Visual Execution Analysis 30 June, 2017

M 4 » M | CallTree Report | Summary Report | ConsoleApplication:CQuickSort:Quicksort
-

Module:ConsoleApplication

Function: CQuickSort:Quicksort

Date: 20,/09/2013 2:53:21 PM

Author smeagher
Iterations: 28679

LineMo Hits Code

21 28645 {

22 28644 if ir<=1)

23 14460 retum;

24 14134 inti=1.j=r.p=F.g=r;
25 for {;;)

26 i

27 435530 while (a[++] < a[r]) ;

28 14185 while (@[] = alrl)

29 if§==I)

30 breal:;

H if i =]}

32 14185 break;

33

M BExchangel(a. i. j)

35 if {alil ==all)

g Exchangela, ++p. i);
7

33 if {af] ==al])

35 Exchangela. j. gl
40

41 }

42 14185 Exchangela.i. r);

43 14185 j=i-10=is1;

44 14185 forfint k=1, k < p; k== j-)

End Line Report Capture

Once enough information is captured, or the function has ended, click on the Profiler toolbar Stop button to stop
recording the capture.

Save Reports

Use the Save button on the Call Stack toolbar to save the Sampler report and any Function Line reports to a file.

Delete Line Reports

Closing the 'Line Report' tab will close that report but the report data will only be deleted when the report is saved.
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Generate, Save and Load Profile Reports

Reports can be produced at any time during a session, or naturally when a program ends. To enable the Report button
while the program is running, however, you need to suspend Profiling by toggling the Pause/Resume button, or by
terminating the Profiler with the Stop button. You have some options for reviewing and sharing the results:

e  View the report

e  Save the report to File

e Distribute the report as a Team Review resource

e  Attach the report as a document to an Artifact element

e Synchronize the model by reverse engineering the source code that participated in the profile

Access
Ribbon Execute > Analyze > Profiler > Create Report from Current Data
Other

From the Profiler window, click on the icon in the toolbar.

CallFrequency Report
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d=|e~|a4|a7|3|@

Call Stack Inclusive Hits  Hits
= xercesc_3_1n5AKZKMLReaderlmpl:parse 16051
= xercesc_3_T1uxXMLScanner:scanDocument 16051
= xercesc_3_T:ulGEMLScanner:scanDocument 16051
= xercesc_3_1ulGEMLScanner:scanContent 16051
= xercesc_3_1ulGXMLScanner:scanStartTaghs 16051
= xercesc_3_1ulGXMLScannersresolveschemaGrammar 16051
= xercesc_3_1nSchemaValidator:preContentValidation 16049
= xercesc_3_luComplexTypelnfoicheckUniqueParticledttribution 16049
= xercesc_3_1uComplexTypelnfoimakeContentModel 16049
= xercesc_3_1uDFAContentModel:DFAContentModel 16047
= xercesc_3_TuDFAContentModel:buildDFA 15993 515
= xercesc_3_1:CMStateSet:operator|= 2174 2093
memcpy 32 32
wercesc_3_1aCMStateSet:allocateChunk 27 1
__security_check_cookie 21 21
TraillpVec 1 1
xercesc_3_TuCMStateSet:: ~ CMStateSet 3573 4
xercesc_3_1uXMemorny:operator delete 241 2
xerces-c_3_10 4416 2
xercesc_3_1nCMStateSet:getBit 1036 1036
xercesc_3_1nDFAContentModel:buildSyntaxTree 528 3
wercesc_3_1nCMStateSet: CMStateSet 373 3
xercesc_3_1nCMStateSet:getBitCountinRange 285 285
xercesc_3_1uXMemonyioperator new 21 2
xercesc_3_TuCMStateSetizeroBits 154
wercesc_3_1uCMStateSetEnumerator:nextElement 153 136
xercesc_3_1uRefHashTableOf<xercesc_3_1uXMLinteger: 59 2
xercesc_3_1uRefHashTableOf <xercesc_3_1uXMLinteger: 28 2
xercesc_3_1uRefHashTableOf<xercesc_3_1n¥MLintegery 25
wercesc_3_1uDFAContentModel:makeDefStatelist 25 2

Function Summary
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®StartPage i Clea\tests\cg-xerces-sax2print.ssprf

Marme Inclusive Hits Occurrences
p P

[2 mainCRTStartup 7408 1
[& _tmainCRTStartup 7407 1
@ wercesc_3_TuxXMLFormatter handle UnEscaped Chars 7351 10
@ xercesc_3_1uxMLFormatter::format Buf 7351 10
@ wercesc_3_TuxXMLFormatter:ispecialFormat 7351 10
@ 582 PrintHandlers:write Chars 7350 10
@ xercesc_3_1nxMLScanner::scanDocument 7350 1
[ main 7350 1
@ xercesc_3_1n5AX2XMLReaderImpl::parse 7350 1
@ xercesc_3_1nxMLScanner::scanDocument 7349 1
@ xercesc_3_1nIGXMLScanner:scanDocument 7348 1
@ xercesc_3_1uxMLFormatter::format Buf 4042 8

Unfiltered Summary Report listing all participating functions in order of inclusive hits.

®StartPage W Ci\ea\tests\cg-xerces-sax2print.ssprf X

Mame Inclusive Hits Occurrences
SAX e

@ 5422 PrintHandlers:write Chars 7350 10

@ xercesc_3_1n5202XMLReaderImpl:parse 7350 1

@ xercesc_3_1n522xMLReaderImpl:doc Tharacters 3309 2

@ S5Ax2PrintHandlers: .characters 3309 2

@ xercesc_3_ 10522 xMLReaderImpl:end Element 2114 1

FE“] xercesc_3_1:05802XMLReaderImpl:startElement 1925 1

@ 5802 PrintHandlers::endElerment 1523 1

You can filter and reorganize the information in the report, in the same way as you do for the results of a Model Search.

Report Options

Right-click on the report to display the context menu.
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-c_3_1Dmmercesc_3_1:5AK2XMLReaderlmpl:parse 7,350
ces-c_3_1Dmercesc_3_1u¥MLScanner:scanDocument 7.350
werces-c_3_1Dkxercesc_3_1uXML5canner:scanDocument 7.349
@ xerces-c_3_10hxercesc_3_1zlGXMLScannen:scanDocument _ 48
4 FEE] xerces-c_3_1Dhwercesc_3_1nlGXMLScannern:scanContent LRI TS AT g
d @ werces-c_3_1Dkxercesc_3_1uIGXMLScanner:scanCharl Find in Summary Window 01
4 [ xerces-c_3_1D:xercesc_3_1:GXMLScanner:sendCh Collapse Graph i
P @ xerces-c_3_1Dhercesc_3_1n5AK2XMLReaderlm Collapse To Node 01
4 & sax2print:SAX2PrintHandlers::characters 01
d @ xerces-c_3_1Dhxercesc_3_1uXMLFormat Follow Max Allocations 01
4 [ werces-c_3_1D:xercesc_3_1:XMLFori Create Line Report for Function 01
a @ xerces-c_3_1Dhxercesc_3_TudML e TR e 01
4 FEE] werces-c_3_1Dhxercesc_3_Tnk 01
4 [ sax2print:SAX2PrintHanc Display Heaviest Weighted Use i
4 [7] MSVCP90D 01
4 [F] MSVCPOOD 01
4 [7] MSVCPOOD 01
4 [7] MSVCPS0 01
4 FIMSVC o tofit P!
a4 [F] M2 01
4 save Report to File 01
¥ Save Report to Artifact 01
Hel 01
2

"’ 61
] KERMELBASE 1,640

Action Detail

Show Source for Function For the selected frame, select this option to display the corresponding line of code
in a code editor. Frames that have source available are identifiable by their icon.

Find in Summary Window Select this option to locate the function in the 'Summary' tab.

Collapse Graph Select this option to collapse the entire graph including child nodes, visible or not.

Collapse to Node Select this option to collapse the entire graph, then expand and set the focus to the
selected node.

Follow Max Allocations Select this option to expand an entire line in the graph.

Create Line Report for Select this option to launch the Profiler (if it is not already running), immediately

Function bind the selected function and ready it for recording. Once bound, an extra tab is
opened in the current Report View. This report will update instantaneously,
showing the number of times each line executed. Of course, the report will continue
to record activity in the function even if is not visible.

Note: In windowed programs, it is usually necessary to take some action in the
application to cause the function to be invoked.

Create Function Graph Select this option to create an additional tab, which shows the selected function in
isolation. For a Call Frequency Profile, this produces a graph showing all the lines
that led to this function being called (that is, the callers). For a Memory Profile, this
produces a graph showing all lines that emanate from this function (that is, the
callees).
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Display the Heaviest Select this option to display the line in the graph with the highest weight in which
Weighted Use this function appears.

Display the Next Weighted Select this option to navigate to the next line in the graph where the function
Use appears.

You can use the shortcut key combination Ctrl+Down Arrow.

Display the Previous Select this option to navigate to the previous line in the graph where this function
Weighted Use appears.

You can also use the shortcut key combination Ctrl+Up Arrow

Save Report to File Select this option to display the 'Save As' dialog, allowing you to choose where to
store the report.

Save Report to Artifact Note: Before selecting this option, go to the Project Browser and select the Package
or element under which to create the Artifact element.

You are prompted to provide a name for the report (and element); type this in and
click on the OK button.

The Artifact element is created in the Project Browser, underneath the selected
Package or element.

If you add the Artifact to a diagram as a simple link, when you double-click on the
element the report is re-opened.

Team Review Options

Option Description
Make Report a Team You can save any current report as a resource for a Category, Topic or Post in the
Review Resource Team Review to share and review at any time, as it is saved with the model. The

report can also be compared with future runs.

To begin this process, on the "Team Review context menu select the menu option
'Share Resource | Add Active Profiler Report'.

Notes

e Ifyou add the Profiler report to an Artifact element and also attach a linked document, the Profiler report takes
precedence and is displayed when you double-click on the element; you can display the linked document using the
'Edit Linked Document' context menu option
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Save Report in Team Review

You can save any current report as a resource for a Category, Topic or Document in the Team Review. The report can
then be shared and reviewed at any time as it is saved with the model. This helps you to:

e  Preserve a Profiler report to compare against future runs

e Allow other people to investigate the profile

Access

Context Menu Right-click in Team Review window | Share Resource | Active Profiler Report
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Recording
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Sequence diagrams are a superb aid to understanding behavior. Class Collaboration diagrams also can be helpful. In
addition to these, sometimes a Call Graph is just what we need. Then again, if you have this information available, you
could use it to document a Use Case, and why not build a Test domain while you are at it? The Enterprise Architect
Analyzer can generate all of these for you and from a single recording. It does this by recording a running program, and
it works on all of the most popular platforms.

Access

Ribbon Execute > Analyze > Recorder > Open Recorder

Overview

At its simplest, a Sequence Diagram can be produced in very few steps using even a brand new model. You do not even
have to configure an Analyzer Script. Open the Enterprise Architect code editor (Ctrl+Shift+0O), place a recording
marker in a function of your choice, and then attach the Enterprise Architect debugger to a program running that code.
Any time that function is called, its behavior will be captured to form a recording history. From this history these
diagrams can be easily created.
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Broker: Broker Exchange.Exchange Exchange.Stock: Exchange.Account:
Stock Account

T T T
. 1.0 Buy(1, 2, 100): : :
bool | o |
1.1 FindAccount(1): :
Account* |
1.2 FindStock(2): |
Stl.3 GetStockVolume(): o |
UINT ~0
1.4 GetStockCost(): - !
FLOAT >0

1.5 GetBalance(): -

INT | gl

1.6 Credit(2, 100, - -

L

Sequence diagram
generated in Enterprise
Architect using recording
marker in a Use Case

100)
1.7 GetSector():

ESector
1.8 UpdateSector(secEquities,

00)
1.9 GetSector(secEquities):
Sector*

»
>

1.10 Move
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Exchange.Sector

The Sequence diagram from the Example Model recording.

(o |

Broker ‘

BeginDaylint): void
EndDay(): int
Move(int): void.
Sector(ESector)

Broker()

~Broker()

GetNext(Exchange::TAccountlD): Exchange::Transaction™
Trade(Exchange::Exchange*): void

-m_exchSectors /

Exchange

Buy(TAccountiD, TtockiD, UINT): bool
Close(): void

Exchange(LPCTSTR)

~Exchange()

FindAccount(CString): Account*
FindStock(CString): Stock*
FreeAccounts(): void

FreeSectors|): void

FreeStocks(): void
GetAccount(TAccountID): Account*
GetSector(ESector): Sector*
GetStock(TtockID): Stock*

Open(): bool
RegisterAccount(Account*): TAccountiD|
RegisterStock(Stock®): TStockiD.
Sell(TAccountiD, TStockID, UINT): bool
Transmitstock(IStock*): TstockiD
UpdateSector(ESector, INT): void

I

5 &0 o

[

Stock

[ *, LPCTSTR, FLOAT, UINT, ESector): IStock*

GetName(): LPCTSTR

GetSector(): ESector

GetStockCost(): FLOAT

GetStockiD)): TStockiD
GetstockVolume(): UINT
Stock(LPCTSTR, FLOAT, UINT, ESector)

Account

Account(LPCTSTR, UINT)
o o*, |PCTSTR, UINT): |
Credit(TStockiD, UINT, INT): void
Credit(Stock*, UINT, INT): void
Debit(TStockID, UINT, INT): void
Debit(Stock*, UINT, INT): void
GetAccountlD): TAccountlD
GetBalance(): INT
GetName(): LPCTSTR
Register(|Exchange®): void

The Class Collaboration diagram from the same recording.

«testcut»
Buy Sector

«testset»
Buy Stock
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|
|
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|
|
|
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o
|
:
|
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|
|

+ GetAmount(): INT
+ GetStock(): TStockiD
+ Transaction(TAccountID, TstockiD, INT)

«testcut»
Buy Broker

«testcut»
Buy Stock

«testcut»
Buy Account

«testcut»
Buy Exchange
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The Test Domain diagram from the same recording.

Of course, an Analyzer Script is still the best idea, and opens up an incredibly rich development environment, but it is
worth noting that significant results can be obtained without one. This is also true of the Enterprise Architect Debugger
and Profiler tools.

A point of interest: you can view a thread's behavior while it is recorded. Showing the Call Stack during a recording will
show updates to a thread's stack in real-time, much like an animation. It is a good feedback tool and in some
circumstances it might be all that is required.

CE” Sta Ck P B S B e e e e B S B e o B ceE o B e o e S BB e B BB P e B b P R B Pk e
HE®R2" 1@
B Thread 4184
Eroker.exe! wmain, chea‘wea\projects\c++\stockexchange\brok
Eroker.exe! Trade, chea\wea\projectsc++'\stockexchange\broke
Broker.exe! GetMext, ciea\wea\projects\c++\stockexchangeibro
Broker.exe! CArray<Exchange Transaction *,Exchange. Transactio
Eroker.exe! CArray<Exchange Transaction *,Exchange. Transactio
g+ Broker.exe! CArray<ExchangeTransaction *,Exchange. Transactio

Features at a glance

Diagram Generation

e  Sequence diagram

e (Class Collaboration diagram
e  Test Domain diagram

e  State Transition capture

e Call Graph

Control

e  Support multi-threaded and single-threaded models

-
-

e  Support stack depth control 3

e  Support filters to restrict capture
e  Filter wildcard support

e  Real-time stack update
Integration

e (Class Model

e Test Domain

e  StateMachine

e  Executable StateMachines

o  Unit Tests
Platforms

e  Microsoft NET

e  Microsoft Native
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e Java

e PHP

e GDB

e  Android
Requirements

30 June, 2017

e Recording is available to users of all editions of Enterprise Architect except the Desktop edition

Notes

e The debug and record features of the Visual Execution Analyzer are not supported for the Java server platform

"Weblogic' from Oracle
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How it Works

This topic explains how the Visual Execution Analyzer generates Sequence diagrams.

Explanation
Points Detail
Usage The Visual Execution Analyzer enables you to generate a Sequence Diagram from
recordings of the live execution of an application. As the application runs, the
history of each thread is recorded. This history can be used to generate the
Sequence diagram.
This is a Sequence diagram generated from a program that calculates the price of
books:
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How does the recorder know what to record?
- The recorder works from recording markers. These are placed by you in the
functions of interest.
Call Stacks in Java can stretch further than the eye can see. How can we restrict the
recording to just ten frames?
- The recorder is controlled by the depth either set on the recorder toolbar or
associated with a Marker Set stored in the model.
Its the real thing In recording, the target application is not modified; no instrumentation of any
image or module occurs at all. A recording produced using a 'Release' build of a
program is as trustworthy a document as any of what a program did.
Where do you start We have a very large server application; so where do we start? If you have little or

no understanding of the program you intend to record and little or no model to
speak off, you might be best starting with the Profiler. Running the Profiler whilst
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using a program in a specific manner can quickly identify Use Cases from the entry
points and Call Graphs presented. Having that knowledge can enable you to focus
on areas that are uncovered and record those functions.

If you have the source code, all you need to do is place a recording marker in a
function that interests you. We recommend against placing multiple recording
markers in multiple functions at the same time. In practice this has shown to be less
helpful. Where do you place a recording marker? For windows UI programs, and in
relation to some business use case, you might start by placing one in the event
handlers for a message that seems most pertinent. If you are investigating a utility
function, just set a method recording marker at or somewhere near the start.

For services, daemons and batch processes you might want to profile the program
once for each behavior of interest and use the report to explore those areas

uncovered.

Tip It's a good idea to have a quick glance at the Breakpoints and Markers window
before debugging, and check that the markers listed here are what you are
expecting.

Scenarios e  Microsoft Native C and C++, VB

(Windows programs, Window Services, Console programs, COM servers, IS
ISAPI modules, Legacy)

e  Microsoft NET
(ASP.NET, Windows Presentation Foundation (WPF), Windows Forms,
Workflow Services, devices, emulators)

e Java
(Apps, Applets, Servlets, Beans)
e Android
(using Android debug bridge for devices and emulators)
e PHP
(Web site scripts)
e GDB

(Windows / Linux interopability)
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The Recording History

When the execution analysis of an application encounters user-defined recording markers, all information recorded is
held in the Record & Analyze window.

Access

Ribbon

Facilities

Facility

Information Display

Operations on Information

(c) Sparx Systems 2015 - 2017

Execute > Analyze > Recorder > Open Recorder

Information/Options

The columns in the Record & Analyze window are:

e Sequence - The unique sequence number

e Threads - The operating system thread ID

e Delta - The elapsed thread CPU time since the start of the sequence

e Method - There are two Method columns: the first shows the caller for a call or
for a current frame if a return; the second shows the function called or the
function it is returning to

e Direction - Stack Frame Movement, can be Call, Return, State, Breakpoint or
Escape (Escape is used internally when producing a Sequence diagram, to
mark the end of an iteration)

e Depth - The stack depth at the time of a call; used in the generation of
Sequence diagrams

e  State - The state between sequences

e Source - There are two Source columns: the first shows the source filename
and line number of the caller for a call or, if a return, for a current frame; the
second shows the source filename and line number of the function called or
function returning

e Instance - There are two Instance columns, which only have values when the
Sequence diagram produced contains State Transitions; the values consist of
two items separated by a comma - the first item is a unique number for the
instance of the Class that was captured, and the second is the actual instance of
the Class
For example: supposing a Class CName has an internal value of 4567 and the
program created two instances of that Class; the values might be:

-4567,1

-4567,2
The first entry shows the first instance of the Class and the second entry shows
the second instance

The Record & Analyze window toolbar provides a range of facilities for controlling
the recording of the execution of an Analyzer script.

You can perform a number of operations on the results of a recording, using the
Record & Analyze window context menu, once the recording is complete.
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Notes

e  The checkbox against each operation is used to control whether or not this call can be used to create a Sequence,
Test Domain Class or Collaborative Class diagram from this history

e In addition to enabling or disabling the call using the checkbox, you can use context menu options to enable or
disable an entire call, all calls to a given method, or all calls to a given Class
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Diagram Features

When you generate a Sequence diagram, it includes these features:

Features
Feature Detail

References When the Visual Execution Analyzer cannot match a function call to an operation
within the model, it still creates the Sequence but also creates a reference for any
Class that it cannot locate.
It does this for all languages.

Fragments Fragments displayed in the Sequence diagram represent loops or iterations of a
section(s) of code.
The Visual Execution Analyzer attempts to match function scope with method calls
to as accurately as possible represent the execution visually.

States If a StateMachine has been used during the recording process, any transitions in

State are presented after the method call that caused the transition to occur.

States are calculated on the return of every method to its caller.
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Setup for Recording

This section explains how to prepare to record execution of the application.

Steps

Step

Prerequisites - To set up the environment for recording Sequence diagrams you must:
e Have completed the basic setup for Build & Debug and created Execution Analysis scripts for the Package
e Be able to successfully debug the application

Narrow the focus of a recording by applying filters.

Control the detail of a recording by adjusting the stack depth.
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Control Stack Depth

When recording particularly high-level points in an application, the Stack Frame count can result in a lot of information
being collected; to achieve a quicker and clearer picture, it is better to limit the stack depth on the toolbar of either:

e The Breakpoint and Markers window or

e The Record & Analyze window

Access

Ribbon Execute > Analyze > Recorder > Open Recorder

Set the recording stack depth

You set the recording stack depth in the numerical field on the toolbar of the Breakpoints & Markers window or the
Record & Analyze window:

R

By default, the stack depth is set to three frames. The maximum depth that can be entered is 30 frames.

The depth is relative to the stack frame where a recording marker is encountered; so, when recording begins, if the stack
frame is 6 and the stack depth is set to 3, the Debugger records the frames 6 through 8.

For situations where the stack is very large, it is recommended that you first use a low stack depth of 2 or 3. From there
you can gradually increase the stack recording depth and insert additional recording markers to expand the picture until
all the necessary information is displayed.

(c) Sparx Systems 2015 - 2017 Page 150 of 214 Created with Enterprise Architect



User Guide - Visual Execution Analysis 30 June, 2017

Place Recording Markers

This section explains how to place recording markers, which enable you to silently record code execution between two
points. The recording can be used to generate a Sequence diagram.

As this process records the execution of multiple threads, it can be particularly useful in capturing event driven
sequences (such as mouse and timer events).

Access

Ribbon Execute > Windows > Breakpoints

Actions

Action

Different recording markers can be used for recording the execution flow; see the related links for information on
the properties and usage of these markers.

Manage breakpoints in the Breakpoint & Markers window.
Activate and deactivate markers.

Working with Marker Sets - when you create a breakpoint or marker, it is automatically added to a marker set, either
the Default set or a set that you create for a specific purpose.

Notes

e The Breakpoint and Marker Management topic (Software Engineering) describes a different perspective
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Set Record Markers

Markers are set in the source code editor. They are placed on a line of code; when that line of code executes, the
Execution Analyzer performs the recording action appropriate to the marker.

Access

Use one of the methods outlined here, to display the Code Editor window and load the source code associated with the
selected Class.

Ribbon Code > Source Code > Edit Code > Edit Element Source

Context Menu Right-click on element | Code Engineering | View Source Code

Right-click on operation | Code Engineering | View Source Code

Keyboard Shortcuts F12

Set a recording marker

Step Action

1 Open the source code to debug, in the integrated source code editor.
2 Find the appropriate code line and right-click in the left (Breakpoint) margin to bring up the
breakpoint/marker context menu; select the required marker type:
12 F‘a:ssengiars = GetRandom(@,288);
13 Number = number;
A Y P T LY
@® AddBreakpoint
©  Add Start Recording Marker tation(5tation);
@ 1~dd End Recording Marker
% Add Stack Auto Capture Marker
& Add Method Auto Record Marker
& Add Tracepoint Marker
Help
)
3 If a Start Recording Marker has been set, you must also set an End Recording Marker.
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Marker Types

Markers are really fantastic. Unusual by their very light footprint when used with care, their impact on the performance
of the programs being recorded can be neglible. Markers come in several flavors (well colors actually) and more are
always being added. They are placed and are visible in the left margin of the editor, so you will need to have some source
code.

Use to

e Record a single function

e Record parts of a function

e  Use Cases spanning multiple functions
e Record call stacks

e  Generate Sequence Diagram.

e  Generate Test Domain diagram

e Generate Class Collaboration Diagram

Reference
Marker Detail
Start / End Recording Place the markers at the start and ending lines of the code to record. These need not
markers be within the same function.
o 17 private int m delivery;
13 public ClassLibi(){
20
21 T
22
23 & &
24 =
25 #* @exception Throwable
2 E r =
] 27 public void finalize()

When the program encounters a start recording marker, a new recording is initiated
(the camera starts rolling!). When an end marker is encountered, the current
recording ends (it's a take). How you use these markers is up to you and your
knowledge of the system under your care.

Advanced Stuff (nested markers):

If a Start recording marker is encountered while a recording is in progress but
where capture is inhibited by the Stack depth value in use, a separate recording will
be initiated. Each recording is kept on a stack. When one ends, it is removed. This
technique can be used in Enterprise Architect to record and render scenes in very
complex systems. It is rather like splicing short scenes from a video to create a
trailer. If you only want to record a single function, you should use an Auto record
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marker.
Method Auto Record A Method Auto Record marker enables you to record a particular function. The
marker debugger will automatically end the recording when the function completes. This is

good because recording is an intensive operation.

The function marker combines a Start Recording marker and an End Recording
marker in one, so recording is executed after the marker point, and always stops
when this function exits.
185 i
186

a
-1

BOOL CRecurrenceDlg::0OnInitDialog()
BHi{

[STT- T

L

CBCGPDialog: :OnInitDialog()

UINT nMask =
CECGPDateTimeCrrl: :DTM SPIN |
CECGPDateTimeCrrl: :DTM DATE |
CECGPDateTimeCtrl: :DTM TIME |
|
]

CECGPDateTimeCtrl: :DTM CHECKBOX
CBCGPDateTimeCtrl: :DTM DROPCALENDRR
CBCGPDateTimeCtrl::DTH_CHECKED;

[ el e
oo s W R

oW om

UINT nFlags = CBCGPDateTimeCtrl::DTM CHECKED | CECGPDateTimeCtrl::DI

[ T T R Ve T BT R e R T= R T B T B Ve BT B e e R e

RSOR3 RD B

ff Betup date fields:

[

Recording markers can be nested. When a new Method Auto Record marker is hit
while recording, the stack depth to record to will be extended to include the current
method and the required depth from that function.

SHkaAuKyCapnuennuker T6 J% End - ER generated code for Parts and Ports */
T7 /% Begin - EL generated code for Activities and I
& T8 public wvoid ClassLib ActivityGraphWithfctionPin()
79 {

Stack markers enable you to capture any unique stack traces that occur at a point in
an application; they provide a quick and useful picture of where a point in an
application is being called from.

To insert a marker at the required point in code, right-click on the line and select
the 'Add Stack Auto Capture Marker' option.

Each time the debugger encounters the marker it performs a stack trace; if the stack
trace is not in the recording history, it is copied, and the application continues

running.
Limiting the recording You can limit the depth of frames in any recording using the stack depth control on
depth either the recorder and breakpoints toolbars.
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The Breakpoints & Markers Window

Using the Breakpoints & Markers window, you can apply control to Visual Execution Analysis when recording
execution to generate Sequence diagrams; for example, you can:

e Enable, disable and delete markers
e  Manage markers as sets

e Organize how markers are displayed, either in list view or grouped by file or Class

Access

Ribbon Execute > Windows > Breakpoints
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Working with Marker Sets

Marker sets enable you to create markers as a named group, which you can reapply to a code file for specific purposes.

You can perform certain operations from the Breakpoints & Markers window alone, but to understand and use markers
and marker sets you should also display the appropriate code file in the 'Source Code Viewer' (click on the Class element
and press F12).

Access

Ribbon 3

Execute > Windows > Breakpoints : —  toolbar icon

Using Marker Sets

Action Details

Example of Use You might create a set of Method Auto Record markers to record the action of
various functions in the code, and a set of Stack Capture markers to record the
sequence of calls that cause those functions to be called.

You could then create Sequence diagrams from the recordings under each set.

Create a Marker Set To create a marker set from the Breakpoints & Markers window, click on the
I_i -

drop-down arrow on the icon and select the New Set' option.

The 'New Breakpoint Marker Set' dialog displays; in the 'Enter New Set Name'
field, type a name for the set, and click on the Save button.

The set name displays in the text field to the left of the 'Set Options' icon.
Alternatively, you can either:
e Create a Class Activity marker set or

e Select the 'Save as Set' option from the 'Set Options' drop-down, to make an
exact copy of the currently-selected set, which you can then edit

Accessing Sets To access a marker set, click on the drop-down arrow on the text field to the left of
the 'Set Options' icon, and select the required set from the list.

The markers in the set are listed in the Breakpoints & Markers window.

You would normally load a marker set prior to the point at which an action is to be
captured.

For example, to record a sequence involving a particular dialog, when you begin
debugging you would load the set prior to invoking the dialog; once you bring up
the dialog in the application, the operations you have marked are recorded.

Add Markers to Set To add markers to a marker set, add each required marker to the appropriate line of
code in the 'Source Code Viewer'.

The marker is immediately added to whichever set is currently listed in the
Breakpoints & Markers window.

Each marker listed on the dialog has a checkbox in the 'Enabled' column;
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newly-added markers are automatically enabled, but you can disable and re-enable
the markers quickly as you check the code.

Storage of Sets When you create a marker set it is immediately saved within the model; any user
using the model has access to that set.

However, the Default set, which always exists for a model, is a personal workspace,
is not shared and is stored external to the model.

Delete a Marker from a Set Right-click on the marker and select the 'Delete Breakpoint' option.

Delete a Set If you no longer require a marker set, access it on the Breakpoints & Markers
window and select the 'Delete Selected Set' option from the 'Set Options'
drop-down list.

You can also clear all user-defined marker sets by selecting the 'Delete all sets'
option; a prompt displays to confirm the deletion.

Notes

e  Marker Sets are very simple and flexible but, as they are available for use by any user of the model, they can be
easily corrupted; consider these guidelines:
- When naming a set, use your initials in the name and try to indicate its use, so that other model users can
recognize its owner
and purpose
- When using a set other than Default, avoid excessive experimentation so that you don't add lots of ad-hoc
markers to the set
- Make sure you are aware of which marker set is exposed in the Breakpoints & Markers window, as you can
easily inadvertently add
markers to the set that are not relevant to the code file the set was created for
- In any set, if you have added markers that don't have to be kept, delete them to maintain the purpose of the set;
this is especially
true of the Default set, which can quickly accumulate redundant ad-hoc markers
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Recording Activity For a Class

In addition to setting breakpoints and markers in the code editor, or creating a marker set through the Breakpoints and
Markers window, you can record all the operations of a Class or a subset using the 'Class Markup Selection' dialog to
create a marker set of record markers for those operations. These marker sets are also available to all users of the model.
Note when you do this, the debugger takes no notice of the filename or line of code. This information is obtained by the
debugger at runtime. So you will see these types of markers in the Breakpoint window as fully qualified method names
rather than file paths. This makes these markers tolerant to code changes unlike normal breakpoints which can shift all
over the place as code is edited.

Access

Context Menu In Project Browser, right-click on Class | Execution Analyzer | Markup Class For

Recording
Reference
Field Action

Existing marker set Select to change the operations, marker types or stack depth of an existing marker
set.

New marker set Select to create a new marker set.

Name Type the name of the marker set to create or edit.

Operation check boxes All checkboxes default to selected; click on the checkbox against each operation
that you do not want to record.

Click again on the checkbox against any excluded operation that you do now want
to record, to re-select it.

Include disabled operations Select this option to set a recording marker against all operations, but disable all
those that you have not specifically selected above. In the Breakpoints & Markers
window, you can then enable these markers individually or as a whole, rather than
enabling them by editing the marker set.

Marker Type Click on the drop-down arrow and select the type of marker to set against each of

the selected operations.

The marker type specifies the action to take when the process encounters that
marker on each operation:

e Record function

e Record stack trace
e Break execution

e Actionpoint

e Tracepoint
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Limit recording frame For recording markers, sets the stack depth to limit recording. The recording depth
depth ensures the maximum depth of any recording to be the current depth at time marker
encountered plus this value.

OK Click to store the marker set under the name you have specified; the set can then be
loaded either before or during a session, from the Breakpoint & Markers window
toolbar.
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Control the Recording Session

The Record & Analyze window enables you to control a recording session. The control has a toolbar, and a history
window that displays the recording history as it is captured. Each entry in this window represents a call sequence made
up of one or more function calls.

Access
Open the Record & Analyze window using one of the methods outlined here.
You must also open the Execution Analyzer window ('Execute > Analyze | Analyzer Scripts'), which lists all the scripts

in the model; you must select and activate the appropriate script for the recording.

Ribbon Execute > Windows > Recorder > Open Recorder
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Recorder Toolbar

You can access facilities for starting, stopping and moderating an execution analysis recording session through the
Record & Analyze window toolbar.

Access
Ribbon Execute > Windows > Recorder > Open Recorder > Toolbar
Buttons
Button Description

[ = Display a menu of options for defining what the recording session operates on.

e 'Attach to Process' - enabled even if no Analyzer Script exists, this option
displays a dialog through which you select a process to record and a debugging
platform to use; you can also optionally select a record marker set and/or a
StateMachine to use during the recording

e 'Generate Sequence Diagram from Recording' - generate a Sequence/State
diagram from the Execution Analyzer trace

e 'Generate Testpoint Diagram from History' - generate a Test Domain diagram
from the Execution Analyzer trace, that can be used with the Testpoint facility

e 'Generate Class Diagram from History' - generate a Collaboration Class
diagram from the Execution Analyzer trace, depicting only those Classes and
operations involved in the recorded action (use case)

e 'Generate Call Graph from History' - generate a dynamic call graph from the
recording history, as you might see in the VEA Profile workspace execution
analysis layout; this can be more useful than the Sequence diagram in
identifying the unique call stacks involved

e 'Generate All' - generate the Sequence, Testpoint and Collaboration Class
diagrams together from the Execution Analyzer trace

e 'Save as Artifact' - create an Artifact element that contains the current
recording history, under the currently-selected Package in the Project Browser;
if you subsequently drag this Artifact element onto a Class diagram and
double-click on it, the history recorded in the Artifact is copied back into the
Record & Analyze window

e 'Load Sequence History from file' - select an XML file from which to restore a
previously-saved recording history

e 'Save Sequence History to file' - save the recording history to an XML file

7 - Select the recording stack depth for the marker set; that is, the number of frames
from the point at which recording began.

8 Launch and record the application described in the script; you can optionally select

a record marker set and/or a StateMachine to use during the recording.

The icon is enabled when the active Analyzer Script is configured for debugging.
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= Perform ad-hoc manual recording of the current thread during a debug session.
Use this function with the 'step' buttons of the debugger; each function that is called
due to a step command is logged to the history window.

The icon is enabled if no recording is taking place and you are currently at a
breakpoint (that is, debugging).

| Perform ad-hoc auto-recording during a debug session.

When you click on this icon, the Analyzer begins recording and does not stop until
either the program ends, you stop the debugger or you click on the Stop icon.

This icon is enabled if no recording is taking place and you are currently at a
breakpoint (that is, debugging).

Step into a function, record the function call in the History window, and step back
out.

Enabled for manual recording only.

Stop recording the execution trace.

3 Display the 'Synchronize Model' dialog through which you can synchronize the
= model with the code files generated during a Record Profile operation.
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Working With Recording History

You can perform a number of operations on or from the results of a recording session, using the Record & Analyze

window context menu.

Options

Option

Show Source for Caller

Show Source for Callee

Generate Diagram for
Selected Sequence

Generate Sequence
Diagram

Clear
Save Recording History to

File

Load Recording History
From File

Disable All Calls
Disable This Call
Disable This Method
Disable This Class

Disable All Calls Outside
This Call

Enable All Calls
Enable This Call
Enable This Method

Enable This Class
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Action

Display the source code, in the Source Code Viewer, for the method calling the
sequence.

Display the source code, in the Source Code Viewer, for the method being called by

the sequence.

Generate a Sequence diagram for a single sequence selected in the recording
history.

Generate a Sequence diagram including all sequences in the recording history.

Clear the recording history currently displayed in the Record & Analyze window.
Save the recording history to an XML file.

A browser window displays, on which you specify the file path and name for the
XML file.

Load a previously saved recording history from an XML file.

A browser window displays, on which you specify the file path and name for the
XML file to load.

Disable every call listed in the Record & Analyze window.

Disable the selected call.

Disable the selected method.

Disable the selected Class.

Disable every call listed in the Record & Analyze window except for the selected
call.

Enable every call listed in the Record & Analyze window.
Enable the selected call.
Enable the selected method.

Enable the selected Class.
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Help Display the Help topic for the Record & Analyze window.
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Start Recording

When you are recording execution flow as a Sequence diagram, you start the recording by selecting the 'Recording' icon
on the Record & Analyze window toolbar. The 'Record' dialog displays with the recording options set to the defaults;
that is, the current Breakpoint and Markers Set, the filters defined in the current Analyzer Script and the recording mode
as basic.

Access

Ribbon
Execute > Windows > Recorder > Open Recorder :

Record Dialog Options

Field/Button Detail

Recording Set Recording markers determine what is recorded.

If you have a recording set to use, click on the drop-down arrow and select it.

Additional Filters Filters are used by the debugger to exclude matching function calls from the
recording history. Recording filters are defined in the Analyzer Script.

In the 'Additional Filters' field you can add other filters for this specific run. if you
specify more than one filter, separate them with a semi-colon.

Basic Recording Mode In basic mode the debugger records a history of the function calls made by the
program whenever it encounters an appropriate recording marker.

Track Instances of Named In Track Instances mode the debugger also captures the creation of instances of the

Classes Classes you specify. It then includes that information in the history. The resulting
Sequence diagram can then show lifelines for each instance of that Class with,
where appropriate, function calls linked to the lifeline.

Track State Transitions The recording can also capture changes in State using a specified StateMachine
diagram. The StateMachine diagram must exist as a child of a Class.
The Execution Analyzer captures instances of that Class and calculates the State of

each instance whenever a function in the current recording sequence returns.

OK Click on this button to start the debugger.
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Step Through Function Calls

The 'Step Through' command can be executed by clicking on the Step Through button on the Record & Analyze window
toolbar.

Alternatively, press Shift+F6 or select the 'Execute > Run > Step In' ribbon option.

The 'Step Through' command causes a 'Step Into' command to be executed; if any function is detected, then that function
call is recorded in the History window.

The debugger then steps out, and the process can be repeated.

This button enables you to record a call without having to actually step into a function; the button is only enabled when
at a breakpoint and in manual recording mode.
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Nested Recording Markers

When a recording marker is first encountered, recording starts at the current stack frame and continues until the frame
pops, recording additional frames up to the depth defined on the Recording toolbar. Consider this call sequence:

A>B>C>D->E>F>G->H->]>]J]>K->L>M->N->0->P>Q->R->S>T>U->V->W->X
>Y>7Z

If you set a recording marker at K and set the recording depth to 3, this would record the call sequence:
K->L->M

If you also wanted to record the calls X, Y and Z as part of the Sequence diagram, you would place another recording
marker at X and the analyzer would record:

K>L>M->X->Y->Z

However, when recording ends for the X-Y-Z component (frame X is popped), recording will resume when frame M of
the K-L-M sequence is re-entered. Using this technique can help where information from the recorded diagram would be
excluded due to the stack depth, and it lets you focus on the particular areas to be captured.
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Generating Sequence Diagrams

This topic describes what you might do with the recording of an execution analysis session.

Access

Ribbon

Reference

Action

Generate a diagram

Save a recorded sequence
to an XML file

Access an existing
sequence XML file

Use to

Execute > Analyze > Recorder > Open Recorder

Detail

Select the appropriate Package in the Project Browser, in which to store the
Sequence diagram.

To create the diagram from all recorded sequences, either:

e  C(Click on the 'Recorder Menu' icon ( T ) in the Record & Analyze window
toolbar, and select the 'Generate Sequence Diagram from Recording' option, or

e Right-click on the body of the window and select the 'Generate Sequence
Diagram' option

To create the diagram from a single sequence, either:

e  (lick on the 'Recorder Menu' icon ( T ) in the Record & Analyze window
toolbar, and select the 'Generate Sequence Diagram from Recording' option, or

e Right-click on the sequence and select the 'Generate Diagram from Selected
Sequence' option

Click on the sequence, click on the 'Recorder Menu' icon ( B ) in the Record &
Analyze window toolbar, and select the 'Save Sequence History to File' option.

Either:

e (Click on the k. in the Record & Analyze window toolbar, and select the
'Load Sequence History from File' option, or

e Right-click on a blank area of the screen and click on the 'Load Sequence From
File' option

The 'Windows Open' dialog displays, from which you select the file to open.

e  Generate a Sequence diagram from a recorded execution analysis session, for:

e all recorded sequences or
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e asingle sequence in the session
e Save the recorded sequence to file

e Retrieve the saved recording and load it into the Record & Analyze window
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Reporting State Transitions

This section describes how you can generate Sequence diagrams that show transitions in state as a program executes.

Use to

e  Generate Sequence diagrams that report user-defined transitions in state as a program executes (as shown in the
example generated diagram)

Topic

Create a StateMachine under the Class to be reported.

Set the constraints against each State to define the change in state to be reported.
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Reporting a StateMachine

The Execution Analyzer can record a Sequence diagram, we know that. What you might not know is that it can use a
StateMachine at the same time to detect State transitions that might occur along the way. These States are represented at
the point in time on the lifeline of the object. The transitions also are apparent from the lifelines. Any invalid or illegal
transition will be highlighted with a red border. Have a look.

Process

Firstly you model a StateMachine for the appropriate Class element.
You then compose the expressions that define each State using the 'Constraints' tab of each State.

These simple expressions are formed using attribute names from Class model and actual code base. They are not OCL
statements. Each expression should appear on a separate line.

m_strColour == "Blue"
You then use the Recorder window to launch the debugger.
The Recorder window Run button is different from the button on other debugger toolbars.

The Recorder window will allow you to browse for a StateMachine if you do not know the StateMachine name. The
'State Transition' dialog presents a list of StateMachines for the entire model, in which you locate and select the
appropriate diagram (see the example).

When you generate the Sequence diagram, it depicts not only the sequence but changes in State at the various points in
the sequence; each Class instance participating in the detection process is displayed with its own lifeline.

Example

The Stations StateMachine shows the different States within the Melbourne Underground Loop subway system.
A train traveling on the subway network can be stopped at any of the stations represented on the StateMachine.

The Stations StateMachine is a child of the CTrain Class.

( Parliament w r Treasury *

constraints constraints
{Location=0} {Location=0}
Departing. Mame=FParliament] Departing. Name=T reasury;

= [E] Subway
5 [ Subway
- 72 Subway
+ zenumerations <anonymot
= CXTrain
¥4 DoDataExchange(CDataE
@ Stations
. [E3] Stations
- @ Central
- @ Flinders
constraints constraints ‘ .. (I Lonsdale

{Location=0} {Location=0} .- (@ Parliament
Departing. Name=Lonsdale] Departing Mame=5pencer @ Spencer

Central Flinders

constraints
{Location=0}
Departing. Name=Flinders]

constraints
{Location=0}
Departing. Mame=Central

Lonsdale

Spencer

- (@ Treasury
+ [l Stations
= CControlPanel
+ B Clock

When you browse for the diagram in the 'State Transition Recorder' dialog, the hierarchy shows only the root Package,
parent Class and child SubMachine and diagram; no other model components are listed.
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P

5 | State Transition Recorder 3|

[[] C++.Software.Implementation Model. Systems Engine «
= 10
- @ SearchExternalMedia
b %g SearchExternalMedia
[ Java.Software. Implementation Model, Systems Engine
= 10
- @ SearchExternalMedia
b %g SearchExternalMedia
D VBMet. Software. Implementation Model. Systems Engir
= 10
- @ SearchExternalMedia
b %g SearchExternalMedia
[ Source.C++Mative,Execution Analysis

EI CTrain =
- @ Stations
-3 E =
< | Il | b

Record state transitions for Stations

I Select ” Cancel ” Help ]
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Recording and Mapping State Changes

This topic discusses how to set constraints against each State in the StateMachine under a Class, to define the change in
state to be recorded.

Example

This example of a 'State Properties' dialog is for the State called Parliament; the 'Constraints' tab is open to show how the
State is linked to the Class CXTrain.

A State can be defined by a single constraint or by many; in the example, the State Parliament has two constraints:

Defined Constraints Sav

41}
il
@
m
i

Constraint Type Status
Location=0 Invarart Approved
Departing. Mame=Padiament Invarart Approved

The values of constraints can only be compared for elemental, enum and string types

The CXTrain Class has a member called Location of type int, and a member called Departing.Name of type CString;
what this constraint means is that this State is evaluated to True when:

e an instance of the CXTrain Class exists and
e its member variable Location has the value 0 and

the member variable Departing.Name has the value Parliament

Operators in Constraints

There are two types of operators you can use on constraints to define a State:
e Logical operators AND and OR can be used to combine constraints
e Equivalence operators {= and !=} can be used to define the conditions of a constraint

All the constraints for a State are subject to an AND operation unless otherwise specified; you can use the OR operation
on them instead, so you could rewrite the constraints in the example as:

Location=0 OR
Location=1 AND
Departing.Name!=Central
Here are some examples of using the equivalence operators:
Departing.Name!=Central AND

Location!=1

Notes

e Quotes around strings are optional; the comparison for strings is always case-sensitive in determining the truth of a
constraint
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Synchronization

The recording produces a number of assets, the recording history being the main one. Recording also identifies a set of
source code files. This set can be used to produce Class and Test Domain diagrams, but can also be used to synchronize
your model.

A synchronized model provides quick and accurate navigation between diagram elements and the Class model.

Access
Ribbon =
Execute > Analyze > Recorder > Open Recorder > Toolbar ﬂ% button
Context Menu Right-click on the Record & Analyze window | Synchronize Model with Source
Code

Synchronize Model

' ™
oo e

Synchronize Package from selected source code files below:

Package; |Source — Select

Files Action
C#

cea'wea'microsoft net'\delegatesdelegates 1%bookstore cs Synch

{

Select Al | | Select None |

Field/Button Action

Package Click on the Select button and select the target Package into which to
reverse-engineer the code files.

Files/Action Lists the files identified during one or more recording(s). The appropriate action is
listed next to each file.

Select All Click on this button to select the checkbox against every file in the 'Files' list.
Select None Click on this button to clear the checkbox against every file in the 'Files' list.
OK Click on this button to start the operation. The progress of the synchronization will
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be displayed.

Cancel Click on this button to abort synchronization and close the dialog.
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Testpoints

Testpoints present a scheme by which constraints and rules governing the behavior of objects can be taken from the
model and applied to one or more applications. The advantages schemes such as this offer are tolerance to code changes -
adding and subtracting lines from a function has no effect on the constraints that govern it. Another advantage is that
changes to the behavioral rules do not require a corresponding change to any source code; meaning nothing has to be
re-compiled!

Also, the ability to verify multiple applications using a single test domain is a simple rather than onerous matter. The
Test Domain is a both a logical and relational model; constraints in the Class model can be partitioned with Test Cuts.
These can be aggregated simply into Test Sets and Test Suites using connectors. Due to the decoupling of the Test
Domain from the codebase, it is a simple choice of buttons to run a program normally, or run it for a specific Test
Domain. This system also delivers practical benefits in that no instrumentation is required at all. Test results are
displayed in the report window during the run, in real-time, as the program runs. These results can be retained, and
reviewed at any time in the Test management window Alt+3 or using EA's documentation features.
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SRR NN R R RIS stort poge B srokercpp S Trades 33 Echange [ NIED Bl Acountcpp Bl Accountn PR estsuteradestoad| pow J = B -H@ «

(] Use case model N e EED RN I e 15 Id Constraints Status  Evals  Passes  Fals  LastRunBy  LastRunix
& [ Test domain model | @ @ Trade Stock 850 850 ~
& Testpoints & [ Account J 2 2
= [ Bchange cinterface = Invariant 182 0
22 Trades iExchange ¢ (m_acctiD>0) OR (m_pExchange==n 3 182 8 smeagher  2015-09-31
e by + Buy(TACCountD, TStockD, UNT): bool & =4 void Credit(TStockiD, UINT, INT) @ 3 N
e esteet Buy Stock + Cose(): vod & [ Pre-Condition 3 E
29 Buy i e e  (id>> 0) AND (amount > 0) 5 u u smeagher 20150030
uy Stod o + DeregsterStock(TStockD): boo !
e | e = B X
wdesteuts Buy Accoun + GefStock(TStockD): Stock™ & [ Post-Condition u 3
1 wtesteuts Buy Broker ~ Credt(TStockD, UNT,INT): void + GetStockVolume(): UNT  pStocke>null e u 3 smeagher  2015-09-3
[ «testeuts Buy Bxchange = Debi(TStockD, UNT, NT): void + Opend): bool &
= GethccountD(): TAccountD + RegisterAccount(Account): TACeountD N
[ stesteuts Buy Sector = GetBalance(): NT + RegisterStock(Stock®): TStockD - 36 35
[ testcuts Buy Stock - _Gelllame(): LPGTSTR +_ SelTAGcountD, TStockD, UINT): bool 2 (amount>0) 10 36 36 smeagher  2015-09-31
£ <testeuts TestCutt A\ JA = = void Debit(Stock’, UINT, INT) oy 3 36
@ etestsctn Exchange Buy i i & [ Post-Condition 3% 3%
o & s 0 B 4 pStocke>null 9 ) 3% smeagher 20150931
H H = & Stock 7 526 526
@ etestset Sel Stock | | o
H H 8 Invariant 316 36
92 SellStock
Account T & m_stiSector <> 1 316 36 smeagher  2015-09-3!
£ testeuts Sll Account — - = o ° J o o
£ st Sell roker " e Taceouto T M ecehAceounis2 TAcomumile & @ Pre Condtion noow
esteuts - e - < 1= 08
[ «testcuts Sell Sector - m_acctilame: CString - m_exchame: CStrin @ m_stkSector = "secC TS BT A 2015-08-3(
B <testeuts Sell Stock - m_pxchange: Exchange® - m_exchSeetors: Sector' (secCount) = ¢ FLOAT GetStockCost])
[ ctesteuts Sell Exchange R, UNT) octs [Siociel =) vt:uec , rsion
ctestsuites TestSuitel @ m_stknitCost > -09-31
@ + Creste(Exchange*, LPCTSTR, UNT): ccount: UINT GetStockVolume [z e Condtin
@ testsuites Trade Stock Tovoid == 0
N e & [ Pre-Condition
® hange_Exchange S Condition
st f” Behenge fchange. el N @ m_stkolume > 0 & m_acctBalance 2015-09-3
I Sockichangez SellStock & & Broker o XTI pcionon Fai: | ¢ contrue -
i Workbench = =0 void Trade(Exchange:Exchal @ m_acctName
& [ Pre-Condition Evalsate || @ m_pExchange .
Vihen 5
£o|ds s [HOF AHA|O@ ~
& & Spantystems.Software Enginesring Stock Exchi Gold Resources unit costis $23.51 Lev:  Faionly -
7§ Stock Exchange Debuga86./S2008 Socktachangebxchange AccountCredt |
P ttemert:
§ Stock Bxchange DebugaB6S2010 y Credit: purchased 132 of stock "Gold Ret
§ Stock Exchange. Debugx64.V52012 L Credit: cost $-3036
§2 Stock Exchange Debug 5452010 7 X
— Total Test Count: 10 ok = Help
S Total Passes: 10
Total Failures: 0
Total Invalid constraints: 0
Total Test Points encountered in un: 10
Total Test Points not encountered in run: 0
Total Test Points evaluated by Analyzer: 850
PRSP 5 Ececution analyzer z System | Seril ), Testpoints < >
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Features

Feature Details

Testpoint Composition Testpoint composition is performed using the Testpoint Window. The Testpoint
Window is context-sensitive and displays the Test Domain for the selected element
in either the Project Browser or diagram. Selecting a single Class will display the
Class structure. A 'pencil' icon is displayed against Classes and methods that have
existing constraints.

When you select a Test Cut, Set or Suite Test, the Testpoint window displays the
entire Domain structure including all the Classes that make up the domain. Note:
You can navigate the domain hierarchy using the Navigation' pane on the right.
Testpoints are composed as expressions using the variable names of the Class
members. The intelli-sense shortcut Ctrl+Space is available within the editor to
help you find these. Expressions that evaluate to True are taken to mean a pass.
Returning False is taken to mean a fail.
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Testpoint Trace Statements

Test Domain Composition

(c) Sparx Systems 2015 - 2017

Testpoints

Tests:Stock [ | p/ - H

Tests Id | Constrai..  Evals Passes Fa Parent Collections:
2 & Stock i 538 538 - ] Exchange Stock
= [ Invariant 316 316 ] Buy Stock
@ m_stkSector <= "" 1 316 316 [ Sell Stock
= =% |Stock™ Create(lExchange™, LPCTSTR, F ] p/ 12 12
= [z Pre-Condition 12 12
@ (pExchange=>null) AND (stock 4 12 12
& LPCTSTR GetMName()
= =4 ESector GetSector() ] p/ 70 70
= [z Pre-Condition 70 70
@ m_stkSector |= "secCount” 5 70 70
[= =4 FLOAT GetStockCost() @ ;7 70 70
= a Pre-Condition 70 70
w m_stkUnitCost > 0 2 70 70
4 TStocklD GetStocklD()
= =4 UINT GetStockVolume() o 70 70
3] Pre-Condition 70 70

& void SetStockID(T5tockiD)

You can add or edit an existing Invariant by double-clicking the Class.

You can add or edit an existing pre- or post-condition similarly by double-clicking
the method.

Double-clicking a Testpoint will automatically display the source code if it is
available.

Line conditions are best added from within the code editor using its shortcut menus.

This image is of a pre-condition in the above Test domain.

pf Testpoint Editor: : Exchange.Stock:nGetStockVolume() 4
Constraint
Type: Pre-Condition -
Condition: m_stkVolume ==10

Action on Fail: & EBreak execution -

Evaluate
When:

Trace

Level: Fail Only =

Statement: | Stock volume: @m_stkVolume is not allowed to be negative

oK Cancel || Hebp

Each Testpoint can have its own Trace statement. The Trace statement is a dynamic
message that can reference variables in its object or local scope. They are output
during the evaluation of a test. They can be configured to be output every time a
constraint is evaluated, or more usually when a test has failed. Trace statements can
be directed to the 'Testpoints' tab of the System Output Window, or to an external
file. You can configure this in any Analyzer Script.

The Test Domain diagram is a dynamic medium where Testpoints are assembled to
test Use Cases. Use Cases in a Test Domain diagram are provided in three different
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stereotypes: Test Cut, Test Set and Test Suite. Management of the domain is as
easy as modeling on any diagram. The toolbox and shortcut menus provide access
to any Test Domain Artifacts. In brief, Testpoints from multiple Classes are
aggregated into Test Sets. Test Sets are then linked to form Test Suites. Both Test
Cuts and Test Sets are re-usable assets. Linking the same Test Set to the one or
more Test Suites is a matter of drawing connectors.

«testset»
Sell Stock

«testcut» «testcut» «testcut»
Sell Account Sell Broker Sell Stock

Broker
Test Domain and the Class Rarely would a Use Case involve all the methods of a single Class. Most likely it is
Model realized using a variety of methods from collaborating Classes. We call this subset

of methods a cut and the Test Cut Artifact is the tool we use to make these cuts. The
Testpoint Window will adapt depending on the context, be that a Test Domain or
Class element. This image shows the Testpoint window when a Test Cut has been
selected. Note the checkboxes. These are only visible for a Test Cut. They denote
the methods (Test Cut) which are contributing to a Test Set. In this example the
Test domain was generated by the Execution Analyzer, which did the method
identification work for us.

TestCut:AddCustomer d V'J O F-~-H @
Tests ld  Constraints  Parent Collections:

= [ AddCustomerTC2 @ AddCustomer
= & Customer
g int AddMew()
¢ int GetAddress(string)
4 int GetlD()
4 string GetMame(string)

&

OoQoo-

Testpoint Evaluation The Testpoint window is used to evaluate Test domains. The window has a toolbar
for starting or attaching to the target application. The domain to test is always
reflected by the element that has context, so if you select a Class the window will
show only the Class structure and Testpoints of that Class. If you select a Test
Suite, the window will display the entire domain hierarchy and all the Testpoints
included in it. Clicking on the Run button will load the Testpoint domain in the
Execution Analyzer, which will then evaluate, collect and update the report window
as Use Cases pass or fail each test. The exact details of each constraint type and the
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when and how of that constraint's capture are:

e A Class Invariant is evaluated by the Analyzer whenever any method called on
an object of this Class type is completed; the invariant serves to test that the
state of a complying object is both known and permitted

e  Pre-conditions are evaluated immediately before an operation is called

e Post-conditions are evaluated (at the same time as a Class invariant) when the
method is completed

e Line-conditions are evaluated if and when their specific line of code comes into
scope during program execution
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Test Domain Diagram

The Test Domain diagram is the medium where you assemble and group test cases for a particular domain. An example
of a Test domain might be 'Customer'. The breadth and depth of the domains you assemble is up to you. You might have
separate domains for 'Add Customer' and 'Delete Customer', depending entirely on how you consider best to balance the
domain hierarchy. The diagram toolbox and shortcut menu provide a number of Artifacts to help model the domain.
Because the medium is dynamic, allowing you to revisit and build on relationships between Test domains, the system is a
great model for delivering reusable assets to a organization that are low overhead and integrate with both the UML view
of the world, and the Software Engineering nuts and bolts of daily life.

Facilities
Facility Details
Test Domain Generation If you think the process of composing a Test Domain is complex, it can be, but help

is at hand! The Execution Analyzer can produce a Test Domain diagram for you. It
cannot write the Tests for you, but it can do some of the leg work. It can identify
the Classes and pick out only those methods that participated in a Use Case. And
this is not guesswork. The Analyzer Test Domain is obtained from a running
program. This image shows the Test Domain generated by the Execution Analyzer
from recording an Example Model program.

«testset»

Buy Stock

P NN
v / | \ N
Ve // : \\ N N
7
e / | \ AN
yid / | \ N
s / | \ N
) / | \ N
s / | \ AN
P Ve // : \\ N N
e / | \ AN
P / I \ N
Y / | \ N
V4 4 v N N\

«testcut» «testcut» «testcut» «testcut» «testcut»
Buy Sector Buy Broker Buy Stock Buy Account.

And this is the recording itself (as a Sequence diagram) from which the Test
Domain was generated.
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The first task on a Test domain diagram is to create the Use Cases (Test Sets).
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These define this particular domain's responsibility. The Diagram Toolbox and
shortcut menu provide Artifacts to help you achieve this. The first of these is the
Test Cut and this is used in the next step; identifying those methods (from the class
model) that you consider to be participants in the Use Case. The Test Cut Artifact is
useful because its allows us to partition a Class, selecting only those methods which
are relevant. Test Cuts can be run individually or link to one or more Test Sets. Test
Sets in turn can be linked to one or more Test Suites. In any case, any element of
the Test domain tree can be run individually or as a whole.

«testset»
Buy Stock

from Bu
«testsuite» (f y)

Trade Stock

«testset»

Sell Stock

(from Sell)
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Test Cut

atestocuts
TestCutd

Description

A Test Cut element is a stereotyped Object element, used internal to Enterprise Architect for defining test sets using the
Testpoint code testing facilities.

A task, such as 'Print', might involve operations on different Classes. In order to create a Print' test, you would want to
include only the Print' operations of these Classes and exclude any other operations.

A Test Cut enables you to capture only the operations that represent the behavior (in this case, 'Print') defined for a single
Class. You might then place the Test Cut from each of several Classes into a single task as a Test Set.

When you drag a Test Cut element onto a Test Domain diagram, you create a Dependency relationship with the required
Class element. As a result, when you select the Test Cut element on the Testpoints Window, the operations of the Class
are listed in the window, each with a checkbox. You then select the checkbox against each Class operation to include in
the Test Cut.

Toolbox icon

Bl TestCut
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Test Set

wtestsets

Test5et

Description

A Test Set element is a stereotyped Use Case element used to aggregate one or more groups of methods (Test Cuts),
which perhaps span multiple Classes, into a single task. Test Sets can also be aggregated into Test Suites.

You link the Test Cut elements to the Test Set using Dependency connectors.

Toolbox icon

_»  Test set
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Test Suite

wtestsuites

TestSuite]

Description

A Test Suite element is a stereotyped Use Case element, used to aggregate one or more groups of tasks (Test Sets).

You link the Test Set elements to the Test Suite using Dependency connectors.

Toolbox icon

1 Test Suite
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The Testpoints Window

The Testpoints Window is the hub where Test Domain constraints are composed. It is also the control that lets you verify
a particular Test Domain on a program. The program might be already running or it can be launched using the control's
Toolbar. Here you will also be able to see the results of your tests, as they happen. This control is context-sensitive,
responding to the selection of elements in the Project Browser or on a diagram. Depending on the selection, tests can be
carried out on a single class, a Use Case (Test Set) or a collection of Use Cases (A Test Suite).

Access

Ribbon Execute > Analyze > Testing > Show Testpoints Window

Testpoint Window Columns

Column Usage
Tests Displays the name of the selected Testpoint object and the hierarchy of objects
beneath it.

The selected object can be a:
e C(lass

e  Operation

e Test Cut

e  Test Set or

e  Test Suite

Id For an Operation, this column shows a Testpoint marker icon (a ) when the

Analyzer has successfully bound this operation in the target application. If no icon
appears in this column during a run, it indicates that the model and code base might
not be synchronized; perhaps the signature of the function has changed, or the
operation is a new method you are working on, that exists in the source code but
not yet in your model.

For a Testpoint, this column shows a generated id number. This id number is used
in trace output to indicate which constraint is being referenced.

Constraints A pencil icon ( ¥ ) in this column indicates that one or more constraints are defined

for this Class or Operation.

Status During a test run, indicates these possible statuses:
e (%) Failed - Constraint has evaluated as false one or more times.
e ( ! ) Invalid Statement - Constraint failed to parse due to invalid syntax.

o ( ? ) Variable not found - A referenced variable name was not found at the
location where the constraint was evaluated.

No icon is shown if a constraint has Passed.
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Evals During a test run, indicates the number of times the Execution Analyzer has
evaluated this constraint.

Passes During a test run, indicates the number of times the test passed.

Fails During a test run, indicates the number of times the test failed.

Last Run By Displays the username of the last person to run this test.

Last Run Date Displays the date and time this test was last evaluated.

Last Run Result Displays the result of the last test run.

Parent Collections Pane Lists any parent collections that include the selected object as part of their design.

Double-click this collection to make it the selected object in the left pane.

The Parent Collections pane can be hidden by clicking the Show / Hide Parent
Collections pane button on the Testpoints Window Toolbar.
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Testpoints Toolbar

The Testpoints Window Toolbar provides options to execute configured tests on the currently selected Testpoint object,
stop a test run currently in progress, filter the displayed items, and save the results of a completed test run.

Access

Ribbon Execute > Analyze > Testing > Show Testpoints Window

Testpoints toolbar options

Toolbar Button Action
TR E TR Field showing the name of the currently selected Testpoint object.
b Execute the test run.
- Stop the test run currently in progress.
i Toggle between showing all items and showing only those items that have

constraints defined.

= Toggle between showing all items and showing only operations that have been
marked for inclusion in this Test Cut; this button is only enabled when a Test Cut
object is selected.

When a Test Cut is selected, each of the operations of its associated Class are
displayed with a checkbox; you use this checkbox to mark the operations that apply
to this Test Cut.

Click on the drop arrow next to this icon to display the 'Test Run Options' menu,
providing these options:

e 'Prefix Trace output With Function Call' - Prefix all trace output lines with the
executing function name

e 'Enable Standard Breakpoints during Testing' - When not checked, the test run
ignores any breakpoints in the current breakpoint set, and any attempts to set
breakpoints during the run are ignored

e 'View Trace output' - Display the 'Testpoints' tab of the System Output window

] Click on this icon after completion of a test run to save the results to Test item on
the current object. Saved tests can be viewed using the Testing Workspace.

A prompt displays to select the Test Class - Unit, Integration, System, Inspection,
Acceptance or Scenario. Select the appropriate Test Class and click on the OK
button.
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Display the Testpoint Management Help topic.

Show or hide the Parent Collections pane.
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Testpoint Editor

The Testpoint Editor is used to compose constraints for Classes and Operations. The types of constraints permitted are
dependent on the selected object. For Classes, the type will always be Invariant. For operations, the type can be either
Pre-Condition, Post-Condition or Line-Condition.

Invariants are evaluated by the Analyzer when any method called on an object of the selected Class type completes.
Pre-conditions are evaluated at the beginning of each call to the specified operation. Post-conditions are evaluated upon
completion of each call to the specified operation. Line-conditions are evaluated each time the specified line of code is
executed.

Access

Ribbon Execute > Analyze > Testing > Show Testpoints Window : Double-click on a Class
or Operation in the Testpoints window

Constraint Group fields

Field Usage

Type The type of constraint for the selected Class or Operation:

e Invariant - Evaluated after any method called on the specified Class has
completed

e Pre-Condition - Evaluated at the beginning of each call to a specific Operation

e Post-Condition - Evaluated after completion of each call to a specific

Operation
e Line-Condition - Evaluated upon execution of a specific line of code within an
Operation
Offset For Line-Conditions only, the Line number within the specified operation upon

which to evaluate the constraint.

An offset value is automatically set if the Testpoint was created using the Code
Editor context menu.

Condition The constraint to be evaluated when this Testpoint is triggered. A status of pass or
fail will be recorded depending upon whether this constraint condition evaluates as
true or false.

Action on Fail Click on the drop-down arrow and select from the three options:
e 'Continue' - ignore failure of this constraint and continue execution
e 'Break execution' - halt execution and display the Stack trace

e 'Disable on fail' - do not execute the constraint again after failing once

Evaluate When (Optional) An additional constraint which must be met before the main Testpoint
Condition is evaluated, providing greater control over test coverage.
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Trace Group fields
Option Action
Level Specifies when the trace statement (if defined) will be output. Available options
are:
e 'Fail Only' - Output trace statement only when this Testpoint condition fails
e 'Always' - Output trace statement every time this Testpoint is evaluated
Statement (Optional) A message to be output when this Testpoint is evaluated.

Variables currently in scope can be included in a trace statement output by
prefixing the variable name with a $ token for string variables, or a @ token for
primitive types such as int or long.

Output from a Trace Statement can be directed either to the 'Testpoints' tab of the
System Output Window, or to an external file, as configured by the Analyzer Script
for the parent Package.
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Testpoint Constraints

A Constraint is typically composed using local and member variables in expressions, separated by operators to define
one or more specific criteria that must be met. A constraint must evaluate as true to be considered as Passed. If a
constraint evaluates as false, it is considered as Failed.

Any variables referenced within the constraint must be in scope at the position where the Testpoint or Breakpoint is
evaluated.

General/Arithmetic Operators

Operator Description

+ Add
Example: a+b>0

- Subtract
Example:a-b>0

/ Divide
Example: a/b==

* Multiply

Example:a *b==c¢

% Modulus
Example:a %2 =1

0 Parentheses - Used to define precedence in complex expressions.
Example: ((a/b) * ¢) <= 100

[] Square Brackets - Used for accessing Arrays.

Example: Names[0].Surname == "Smith"

Dot operator - Used to access member variables of a Class.

Example: Station.Name == "Flinders"
> Alternative notation for the Dot operator.
Example: Station->Name == "Flinders"
Comparison Operators
Operator Description
= Equal To
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Example: a=b

Equal To

Example: a ==

Not Equal To

Example: a !=b

<>

Not Equal To

Example: a<>b

Greater Than

Example: a>b

Greater Than or Equal To

Example: a>=b

Less Than

Example: a<b

Less Than or Equal To

Example: a<=b

Logical Operators

Operator Description
AND Logical AND
Example: (a >= 1) AND (a <= 10)
OR Logical OR

Example: (a==1) OR (b==1)

Bitwise Operators

Operator Description
& Bitwise AND
Example: (1 & 1)=1
1&0)=0
Bitwise OR

Example: (1] 1)=1
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(110)=1
A Bitwise XOR (exclusive OR)
Example: (17 1)=0
a1r0=1
Additional Examples
Example Description
((m_nValue & Use a Bitwise AND operator (&) with a hexadecimal value as the right operand to
0xFFFF0000) == 0) test that no bits are set in high order bytes of the variable.
((m_nValue & Use a Bitwise AND operator (&) with a hexadecimal value as the right operand to
0x0000FFFF) == 0) test that no bits are set in low order bytes of the variable.
m_value[0][1] =2 Accessing a multi-dimensional array
a AND (b OR ¢) Combining AND and OR operators, using parentheses to ensure precedence. In this

example, variable 'a' must be true, and either 'b' or 'c' must be true.

Notes

e  String comparisons are case-sensitive
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Object Workbench

The Object Workbench is an Enterprise Architect debugging tool that helps you create objects from your Class model.
The Workbench allows multiple instances of any Class to coexist in the same session. Each Object can serve as the target
of a method you want to invoke. They can also participate as parameters in methods you invoke. The Object Workbench
is supported for the Java and Microsoft .NET platforms.

Workbench Tasks

Task

Provides a guide and the requirements for using the Object Workbench.

Explains what Workbench objects are, and how to create them.

Explains how to execute methods on a Workbench Object and provides information on passing arguments.
Explains stepping through a method's execution using the Debugger.

Explains how to record a method and produce a Sequence diagram.

Explains how to delete a Workbench Object once you are finished with it.

Explains how to shut down the Debugger and close the Workbench once you have finished with it.
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Using the Workbench

Using the Object Workbench is straightforward. From your Class model, select the Classes to workbench and drag them
individually on to the Workbench window. You might have to choose a constructor if more than one exists, then simply
give the variable a name. The Object workbench prepares the required runtime, loads any required modules and
instantiates the objects for you. Executing a method is a matter of selecting from a list. Parameters can be entered where
required. Workbench objects themselves can be used as parameters either singly or as object arrays.

Access

Ribbon Execute > Analyze > Testing > Open Object Workbench

Analyzer Script Requirements

An Analyzer Script is required that has been configured for debugging. It should specify this information:
e  The debugger to match your project
e  For Microsoft .NET, the location of the assembly that will be hosted by the Object Workbench

e  For Java, the location of the JDK and additional class paths to use

Checklist

e  Select the intended Workbench Class and press F12; the source code should be displayed in a code editor
e  Press Shift+F12 to build the project; the output from the build should show successful compilation
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Creating Objects

This topic explains how to create a workbench instance for a Class from your model.

Access
Context Menu Project Browser | Right-click on Class | Execution Analyzer | Create Workbench
Instance of Class
On a diagram | Right-click on Class | Code Engineering | Execution Analyzer |
Create Workbench Instance of Class
Keyboard Shorcuts Ctrl+Shift+J
Other Drag a Class directly from the Project Browser onto the Workbench window
Tasks
Task Detail
Creating an Object on the Select the Class in the Project Browser and drag it on to the Object Workbench
Workbench window.
The "Workbench' dialog displays.
MName
Value
MyClassLibrary. CPerson
Create ] | Help || Cancel
Type in a name for the new instance. The name should be unique for the
Workbench.
Click on the Create button.
Choosing a Constructor The 'Constructor' dialog is displayed where a choice of constructor exists.
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Employee(MyClassLibrary: CPerson) b4

=]
0

CPerson{CPerson)

CPerson(String, String,int)

Select the constructor from the drop-down list.

Enter Parameters

Provide values for the selected constructor's parameters:

e  Strings as arguments - Surround values with quotes where appropriate, or
where the value would conflict with the name of a Workbench object

e  Objects as arguments - Enter the name of the Workbench object

e String array arguments take text values separated by commas:

one,two,three,"a book","a bigger book"

e  Object arrays as arguments take object names separated by commas; supply the
named Workbench objects separated by commas, for example:

Tom,Dick,Harry

Invoke Constructor

Click on the Invoke button to create the instance. The object can be recognized by
its name in the Workbench window.
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Invoking Methods

Access

On the Workbench window, right-click on the instance on which to execute a method, and select 'Invoke'.

Ribbon Execute > Analyze > Testing > Open Object Workbench
Actions
Action Details
Choose Method Select a method from the list and click on the Invoke button.

Note that all methods listed are public; private methods are not available.

Rob(MyClassLibrary:Person) x

nt AddFriends(MyClassLibrary.Person[] -
int AddFriends({MyClassLibrary.Person|]

Person Find(string)

int FriendCount()

bool IsFriend(string)
void main(string[])
string Mame()

string Occupation)
void Run(string[])

int SetAge(int)

String SetMame(string)
String SetTown(string)
bool Test{string)

Provide Arguments

In this image, the method to be invoked takes an array of objects as its only
argument. You construct this argument by naming the other instances on your
Workbench that you want to pass to the method.

Waorkbench

Variable Value Type
$ John MyClassLibrary.CPerson
§ Robert MyClassLibrary.CPerson

MyClassLibrary.CPerson

% mInt L SheilalMyClassLibrary:: CPerson)
g E_E:j:}le 1§! int AddFriends{MyClassLibrary.CPerson[])
& Averagefge 0.00l MyClassLibrary. CPerson(] John,Robert
& FriendCount i]
& Age 0
& Friends

Argument Types

These are the parameter types supported by the Workbench:
e  Strings

e  Numbers
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Argument Syntax

Invoke
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e String Arrays

e  Object Arrays

e  Strings as arguments - Surround strings with quotes where necessary; for
example, to avoid conflict with Workbench object names

e String Arrays as arguments - Enter the elements that compose the array,
separated by commas; for example:

"A maths book","A geography book","A computer book"

e Objects as arguments - Type the Workbench object name as the argument; the
debugger checks any name entered in an argument against its list of
Workbench instances, and will substitute that instance in the actual call to the

method

e Object Arrays as arguments - Enter the Workbench objects' names to satisfy
the argument, separated by commas:

Tom,John,Peter

Click on the Invoke button to execute the method.

Output confirming this action is displayed in the Debug window.

# - A
[437449575]
[437449717]
[437449719]
[437449720]
[437449720]
[437449720]
[437449720]
[437449720]
[437449721]
[437460456]
[437460478]

EE sz @ H (@j

Stack recording threshold set to 7 frames

created new instance counter of Counter

Default Directory is C:\Object Workbench\Microsoft MET\Utilities

Default Directory is ChObject Workbench\Microsoft NET\Utilities

Ch\Program Files (x86)\Sparx Systems\EA wea\ b\ 55Workbenchbd. exe targets .M
Process created \Device\HarddiskVolume2'\Program Files (x86)\5parx Systems\E!
Debug process in demain DefaultDomain

Debug process in domain DefaultDomain

Debug Session Started

Invoking method NumberQfDigits on instance counter of type Counter
MumberQfDigits returned 3
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Setting Properties

For languages that support properties, we can set the value of an Object's property in the same manner in which we
invoke a method. Select the instance in the Workbench, and use its context menu to select the 'Invoke' option. You will
find the properties exposed by the Class listed alphabetically, along with its methods. You will be prompted to provide
the new value of the property. Type the value as you would have entered it for the parameter in a method call. This
image demonstrates changing the Occupation property of a Person called Bertie; Bertie being a type of Person.

Waorkbench

Variable Walue Tune

% Rob Bertie[MyClassLibrary: Plumber) w

& string Occupation() =
string Schoolteacher

(c) Sparx Systems 2015 - 2017 Page 200 of 214 Created with Enterprise Architect



User Guide - Visual Execution Analysis 30 June, 2017

Debugging and the Workbench

While you are working in the Workbench, you might want to debug one or more methods you are developing or
investigating. This can easily be accomplished. The same features of Enterprise Architect's Execution Analyzer are
available to users of the Object Workbench. Debugging can be performed during object construction and destruction as
well as during the execution of a method. To gain access to the debugger, simply place a breakpoint at the points at
which to step through the code. You could also set the condition on these breakpoints to only break under certain
conditions.

28 // The NumberOfDigits static method calculates the number of o
21 public int NumberOfDigits(string theString)
22 {
23 int count = @;
24 for { int i = 85 1 < theString.Length; i++ )
25 f
2B if ( Char.IsDigit(theString[i]) )
27 {
t.‘» 28 count++;
29 }
38 }
31 m_nResult = count;
32 return m_nResult;
33 }
34 }
35}

When debugging, the states of objects are inspected using the debugger controls. Here we use the Locals window to
examine the state of our object while execution is halted.

LI:I d I K% o EeR e o o e o B B B e o B S B b o BB e o B e B e e BB e P B BB P o B e P R B PR e BB e kRS
Variable Value Type
B § this Utilities.Counter
@ m_nResult 3 int
s theString "123" String

$ i 0 int

& C55150000 0 int

g 0 Boolean

o

When the program resumes, the Object on the Workbench will reflect any changes in state.
TR G958055000500050005090500050900090009000050 00500000 00000000000000500050005

Variable Value Type

counter Litilities. Counter

@ m_nResult g int
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Recording and the Workbench

While you are working in the Workbench, you might want to produce a Sequence diagram for one or more methods you
are developing or investigating. This can easily be accomplished. The same features of Enterprise Architect's Execution
Analyzer are available in the Object Workbench. You might even begin a Workbench session by recording a Sequence
diagram first off, as a means of visualizing what you plan to work on.

Set the Recording Marker

152
135 public becl Test(string name)
136 {

- 137 Person px = Find(name);
138 if(px != null)
139 {
148 return true;
141 }
142 return IsFriend(name);
143 3

Invoke the Method

Workbench

Variable Value Type
§ lJohn MyClassLibrary.CPerson
§ FRobert MyClassLibrary.CPerson
MyClassLibrary.CPerson
% mnt 0 Sheila[MyClassLibrary::CPerson)
g ::Blzztlle 1§£ int AddFriends{MyClassLibrary.CPerson[])
o AverageAge 000! My ClassLibrary.CPerson(] lohn,Robert
@ FriendCount 0
§ Age ]
i Friends

View the Recording History

Record & Analyze

[ - P GG Ee | F

Sequence Instance Method Direction Method

- COo0D00001 System Reflection. RuntimeMethodin...  Call WyClaszLibrany . Person. Test
DDDOO00Z MyClassLibrary Person. Test Call MyClassLibrary Person.Find
DOD00003 MyClassLibrary Person. Test Call MyClassLibrary Person.Find
DOD00004 Fietum WyClassLibrary Person Test
00DO0D0S MyClassLibrany. Person. Test Call MyClassLibrany . Person lsFriend
DOD0000G Retum WyClassLibrary Person . Test
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Generate the Sequence Diagram

LN T MyClassLibrary_Person_Test X

Default Style | B
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Deleting Objects

You can easily delete an object by selecting it in the Workbench, right-clicking on it and selecting the 'Delete' option.
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Closing the Workbench

To shut down the Workbench perform anyof these actions:

e Choose 'Reset' from the Object Workbench context menu
e Press the Stop button on any debugger toolbar

e Delete all objects on the Workbench
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Visualize Run State

You can record the state transitions of a single object by taking multiple snapshots of the object's run state at key points
in its lifetime. To do this simply drag the local or member variable on to an Object diagram.
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Unit Testing

Enterprise Architect supports integration with unit testing tools in order to make it easier to develop good quality
software.

In sequence:

e You download and install the NUnit and JUnit applications (JUnit - http://www.junit.org/ NUnit -
http://www.nunit.org/index.php?p=home); Enterprise Architect does not include these applications in the installer

e  Enterprise Architect helps you to create test Class stubs with the JUnit and NUnit transformations
®  You define your test code within the Class stubs
e  You set up and run a test script against any Package

e  All test results are automatically recorded inside Enterprise Architect
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Set Up Unit Testing

This topic explains the actions you should take in setting up Unit Testing, after having downloaded and installed the
JUnit and/or NUnit applications.

Actions

Action Details

Create Unit Test Stubs By using the JUnit or NUnit transformations and code generation you can create
test method stubs for all of the public methods in each of your Classes.

(TestFixture)
public class CalculatorTest
{
(Test)
public void testAdd(){
}
(Test)
public void testDivide(){
}
(Test)
public void testMultiply(){
}
(Test)
public void testSubtract() {

b

Define Test Cases Write your unit test in the generated code stubs (either in Enterprise Architect or
your preferred IDE).

This is an NUnit example in C#, although it could also be any other .NET language,
or Java and JUnit.

(TestFixture)
public class CalculatorTest
{
(Test)
public void testAdd(){
Assert.AreEqual(1+1,2);
H
(Test)
public void testDivide() {
Assert.AreEqual(2/2,1);
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(Test)

public void testMultiply() {
Assert. AreEqual(1*1,1);

H

(Test)

public void testSubtract(){
Assert.AreEqual(1-1,1);

Alternatively, if you have not performed an xUnit transformation, you can reverse
engineer the code into Enterprise Architect so that the system can record all test
results against this Class.

Compile Your Code Check that the source code being tested compiles without errors, so that the test
scripts can be run against it.

Set up the Test Scripts Set up the Test scripts against the required Package, and then run the tests.
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Run Unit Tests

On running a test script you generate test results that are stored as Test Cases against the Classes being tested.

Access
Ribbon Code > Build and Run > Test or
Execute > Analyzer Scripts > A (The 'Run Test Script' icon on the toolbar of the
Execution Analyzer window.)
Tasks
Task Details
Run Tests Select the appropriate Package in the Project Browser.
Select the 'Run Test Script' option to run the test script you previously set up for
that Package, in the Execution Analyzer.
View Results The results of xUnit tests are displayed in the System Output window, identifying

which tests have run and which of these have failed.

The results also show which method failed and the file and line number the failure
occurred at.

Double-click on an error message; Enterprise Architect opens the editor to that line
of code, enabling you to quickly find and fix the error.

Enterprise Architect also records the run status of each test against the Class being
tested; these are stored in the element Test Cases.

A diagram containing the Class can be set to display these Test Cases, by exposing
the test scripts compartment on the diagram elements.
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Record Test Results

Enterprise Architect is able to automatically record all results from tests through a testing script in Enterprise Architect.

Process

In order to use this feature, you must reverse engineer the test Class into the Package containing your test script.

Once your model contains your test Class, on the next run of the test script Enterprise Architect adds Test Cases to the
Class for each test method found; on this and all subsequent test runs all Test Cases are updated with the current run time
and whether they passed or failed, as shown:

Calculator Test

testAdd(] : woid
testDivide() : void
testMultiphy() : woid
testSubtract() : woid

o+

test scripts
Unit: : (Pass) testAdd
Unit: : {Pass) testDivide
Unit: : (Pass) testhMultiphy
Unit: : (Fail) testSubtract

The error description for each failed test is added to any existing results for that Test Case, along with the current date
and time.

Over time this provides a log of all test runs where each Test Case has failed, which can then be included in generated
documentation, resembling this:

Failed at 05-Jul-2006 1:02:08 PM
expected: <0>

but was: <1>
Failed at 28-Jun-2006 8:45:36 AM

expected: <0>

but was: <2>
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Enterprise Architect enables you to easily import complete sample models (Packages), including all necessary model
information, code and build scripts. These sample Patterns make it simple to explore and try out the Visual Execution
Analyzer. You can generate an example model for:

e Java
e  Microsoft NET
e  Microsoft C++

e PHP Apache

Access

Ribbon
Context Menu
Keyboard Shortcuts

Other

Display Samples

Field

Technology

Name

description field
Destination folder

Use Local Path

Compiler command

Edit Local Paths

(c) Sparx Systems 2015 - 2017

Design > Package > Model Wizard > VEA Examples
Right-click on Package | Add a Model Using Wizard > VEA Examples
Ctrl+Shift+M > VEA Examples

Project Browser caption bar menu | New Model from Pattern > VEA Examples

Action

Select the appropriate technology.

Displays the samples available for the selected technology; select the required
sample to import.

Displays a description of the selected sample.
Browse for and select the directory in which to load the source code for the sample.

Enable the selection of an existing local path to place the source code under;
changes the 'Destination folder' field to a drop-down selection.

Displays the default compiler command path for the selected technology; you must
either:

e  Confirm that the compiler can be found at this path, or

e  [Edit the path to the compiler location

Many VEA examples specify their compiler using a local path.

The first time you use any sample you must click on this button to display the
'Local Paths' dialog, on which you check and - if necessary - correct the local path
pointing to the correct compiler location.
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Notes

e Ifrequired, you can define custom samples by adding files to the AppSamples directory in which Enterprise
Architect is installed; top-level directories are listed as Technologies and can contain an icon file to customize the
icon displayed for the technology

e Directories below this are defined as groups in the Patterns list; the Patterns are defined by the presence of four files
with a matching name: a zip file (.zip), XMI file (.xml), config file (.cfg) and optional icon (.ico)

e The config file supports these fields:
- [provider], [language], [platform], [url], [description], [version] - all displayed in the 'description’ field
- [xmirootpaths] - the root path of the source code in the exported xmi; this is replaced with the selected
destination folder when
the user applies the application pattern
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